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DOE++ Training Guide

1.1 About This Training Guide

This training guide is intended to provide you with many examples of the DOE++ software. It begins with
step-by-step examples and then proceeds into more advanced examples and questions. At any time during
the training, please feel free to ask the instructor(s) any questions you might have.

If you have a demonstration version of DOE++, you may not be able to save your work for these examples.
For this reason, you may wish to work with the sample projects that are shipped with the software instead of
creating your own. In addition, the data sets for the examples are provided in Spreadsheets within separate
files. Each of these data sets is sorted according to the standard order as specified in the relevant design type,
making it easy for you to copy the data set and paste it into the Folio(s) that you create while working
through the example. The names of the complete sample project and the data file that are shipped with the
application are given for each example in this training guide.

1.2 DOE++ Documentation

Like all of ReliaSoft's standard software products,
DOE++ is shipped with detailed printed
documentation on the product (DOE++ User's
Guide) and the underlying principles and theory
(ReliaSoft's Experiment Design and Analysis
Reference). This training guide is intended to be a
supplement to those references.

User's Guide

1.3 Contacting ReliaSoft

ReliaSoft can be reached at:
ReliaSoft Corporation
Worldwide Headquarters
1450 S. Eastside Loop
Tucson, AZ 85710-6703 USA
Phone: +1.520.886.0410
Fax: +1.520.886.0399
E-mail: Support@ReliaSoft.com

For up-to-date product information, visit our Web site at:
http://DOE.ReliaSoft.com

For assistance, you may contact our Worldwide Headquarters in Tucson, Arizona or go to
http://Directory.ReliaSoft.com to locate the regional office nearest you.
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Features Summary

The examples included in this training guide have been designed to introduce you to the features available in
DOE++. This section presents a brief summary of these features. If you are already familiar with DOE++'s
features, you can proceed to the examples.

2.1 Design of Experiments (DOE) Software... Designed With Reliability in
Mind

ReliaSoft’s DOE++ facilitates traditional Design of Experiments (DOE) techniques for studying the factors
that may affect a product or process in order to identify significant factors and optimize designs. The
software also expands upon standard methods to provide the proper analysis treatment for interval and right
censored data — offering a major breakthrough for reliability-related analyses!

DOE++ guides you through the designs and analyses necessary for all phases of the DOE strategy, from
screening for significant factors, through in-depth analysis of the targeted factors and factorial interactions,
to selecting input levels for optimal performance.

2.2 Intuitive and Flexible Work Environment

The powerful and flexible interface allows you to create multiple designs in a single project, keeping all
related analyses and information together in a single file. Using the same “Project Explorer” approach that is
employed in ReliaSoft’s Weibull++, ALTA and BlockSim software, DOE++ provides an intuitive,
hierarchical (tree) structure to allow you to view and manage one or many standard folios, plot sheets, free-
form regression analyses, spreadsheets and/or attached documents per project.

If you have Weibull++ and/or ALTA 7.5 or later installed on your computer, the applications will work in
concert. This means that you can include all of the analysis types available in DOE++, Weibull++ and ALTA
in a single project and switch between applications with the click of a button!

2.3 Supported Design Types

DOE++ facilitates the design types employed in traditional DOE and also expands upon the traditional
methods to support “Reliability DOE,” which provides the proper treatment for interval and right censored
data. Supported design types include:
e One Factor Designs
e Factorial Designs

o Two Level Full Factorial

o Two Level Fractional Factorial

o Plackett-Burman
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2 Features Summary

o General Full Factorial

o Taguchi Orthogonal Array (single level or mixed level)

o Response Surface Method Designs
o Central Composite
o Box-Behnken

o Taguchi Robust Designs

e Reliability DOE

o One Factor Reliability Designs
o Two Level Full Factorial Reliability Designs
o Two Level Fractional Factorial Reliability Designs
o Plackett-Burman Reliability Designs
In addition, the software’s Multiple Linear Regression Tool allows you to enter your own free-form factor

and response data and perform similar analyses.

2.4 Detailed Analysis of Experimental Results

DOE++ provides a flexible array of tools for detailed analysis of experimental results, including:

e Analysis of variance (ANOVA) information - an overview of the effects of factor(s) on response(s).
e Level-specific information and comparisons for one factor designs.
e Breakdown of the importance of individual factors, interactions and/or groups of effects to output.

e Likelihood ratio test results for reliability DOEs.

2.5 Extensive Plotting Capabilities

DOE++ offers a wide variety of diagnostic, interpretive and predictive plots. In addition to a selection of
individual plots (which are available for each design type based on their relevance and utility), the flexible
Side-by-Side Plots utility allows you to view multiple plots for a given response simultaneously and
MultiPlots facilitate comparison of separate response analyses. Plots include:
o Level Plots:

o Response vs. Level

o Level Mean

o Life Characteristic

o Box Plot

o Mean PDFs

o Comparison Chart
o Effect Plots:

o Effect Probability

o Scatter Plot

o Pareto Chart

o Main Effects
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2.6 Put Your Findings Into Practice with Powerful Optimization Utility

o Interactions
o Interaction Matrix
o Cube Plot

o Residual Plots:
o Residual Probability
o Residual vs. Fitted
o Residual vs. Run
o Residual vs. Factor
o Residual Histogram
o Fitted vs. Actual

e Diagnostic Plots:
o Leverage
o Cook's Distance

o Box-Cox Transformation

2.6 Put Your Findings Into Practice with Powerful Optimization Utility

You can specify the goal for each response in your analysis (as a maximum, minimum or target value).
DOE++ will search for the combinations of factor settings that most effectively lead to the desired output
and rank them according to their desirability. If certain responses are more important to optimize than others,
or if the target is more narrowly defined, the software can take that into account. Solutions can be viewed
graphically or numerically.

2.7 Configure the Workspace to Meet Individual Needs

DOE++ makes it easy to configure the interface and analysis settings to meet your specific preferences and
needs. For example, the User Setup allows you to specify default options for data sheets, analysis settings,
fonts/symbols, etc. The Plot Setup allows you to configure the appearance of the plots that are automatically
generated by the software. In addition, you can customize the toolbars and/or adjust the appearance of the
workspace by hiding/displaying or changing the position of the Project Explorer and other panels.

2.8 System Requirements

DOE++ is compiled and designed for Windows NT, 2000, XP and Vista and takes advantage of the features
available in these platforms. Minimum system requirements: A 433-MHz Intel Pentium-class processor or
equivalent, with 64MB RAM (128MB or more is recommended), SVGA display and at least 130 MB of
hard disk space.
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First Steps

3.1 Starting DOE++

DOE++ is a 32-bit application that has been designed to work with Windows NT, 2000, XP and Vista. The
internal screens and commands are identical regardless of which operating system you are using, and this
training guide is equally applicable. To start DOE++, from Start select Programs, ReliaSoft Office and
then DOE++.

3.2 Multiple Document Interface and Standard Folio

The Multiple Document Interface (MDI) serves as the container for the Project Explorer, all Standard Folios,
Additional Plots, Other Tools (i.e. Multiple Linear Regression Tools), Spreadsheets and Attachments and
manages the different active windows. The MDI remains open until you close the program. Closing the MDI
has the same effect as terminating the program. The next figure shows the MDI of DOE++ and its
components. The appearance of the MDI will vary depending on the window(s) that are currently open and
the configuration settings of the Project Explorer.

[ Reliasoft DOE++ =
MenuBar— File View Project Tools Window Help |
e R R R REEEEETR
Toolbars—o | A {bn|§ = §| ﬂ‘ | 3 |H.§| _imﬁ ﬁ|g 2l fl| z HJ ‘

Tahoma - 10 -|Bru Hjmu e s e

-5 Standard Folios
-] ] Foliol

B Additional Plots

{3l Other Tools

~{@ll Spreadsheets

B Attachments

Project Explorer —

Internal Area

@ weibull ++

Application Buttons — .d_ ALTA

Status Bar—‘Loaded folios: 0 | Active Docked Project Explorer ‘Pro]ect: Projectl.rsa? | Physical Memaory Available: 41.55%

The Standard Folio allows you to enter and analyze the experimental data. It can consist of up to four tabs:
e The Design tab contains information pertaining to the design of the experiment and allows you to enter
response data. This is the only tab present when the Folio is first created.

e The Analysis tab is created when you click Calculate in the Design tab and contains tables of calculated
analytical information about the experiment.
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3 First Steps

e The Plot tab is created when you click Plot on the Main page of the Control Panel on either the Design
tab or the Analysis tab and contains plots of the experiment analysis.

e The Optimization tab is created when you perform optimization (accessed from the Main page of the
Analysis tab Control Panel) and contains a plot that graphically displays the settings for each factor that
will yield the optimal response(s), as specified by the user.

The appearance of the Standard Folio varies depending on the type of design you are working with. A
Standard Folio for a central composite design is shown in the figure below.

ﬁFolio: Foliol {Design) H=] 3
(=] 1 Ilair | Optiunsl Other I
T 5 Display Factars
Standard | Run Cerjter Block A.Tl.me B:Termperature vield Viscosi Molacular Weight
Order | Order | Points |Mumber | (min} (F) i ] |7 €~ Coded Values
1 3 1 1 1 &0 180 77 &0 2470 © G et
2 10 2 0 1 g5 175 80.3 69 3200 Sort By
3 5 3 1 1 F7.9289 175 75.6 71 3020 & Run ord
4 g 4 o 1 s 175 799 72 3480 — [P
5 12 5 u] 1 85 175 79.7 70 3200 =
6 7 3 1 1 85 167.9289 77 57 3150 Design summary
7 11 7 0 1 85 175 50 &3 410 = ——
Fii)=... e
8 4 g 1 1 a0 180 79.5 59 3390 L —I
9 1 ] 1 1 80 170 76.5 62 2940
10 5] 10 1 1 92,0711 175 78.4 68 3360
11 13 11 u] 1 83 173 79.8 71 3500
12 2 12 1 1 20 170 78 66 2680
13 a8 13 1 1 85 182.0711 785 58 3630

Design I Analysisl Flok Optimizationl

3.3 Getting Help in the DOE++ Environment

ReliaSoft's DOE++ includes complete on-line help documentation. This help can be obtained at any time by
pressing F1 or by selecting Contents from the Help menu. DOE++ also provides theory help, which is
available for the signal-to-noise ratio options available for Taguchi robust designs and for each life
distribution available for reliability designs. Theory help can be accessed by clicking the theory help button
(i) next to your selection.

3.4 A Quick Overview Example

This section presents you with a very simple example and guides you through the solution.

While performing a failure modes and effects analysis (FMEA) of an engine, engineers identify the
crankshaft as a critical area. Bending stress and speed are identified as two probable causes for fatigue
failure. The engineers have identified the bending stress as a Key Process Input Variable (KPIV) and want to
explore its effect. They also wish to explore the speed as a cause for fatigue failure and determine whether it
is a significant factor. Finally, they would like to explore whether there is an important interaction between
speed and bending stress.

The engineers decide on a 27 factorial design with 3 replicates. The levels for the bending stress are chosen
to be within design limits as 40 and 60 ksi. The speed levels, measured in terms of engine revolutions per
minute, are chosen as 6 and 9 krpm. Because of time constraints, the response is measured in terms of
degradation (crack size at a notch location) rather than times-to-failure. All units are tested to the same
number of cycles.
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3.4 A Quick Overview Example

The results obtained at each combination of factor settings are shown next.

Factor A: Factor B: Response:
Bending Stress Speed Crack Size
(ksi) (krpm) (mm)
40 6 0.33
60 6 0.38
40 9 0.19
60 9 0.47
40 6 0.48
60 6 0.74
40 9 0.3
60 9 0.77
40 6 0.2
60 6 0.5
40 9 0.3
60 9 0.54

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\DOE\Training Guide) and is named “IstSteps.rdoe.” The data set for this
example is available in the Spreadsheet in the “IstSteps-Data.rso7” file located in the “Raw Data” folder
within the “Training Guide” folder.

3.4.1 Creating the Project and Design

e Create a new project by clicking Create a New Project in the initial window that may appear at startup,
by selecting New from the File menu or by clicking the New icon.

a

The Design Wizard will be displayed. This window consists of a series of pages that guide you through the
process of creating a new project by asking you a series of questions that allow you to define the design used
in the first Standard Folio that will be added to the project. The steps in the Design Wizard vary depending
on the type of design you want to create. Note that you can click the Load Last Design link on the first page
of the wizard to create another design with the same settings as the last design you created.
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3 First Steps

e On the first page of the Design Wizard, select to create a Factorial Design and click Next to proceed to
the next step.

[IjDesign Wizard [ %]

Specify the type of Design of Experiments.

Step 1

—Create a new project using. ..

[” One Factor Design
S99 Choose this ko compare mean values at each level of a single Factor, 7]

5 ’T ¥ Factorial Design

r,:f_,, Choose this ko simulkaneously study the effects of several Factors (e.q. Fractional Factorial, 71
General Factorial, Plackett-Burman ...},

| [” Response Surface Method Design
Choose this ko establish a relationship between factors and responses (e.g. Central Composite, (el

Box-Behnken Design ...

.| [T Taguchi Robust Design
v Choose this ko use Taguchi's methods {e.g. Robust Parameter Design ... ). 7]

[~ Reliability DOE
Choose this For life test designs, especially when you expect interval data or suspensions from 71

the experiments,

DOE++

Help Load Last Design. .. Cancel | = Back | Eimish |

e On the second page of the Design Wizard, select 2 Level Full Factorial Design and click Next to
proceed to the next step.

[IjDesign Wizard [ %]

Define the design type for your Factorial Design.

Step 2

—Factorial Design

i V¥ 2 Level Full Factorial Design
[ Choose this if the experiment. includes all combinations of the Factors, 7]

[” 2 Level Fractional Factorial Design

Choose this if the experiment. includes only part of all combinations of the Factors, 71

ol " Plackett-Burman Design

it Choose this to study the main effect of multiple Factors, Each Factor has only bwo levels, (7]
f_V$1 [ General Full Factorial Design
Choose this if the experiment. includes all combinations of the Factor levels, Each factor can (7]

have any number of levels,

« [” Taguchi DA Factorial Design
;ﬁ Choose this to use Taguchi's Orthogonal Array, Each Factor can have multiple levels, 71

DOE++

Help | Cancel < Back

Eimish
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3.4 A Quick Overview Example

e The third step of the Design Wizard allows you to define the exact configuration of the design. Select 2
from the Factors drop-down and 3 from the Replicates drop-down. Leave the other options set to the

defaults, as shown next.

[IjDesign Wizard [ %]

:E'_i'\

Step 3

Define the design profile for your factorial design.

& Level Full Factorial Design

Factors |2 VI Factor Properties |
Blocks |1 'l Elock Properties |

Repeated Measurements |MNone

Wiew Available Desions

Center Points Per Block ID 'l
Replicates |3 vl [™ Block On Replicates :I
Responses |1 VI Response Properties |

* | {Available with one response only)

DOE++

Help |

Cancel

| < Back

Ensh |

e Click the Factor Properties button. In the Factor Properties window that appears, enter the names, units
and high and low level values for the factors, as shown next.

[IjFactor Properties !E[ E

-

MNarme Units | Type | Low Level | High Lewvel
A | Bending Stress ksi Quantitative 40 &0
B Speed krprn Quantitative 6 9

t Quantitative: The results can be generalized to other values,

{['] Qualitative: The results can only be applied to the levels you define.

o
-

o |

Note that these factors are both quantitative (i.e. results can be generalized to values other than the ones
that you provide here), not qualitative (i.e. results would be valid only for the values that you provide

here), so leave the Quantitative entry in the Type column for both.

e Click OK to close the Factor Properties window and return to the Design Wizard.

DOE++ Training Guide
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3 First Steps

e C(Click the Response Properties button. In the Response Properties window that appears, define the
response name, as shown next.

[IjResponse Properties _|Of =
Name Units =
Crack Size mr |
+
+
[[]
. -
[-] OF | Cancel | Help

e Click OK to close the Response Properties window and return to the Design Wizard.
e Click Next to proceed to the next step.

e The fourth step of the Design Wizard provides a review of the settings you have chosen for the design.

[IjDesign Wizard [ %]
s Review the settings vou have chosen for your design.

Step 4
View in & separate window. ..

—Design Review
2 Level Full Factorial Design o

Factors:

Blocks:

Center Points Per Block:
Replicates:

Block On Replicates:
Cbservations:
Responses:

S%wap—nm

-

Factor Properties

Factor Name Units Type  Low Level High Level
A Bending Stress ksi Quantitative 40 &0
B Speed krprn Quantitative 6 9

|
Help | Canicel | < Back | fext = |

DOE++

If any of the settings are not as intended, you can click the Back button to return to the appropriate step
and make any necessary changes.1
e Click Finish to create the new project with the Standard Folio containing the two level full factorial

design, as shown next. Note that by default, the Design tab Data Sheet is sorted by the Run Order
column, which is the randomized order, generated by DOE++, in which it is recommended to perform

I Note that you can skip the design review step by clicking Finish after completing the previous step, rather than
clicking Next.
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3.4 A Quick Overview Example

the runs to avoid biased results. Because the order is random, your Data Sheet may not be in the same

order as the one shown next.

[ Reiasoft DOE ++ =]

Elle Edit Wew Project Sheet Data Tools ‘Window Help

iR x| PR == 2

= 00 A
=[] [ [l a[e w291 21 =] [EEA]
[5]] Project1 rFullu Folio1 (Deslgn)
= a Standard Folios
H [6]] Faliol Al Main I 0pt|ons| Other I
g ;f:'tm_;'a‘ IPIOts Standard Run Center Block |A:Bending Stress | BiSpeed | Crack Size ﬂ Display Factors
er [ools
. B spreadsheets Crder Crdler Points | Mumber (ksiy (krprm) {mm} I ¢ Coded Values
@l Attachments 1 4 1 1 1 &0 a (& Actual Values
2 [a] 2 1 1 a0 [i] Sort By
3 1 3 1 1 40 5]
4 s 4 1 1 40 & & Run Order
5 a 5 1 1 a0 5 22| Standard Order
] 12 8 1 1 &0 9 Design Surmmary
7 11 7 1 1 40 9 =
5 10 B 1 1 &0 & Pl=... |
] 7 9 1 1 40 9
10 g 10 1 1 &0 9
11 2 11 1 1 a0 [i]
12 3 12 1 1 40 9
E weibull++
A aLta =
Design

—
Loaded folios: 1 | Active Folio "Foliol” |Prnject: Projectl.rsa7 |

Physical Memory Available: 32.65%

Upon creation, the Standard Folio contains only the Design tab. Notice that the factor columns are shown in
green and are populated with factor settings.

3.4.2 Entering the Data

e For ease of entry, the data in this example have been presented in the standard order as specified in the
design type. To sort the Data Sheet by the Standard Order column, select Standard Order in the Sort By

area in the Control Panel.

DOE++ Training Guide
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3 First Steps

e You can now enter the response data (i.e. Crack Size) in the order given in this example on page 9. The
Folio will look like the one shown next.

[ﬁFnlin: Folio1 {Design) [_ (O] x
G1z 0.54 Main | Opt\DnSI Other |
Standard Run Center Block  A:Bending Stress | B:Speed |Crack Size Display Factors
Order Order Points | Mumber (ksi) {(krprmy) {rrm) " ¢ Coded Yalues
1 1 3 1 1 40 6 0,22 @ actual Yalues
2 2 11 1 1 a0 5] 0.33 Sort By
3 3 1z 1 1 40 9 0.19
4 4 1 1 1 &0 3 0.47 (‘: Run Order
5 5 4 1 1 an 5 0.48 * Standard Order
& 6 2 L L &0 & 0.74 Design Summary
7 7 el 1 1 40 9 0.3 T —
E 8 10 L L 60 9 0.77 =
] 9 5 1 1 40 5] 0.2
10 10 g 1 1 a0 5] 0.5
11 11 7 1 1 40 9 0.3
12 12 5] 1 1 60 9 0.54
Dresign I

3.4.3 Performing the Analysis

Click the Options tab in the Control Panel.

Specify a Risk Level (Alpha) value of 0.1 for the Crack Size response and select to use Individual
Terms in the Test Terms arca. Leave Partial Sum of Squares selected in the Type of Sum of Squares

area, as shown next.

Main  Options | Other I

Response
ICrack Size j

Risk Level (alpha)

jo.1

Type of Sum of Squares

' partial Sum of Squares
" Sequential Sum of Squares

Test Terms

& Individual Terms
" Grouped Terms

14
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3.4 A Quick Overview Example

The risk level is a measure of the risk that the analytical conclusions for the response are incorrect (i.e.

alpha = 1 - confidence level).? The test terms specify what the analysis will examine; using individual
terms causes DOE++ to examine the effects of each individual factor and/or factorial interaction

sepalrately.3

e Click the Main tab in the Control Panel and then click the Calculate icon to perform the analysis.

The Analysis tab will be added to the Standard Folio, as shown next.

EFulin: Foliol {Analysis) |_ (O] x|
A30 Main | Optionsl Other |
A ‘ B ‘ c ‘ D E ‘ F ‘ G ‘ ho A Respanse 1))
1 ANDYA Table Jcrack size =l
Degrees  Sum of Mean - s
2 Suut.'ce_ of of Squares  Squares FRatio | P value dﬂ \
variation : . ="
Freedom [Partial] [Partial] 1@

3 rode! 3 0.2257 0.0752 3.6739 0.0626 ) Risk Level {alpha)
4 &:Bending Stress 1 0.2133 0.2133 10,4192 | 00121 Y4 o1
5 B:Speed 1 0.0003 0.0003 0.0147 00,9065 d _ _
6 | 48 1 0.012 0.012 | 05377 04653 (inlyele Selies
7 |Residual 8 0.1638 0.0205 |Q)|[Partialss | individudl
8 | Pure Error & 0.1635 0.0205 o) - C""ct'_'atec'_ -
9 |total 11 10,3895 EENEIIEE
10 Analysis Summary
11 5 =|0.1431 T Fim | e
1z R-sq = 57.94% _I
13 R-sq{ad]y = 42,17%
14
15 Regression Information
16 Term Effect | Coefficient Stg:_i?rd Low CI HighCI T Value P Yalue
17 Intercept 0.4333 0.0413 0,3365 0.5101 | 104906 | 5.93E-05
18 A:Bending Stress | 0.2667 0.1333 0.0413 0.0565 0.2101 3.2279 00121
19 B:Speed -0.01 -0.005 0.0413 -0.0818 0.0718 -0.121 0.9066
20 AR 0.0633 0.0317 0.0413 -0.0451 0.1085 0. 7666 0.4653 |-

| »

Design  Analysis I

The Analysis tab Data Sheet contains information that describes how each factor and factorial interaction, or
“source,” affects the variation of the response that is currently selected in the Control Panel. In this example,
we are interested in which factor(s) significantly affect the response and whether or not the interaction
between the two factors is significant. This can be determined from the P Value column in the ANOVA
(Analysis of Variance) table, which displays for each source the probability that an equal amount of
variation in the output would be observed in the case that the source does not affect the output. This value is
compared to the risk level (alpha) that you specified on the Options page of the Control Panel. If the p value
is less than alpha, this source of variation is considered to have a significant effect on the output and the p
value will be displayed in red.

Note that the p value for factor A, bending stress, is red but the p values for factor B, speed, and the
interaction between bending stress and speed (AB) are black. This indicates that at a significance level of
10%, bending stress is the only factor in the test that has a significant effect on the response and that speed
does not interact significantly with bending stress.

% Note that the risk level can be specified separately for each response if more than one response is used in the design.

3. Using grouped terms causes DOE++ to examine groups of effect types, such as main effects (e.g. A, B, C...), order 2
effects (e.g. AB, AC, BC...), etc.

DOE++ Training Guide 15



3 First Steps

3.4.4 Plotting the Data

e Click the Plot icon to create a plot based on the analysis.

The Plot tab will be added to the Standard Folio. The Effect Probability plot will be displayed by default, as

shown next.*

[ Folio: Folio1 (Plot)

ReliaSon DOE++ - wwww ReliaSoft.com

Mormal Probability Plot of Effect

99,000

A Rending Strass

[_ (O[]
Plot Type g
Effect Probability @ Effect Probability 2
Grack Size 55 =
= esponse
& o s s .
= Significant Effects "
= Cifirbution Line 2 |crack size =

|¥ Auto Refresh
¥ Keep Aspect Ratio

W Automatic Scaling
w_ |10 EE]
| |6 3

=12

=
= ¥ Round ¥-Scale
_ﬁ |v Round 2-Scale
&
50,000 *
-
User Mame
Zomnpany
152005
10000 12:2h,
6,000 -3.600 -1.200 1.200 3600 00
Standardized Effect (T Yalue)
[Epha =11
Daswgnl Analysis  Plot I

The Effect Probability plot is a linear representation of probability versus the standardized effect for the
currently selected response (i.e. the probability that any term’s standardized effect will be lower than the
given value). The points on this plot represent the values for each term as shown in the T Value column of
the Regression Information table on the Analysis tab.

e Sclect Pareto Chart from the Plot Type menu in the Control Panel. If the Auto Refresh command is
enabled, the display will be updated automatically when you make changes in the Control Panel. If not,

4 If necessary, you may wish to re-size the plot by re-sizing the Folio.

16
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3.4 A Quick Overview Example

select Redraw Plot from the Plot menu or click the Redraw Plot icon to implement your selections.
The Pareto chart will be displayed, as shown next.
[ Folio: Folio (Plot) ] - O]

ReliaSon DOE++ - wwww ReliaSoft.com
Plot Type g

Pareto Chart =

Response

ICrack Size: j

|¥ Auto Refresh
¥ Keep Aspect Ratio

Pareto Chart

Parato Chart

— Critical Walue
2 Mon-Significant

#uBending Stress

W Automatic Scaling

v [ i v
w0 B [Tx
- ¥ Round¥-Scale
ki AR |v Round 2-Scale

BiSpeed

Uzer Marne
Compary
Elz1)2008
102790 AR

0.000 0,800 1600 1,860 2,400 200 4,000
Standardized Effect (T Valus)

[Blpha = 10, 1; Threshold = 12595
Design |_Analysis  Plot

The Pareto chart shows the standardized effect of each term (i.e. factor or combination of factors) for the
currently selected response. The thick blue line is the threshold value. If a bar is beyond the blue line, it will
be red, indicating that this effect is significant. You can see in this case that factor A, bending stress, is
significant and that factor B, speed, and the interaction between factors A and B are not significant.

Notice that the analysis settings are displayed in the legend in the top right corner of the plot and the alpha
(risk level) and calculated threshold values are displayed in the bottom left corner. You can customize these
and other display settings from the Plot Setup window. To access the Plot Setup, select Plot Setup from the
Plot menu or click the Plot Setup icon.

|

e When you are finished experimenting with the Plot Setup window, save the project by selecting Save
from the File menu or by clicking the Save icon.

|

e When prompted to specify the name and location for the file, browse to the directory of your choice and
type “1stSteps” for the File name.” Accept the default type (*.rso7) and click Save to close the window
and save the file.

e Close the project by selecting Close from the File menu. You will now be looking at the MDI with no
project open.

> By default, files will be saved in the “My Documents” directory on your computer. You can select a different
directory, if desired, and DOE++ will “remember” the directory for the next time that you save a file.
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Step-by-Step Examples

This chapter presents the following examples:

e Example 1: One Factor Design - page 19

e Example 2: Two Level Full Factorial Design - page 26

e Example 3: Two Level Fractional Factorial Design - page 36

e Example 4: General Full Factorial Design - page 47

e Example 5: Taguchi Orthogonal Array Design - page 55

e Example 6: Response Surface Methodology: Box-Behnken Design - page 62

e Example 7: Sequential Optimization - page 70

e Example 8: Taguchi Robust Design - page 84

e Example 9: One Factor Reliability Design - page 93
e Example 10: Two Level Fractional Factorial Reliability Design - page 101

e Example 11: Multiple Linear Regression Tool - page 107

4.1 Example 1: One Factor Design

An engineer is interested in studying the effect of different corrosion inhibitors on the rate of corrosion of
steel. Three NaCl aqueous solutions containing different inhibitors (aluminum, calcium and magnesium
cations) are used, as well as one NaCl aqueous solution with no inhibitors. The samples are tested over the

time interval of interest.

The corrosion rate (ugm'zs'l) is measured in 20 samples using randomization. The measurements are shown

next.
(NaCl) (NaCl + Mg2+) (NaCl + Ca2+) (NaCl + Al3+)
8.1 6.9 4.6 4.8
7.9 7.2 4.2 3.8
8.6 6.6 43 3.9
8.9 6.5 4.7 4.5
8.3 7.1 5.1 4.1
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4 Step-by-Step Examples

Do the following:

e If the model accurately accounts for the effect of the factor, the residuals (i.e. the differences between the
observed response values at each factor level and the response values predicted by the model) should be
approximately normally and independently distributed. Graphically validate the normality assumption.

e Determine whether there is a significant difference between treatments at a 10% significance level.

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\DOE\Training Guide) and is named “OneFactorrdoe.” The data set for this
example is available in the Spreadsheet in the “OneFactor-Data.rso7” file located in the “Raw Data”
folder within the “Training Guide” folder.

Solution

e Create a new project by clicking Create a New Project in the initial window that may appear at startup,
by selecting New from the File menu or by clicking the New icon.

d

e Sclect One Factor Design on the first page of the Design Wizard, as shown next.

[IjDesign Wizard [ %]
""’"': Specify the type of Design of Experiments.

Step 1

—Create a new project using. ..

+ | ¥ One Factor Design
S99 Choose this ko compare mean values at each level of a single Factor, 7]

| [ Factorial Design

r;f"f'f_,,_ Choose this ko simulkaneously study the effects of several Factors (e.q. Fractional Factorial, 71
General Factorial, Plackett-Burman ...},

| [” Response Surface Method Design
Choose this ko establish a relationship between factors and responses (e.g. Central Composite, (el

Box-Behnken Design ...

o l/| " Taguchi Robust Design
v Choose this ko use Taguchi's methods {e.g. Robust Parameter Design ... ). 7]

[~ Reliability DOE
Choose this For life test designs, especially when you expect interval data or suspensions from 71
the experiments,

DOE++

Help Load Last Design. .. Cancel = Back [ext =
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4.1 Example 1: One Factor Design

e Click Finish to create the new project with the Standard Folio containing the one factor design, as shown
next.

[ERetiasoft DOE++

=] 3
File Edit Wiew Project Sheet Data Tools Window Help
iR R I Y =S
NEEEEER BEEEIE ===
@ Projectl !E]-Foliu: Foliol (Design) [_ o] =]
-8 Standard Folios
(] Faliot Al HMain | optians | other |
~{l Additiona! Plats level 1 | Level2 ‘ Level 3 ‘ Level 4 ‘ Level 5 ‘ Level 6
-l Cther Tools
-l Spreadsheests 1
@l Attachments 2
3
4
5
5]
7
g
9
10
11
12 -
N 3
_ Design I
I} poe++

Loaded folios: 1 | Active Folio "Foliol" | Projeck: Projectl.rso? |

Physical Memory Available: 37.92%

e Save the project by selecting Save from the File menu or by clicking the Save icon.

=l

e  When prompted to specify the name and location for the file, browse to the directory of your choice and
type “OneFactor” for the File name.' Accept the default type (*.rso7) and click Save to close the window
and save the file.

e To change the title of the first column, double-click the column header and, in the window that appears,
type (NaCl), as shown next, then click OK.

[ change Heading E3
(Macl) [ol’s |
Cancel |

DOE++

L. By default, files will be saved in the “My Documents” directory on your computer. You can select a different
directory, if desired, and DOE++ will “remember” the directory for the next time that you save a file.
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4 Step-by-Step Examples

e Do the same for the second, third and fourth columns, titling them (NaCl + Mg2+), (NaCl + Ca2+) and
(NaCl + Al3+), respectively. When you have finished renaming the columns, the Folio will look like the

one shown next.2
EFolio: Foliol {Design} M= E3

A0 [Main | Optionsl Other I
(MaCly ‘ (NaCl + Mg2+) ‘ (NaCl + Ca2+) ‘ (NaCl + Al3+) ‘ Level 5 ‘ Level &

el b = =0 = A =, N SV T S

Il o]

Design |

e Enter the data, as shown next.

EFolio: Foliol {Design} M= E3
Alg [Main | Optionsl Other I
(MaCly ‘ (NaCl + Mg2+) ‘ (NaCl + Ca2+) ‘ (NaCl + Al3+) ‘ Level 5 ‘ Level &
2.1 6.9 4.6 4.8
7.9 7.2 4.2 38
8.0 6.6 4.3 39
8.9 6.5 4.7 4.5
8.3 7.1 5.1 4.1

el b = =0 = A =, N SV T S

Il o]

Design |

e Click the Options tab in the Control Panel and specify a Risk Level (Alpha) value of 0.1, as shown
next.

Main  Options | Other I

Risk Level (alpha)

0.1

The risk level is a measure of the risk that the analytical conclusions for the response are incorrect (i.e.
alpha = 1 - confidence level).

2 Note that the columns in the Folio shown here have been widened to display the full column name. To do this, you can
click and drag the right-hand border of each column header.
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4.1 Example 1: One Factor Design

e Click the Main tab in the Control Panel and then click the Calculate icon to perform the analysis.

Note that if desired, you can click the Calculate icon in the Data Analysis Tools toolbar or select
Calculate from the Data menu instead. The Analysis tab will be added to the Standard Folio, as shown
next.

[IjFoIio: Foliol {Analysis) M= E3
A4l Main | Optionsl Other I
& ‘ B ‘ c o ‘ E ‘ E ‘ o] ;I TransFormation 0
¥ =Y
1 ANOVA Table
2 Source of Yariation Degrees of = Sum of Mean F Ratio | P Value FEK EE (i)
Freedom Squares Squares 0.1
3 Treatment 3 57.4695 19,1565 | 138.0649  1.20E-11
4 Error 16 2.22 0.1328 Calculated
5 Total 13 506505 Observations = 20
5 Factaor Level = 4
7 S =0.3723
=] R-zq = |96.28%
9
10 Data Summary -
1 »
Design  Analysis |

e To validate the normality assumption graphically, we will use the Residual Probability plot. Plot the data
by selecting Plot from the Data menu or by clicking the Plot icon.

The Plot tab will be added to the Standard Folio. The Response vs. Level plot will be displayed by default,
as shown next.

[EFolio: Folio1 (Plot) [_[a[=]
Response vs Level Plat Type [}
* | [|Response vs Level j
i 3!
- i ¥ Auta Refresh
: ¥ Keep Aspect Ratio
v Automatic Scaling
3 vl b e
b ik
-
- ¥ Round ¥-Scale
¥ Round #-Scale

@
o
o
-
-
-
-
-
-
-
-
Lewel
Designl Analysis  Plot I

DOE++ Training Guide 23



4 Step-by-Step Examples

o Sclect Residual Probability from the Plot Type menu in the Control Panel.

Plat Tywpe gl
Residual Probabiliky j

Response ws Level
Level Mean

Box Plok

Mean PDFs
Comparison Chart

Residual vs Fitted
Residual Histogram

Box-Cox Transformation

The Residual Probability plot will be displayed, as shown next.

[EFolio: Folio1 (Plot)

T e Mormal Probability Flot of Residual

¥ Auta Refresh
¥ Keep Aspect Ratio

|oese™ i

v Automatic Scaling

v_ |t o= [~
wfoe Joe %
¥ Round ¥-Scale
¥ Round #-Scale

= | Residuals

E ||Regular Residual j

&

Residual
Tirviessivy Dorling = D070, pride = 0190
Designl Analysis  Plot I

The data points follow the line reasonably closely, indicating that the normality assumption is valid.

3 If the Auto Refresh command is enabled, the display will be updated automatically when you make changes in the
Control Panel. If not, select Redraw Plot from the Plot menu or click the Redraw Plot icon to implement your

selections.
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4.1 Example 1: One Factor Design

e Return to the Analysis tab by clicking its page index tab. The complete Analysis tab is shown next.

ﬁFolio: Foliol {Analysis) M= E3

A4l Main | Optionsl Other I
& ‘ B c o ‘ E ‘ E ‘ o] ;I TransFormation 0
1 ANDVA Table Y=y
2 Source of Yariation Degrees of = Sum of Mean F Ratio | P Value FEK EE (i)
Freedom Squares Squares 0.1
3 Treatment 3 57.4695 19,1565 | 138.0649  1.20E-11
4 Error 16 2.22 0.1328 Calculated
5 Total 13 506505 Observations = 20
5 Factaor Level = 4
7 S =0.3723
=] R-zq = |96.28%
9
10 Data Summary
Number in | Estimated Standard
11 Factor Level L
Level Mean Deviation
12 (NaCl 5 B.36 0.3975
13 (MaCl + Mg2+) 5 £.86 0.305
14 (MaCl + Caz+) 5 4.58 0.3564
15 (MaCl + Al3+) 5 4,22 0.4207
16
17 Mean Comparisons
Mean Pooled )
18 Contrast . Standard | Low CI | HighCI T Value P ¥Yalue
Difference Error

19 (MaCly - (MaCl + Mg2+) 15 0.2356 1.0887 1.9113 63671 | 9.34E-06
20 (MaCly - (MaCl + Ca2+) 3.78 0.2356 3.3687 4,1913 | 16.0452 | 2.77E-11
21 (MaCly - (NaCl + &l3+) 4.14 0.2356 3.7287 45513 | 17.5733 | 6.96E-12
22 | (MaCl + Mg2+) - (NaCl + Caz+) 2.28 0.2356 1.8687 2.6913 9.6781 | 4.32E-08
23 (MaCl + Mgza+) - (NaCl + Al3+) 2.64 0.2356 2.2287 30513 | 11.2062 | 5.51E-09
24 (MaCl + Ca2+) - (NaCl + AI3+) 0.36 0.2356 -0.0513 0.7713 1.5281 0,146 |«

4 | »

Design Analysis |F‘|_Dt|

In the ANOVA table, the treatment and its p value are displayed in red, indicating that there is a significant
difference in the corrosion rate when using the different solutions. In addition, the mean pair comparisons
displayed in the Mean Comparisons table show that individual pairs are also significantly different, except

for the solutions using calcium and aluminum cations.
A similar conclusion can be reached by examining the Box plot.

e Return to the Plot tab by clicking its page index tab.

DOE++ Training Guide
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4 Step-by-Step Examples

e Sclect Box Plot from the Plot Type menu in the Control Panel. The Box plot is shown next.
[EFolio: Folio1 (Plot) ___B=ES

B Plot

Flot Type

LA

¥ Auta Refresh
¥ Keep Aspect Ratio

|+‘T£

v Automatic Scaling

¥ Round ¥-Scale
¥ Round #-Scale

Fesponse

Level

Designl Analysis  Plot I

Graphically, the overlap between the solutions containing calcium and aluminum indicate that there is no
significant difference between them, while the solution containing magnesium and the control solution with
no inhibitor show significant difference.

e Save the project by selecting Save from the File menu or by clicking the Save icon.

e Close the project by selecting Close from the File menu and proceed to the next example.

4.2 Example 2: Two Level Full Factorial Design

Consider a three-factor experiment to investigate the effects of honing pressure, number of strokes and cycle
time on the surface finish of automobile brake drums. Each of these factors is investigated at two levels. The
honing pressure is investigated at levels of 200 psi and 400 psi; the two levels of the number of strokes used
are 3 and 5 and the two levels of the cycle time are 3 and 5 seconds. It is decided to run two replicates for
this experiment. (The number of replicates is the number of times you want to perform the complete set of
runs required by the design.) The surface finish values obtained are converted to a dimensionless index with
values ranging from 0 to 150. The data set is shown next.

PreI:s(l)lr:'ienfpsi) No. of Strokes Cyc(lsee;r)ime Sl?i;fizﬁe
200 3 3 90
400 3 3 90
200 5 3 85
400 5 3 80
200 3 5 90

26 http://DOE.ReliaSoft.com



4.2 Example 2: Two Level Full Factorial Design

PreI:s(l)lr:'ien?psi) No. of Strokes Cyizeez)ime Sl;li;fiztle
400 3 5 105
200 5 5 75
400 5 5 90
200 3 3 86
400 3 3 90
200 5 3 80
400 5 3 82
200 3 5 85
400 3 5 95
200 5 5 80
400 5 5 80

Do the following:

e Determine which factors and/or factorial interactions have a significant effect on the response.
e Graphically validate the normality assumption.
e Determine the parameters of the model.

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\DOE\Training Guide) and is named “TwoLevelFullFactorial.rdoe.” The data
set for this example is available in the Spreadsheet in the “TwoLevelFullFactorial-Data.rso7” file located in
the “Raw Data” folder within the “Training Guide” folder.

Solution

e C(Create a new project by clicking Create a New Project in the initial window that may appear at startup,
by selecting New from the File menu or by clicking the New icon.

ol
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4 Step-by-Step Examples

e On the first page of the Design Wizard, select to create a Factorial Design and click Next to proceed to
the next step.

[IjDesign Wizard [ %]

Specify the type of Design of Experiments.

Step 1

—Create a new project using. ..

[” One Factor Design
S99 Choose this ko compare mean values at each level of a single Factor, 7]

5 ’T ¥ Factorial Design

r,:f_,, Choose this ko simulkaneously study the effects of several Factors (e.q. Fractional Factorial, 71
General Factorial, Plackett-Burman ...},

| [” Response Surface Method Design
Choose this ko establish a relationship between factors and responses (e.g. Central Composite, (el

Box-Behnken Design ...

.| [T Taguchi Robust Design
v Choose this ko use Taguchi's methods {e.g. Robust Parameter Design ... ). 7]

[~ Reliability DOE
Choose this For life test designs, especially when you expect interval data or suspensions from 71

the experiments,

DOE++

Help Load Last Design. .. Cancel | = Back | Eimish |

e On the second page of the Design Wizard, select 2 Level Full Factorial Design and click Next to
proceed to the next step.

[IjDesign Wizard [ %]

Define the design type for your Factorial Design.

Step 2

—Factorial Design

i V¥ 2 Level Full Factorial Design
[ Choose this if the experiment. includes all combinations of the Factors, 7]

[” 2 Level Fractional Factorial Design

Choose this if the experiment. includes only part of all combinations of the Factors, 71

ol " Plackett-Burman Design

it Choose this to study the main effect of multiple Factors, Each Factor has only bwo levels, (7]
f_V$1 [ General Full Factorial Design
Choose this if the experiment. includes all combinations of the Factor levels, Each factor can (7]

have any number of levels,

« [” Taguchi DA Factorial Design
;ﬁ Choose this to use Taguchi's Orthogonal Array, Each Factor can have multiple levels, 71

DOE++

Help | Cancel < Back

Eimish
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4.2 Example 2: Two Level Full Factorial Design

e The third step of the Design Wizard allows you to define the exact configuration of the design. Select 3
from the Factors drop-down and 2 from the Replicates drop-down and leave all other fields at their
default settings, as shown next.

[IjDesign Wizard [ %]
"""": Define the design profile for your factorial desiagn.

Step 3

& Level Full Factorial Design

Factors |3 VI Factor Properties |
Blocks |1 'l Elock Properties |

Center Points Per Block ID 'l
Replicates |2 vl [™ Block On Replicates :I
Responses |1 VI Response Properties |

Repeated Measurements |MNone * | {Available with one response only)

Wiew Available Desions

Help | Cancel | < Back

DOE++

Ensh |

e Click the Factor Properties button. In the Factor Properties window that appears, enter the names, units
and high and low level values for the factors, as shown next.

MNarme Units | Type | Low Level | High Lewvel =
A | Honing Pressure psi Quantitative 200 400
| B | Mo, of Strokes Quantitative 3 3
C Cycle Tirme sec Quantitative 3 5

b o Juantitative: The results can be generalized to other values,
g Qualitative: The results can only be applied to the levels you define.

[-] OF | Cancel | Help |

Note that these factors are all quantitative (i.e. results can be generalized to values other than the ones
that you provide here), not qualitative (results would be valid only for the values that you provide here),
so leave the Quantitative entry in the Type column for all three factors.

e Click OK to close the Factor Properties window and return to the Design Wizard.
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4 Step-by-Step Examples

e C(Click the Response Properties button. In the Response Properties window that appears, define the
response name, as shown next.

[IjResponse Properties !E[ E
MNarme Units =
Surface Finish |

-

DOE++

OF | Cancel | Help |

e Click OK to close the Response Properties window and return to the Design Wizard.
e Click Next to proceed to the next step.

e The fourth step of the Design Wizard provides a review of the settings you have chosen for the design.

[IjDesign Wizard [ %]
Review the settings vou have chosen for your design.

Step 4
View in & separate window. ..

—Design Review
2 Level Full Factorial Design o

Factors:

Blocks:

Center Points Per Block:
Replicates:

Block On Replicates:
Cbservations:
Responses:

E%MD»—AL\J

-

Factor Properties

Factor Name Units Type  Low Level High Level
A Honing Pressure psi Quantitative 200 400
B Mo, of Strokes Quantitative 3 5
C Cycle Tirme sec Quantitative 3 5

A
Help | Cancel | < Back | Mdexk = |

DOE++

If any of the settings are not as intended, you can click the Back button to return to the appropriate step
and make any necessary changes.

e C(Click Finish to create the new project with the Standard Folio containing the two level full factorial
design.

By default, the Design tab Data Sheet is sorted by the Run Order column, which is the randomized order,
generated by DOE++, in which it is recommended to perform the runs to avoid biased results. For ease of
entry, the data in this example have been presented in the standard order as specified in the design type.
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4.2 Example 2: Two Level Full Factorial Design

e To sort the Data Sheet by the Standard Order column, select Standard Order in the Sort By area in the
Control Panel. The Standard Folio will look like the one shown next.

[ Reliasoft DOE++ =] E3
File Edit ew Project Sheet Data Tools ‘Window Help ‘
e R L EnlEEEEE D
NEEEEEFRIEE TR
@ Projectl ﬁFnlio: Foliol {Design) [_ O]
Standard Folios | =
~[8] | Faliol A1 1 Main Ontlons| Other |
B3 Additional Plots . q : . ¢ Display Factors
[ Other Tooks Standard| Run | Point Block & :Honing Pressure BN, OF Strokes C:Cycle Time curface Finish
Order | Order | Type (psi)y (sec) " Coded values
[0l Spreadshests Iv] & ctusl val
@ Attachments 1 1 6 1 1 200 3 3 e Yeles
2 2 9 1 1 400 3 3 Sort By
El 3 a2 1 1 =200 5 3 £ Fun order
4 4 7 1 1 400 5 3
5
5 5 5 1 1 -0 3 5 Standard Order
5] [ 16 1 1 400 3 5 Design Surmmary
7 7 11 1 1 200 b} 5 l—
Pli)=... wmn
g 2 2 1 1 400 b} b} i —I
9 9 4 1 1 200 8 8
10 1o 15 1 1 400 3 3
11 11 12 1 1 200 5 3
1z 1z 10 1 1 400 5 3
1z 13 1z 1 1 200 3 b}
14 14 1 1 1 400 3 b}
E weibull+ + 135 his} 14 1 1 200 5 5
16 16 2 1 1 400 5 5 -
A ALTA Design I

Loaded folios: 1 | Active Folio "Foliol" |Proiect: Projectl.rsa? ‘

Physical Memory Available: 39,37%

e Save the project by selecting Save from the File menu or by clicking the Save icon.

e When prompted to specify the name and location for the file, browse to the directory of your choice and
type “TwoLevelFullFactorial” for the File name. Accept the default type (*.rso7) and click Save to close
the window and save the file.

e You can now enter the response data in the order given in this example on page 26. The Folio will look
like the one shown next.

EFolio: Foliol {Design} M= E3
al 1 [Main | Optionsl Other I
- e ) - = Display Fact
Standard| Run | Point Block &:Honing Eressure B:ND. Of Sirokes C:Cycle Time Suitem Frigh ] (TR | FER R
Order | Order | Type {psi) (zec) | " Coded Yalues
1 1 & 1 1 o0 3 3 o0 & Actual Values
2 E g 1 1 400 3 3 a0 Sort By
3 3 g 1 1 200 5 3 85 " Run Order
4 4 7 1 1 400 5 3 g0
B
5 5 5 1 1 00 3 5 o Standard Order
4] 4] 16 1 1 400 3 5 105 Diesign Summary
7 7 11 1 1 200 5 5 73 A=
g g 2 1 1 400 5 5 o0
9 9 4 1 1 200 3 3 86
10 10 15 1 1 400 3 3 o0
11 11 12 1 1 200 5 3 g0
12 12 10 1 1 400 5 3 52
13 13 13 1 1 200 3 5 85
14 14 1 1 1 400 3 5 o5
15 15 14 1 1 200 5 5 g0
16 16 3 1 1 400 5 5 50 -
Design |
e Click the Options tab in the Control Panel to view the Options page of the Control Panel.
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4 Step-by-Step Examples

e Specify a Risk Level (Alpha) value of 0.1 for the Surface Finish response and select to use Grouped

Terms in the Test Terms area.*

e Return to the Main page of the Control Panel and click the Calculate icon to perform the analysis.

The Analysis tab will be added to the Standard Folio, as shown next.

ﬁFolio: Foliol {Analysis) M= E3
ATS [Main | Optionsl Other I
A ‘ B ‘ c ‘ D E ‘ F ‘ G ‘ = Response 40
1 ANDVA Table ISurFace Finish j
Degrees  Sum of Mean Transformation
2 %De.l::;ﬁuu: of Squares | Squares  FRatio P Value oy
Freedom [Partial] [Partial] -

3 |Model 7 654.4375 03,4911 5.0707 0.0181 Risk Level {alpha)
4 Iain Effects 3 513.1875 171.0625 0.278 0.0055 0.1
5 2-\Way Interaction 3 140.6875 46,8958 25435 0.1295 _ _
& | 3-way Interaction 1 0.5625 0.5625 | 00305 | 08657 meliysie S
7 |Residual 8 147.5 18.4375 fisitial Ssl I| :m“"e‘j
8 | PureError 8 147.5 18.4375 Calculate
o |Tatal 15 8010375 Observations = 16
10 Analysis Summary
11 S =4.2029 T Fimn | e
12 R-zq = 81.61%
13 R-sq(ad]) = 65.51%
14
15 Regression Information
16 Term Effect | Coefficient Stg:i?rd Low CI | HighCI T ¥alue P Yalue
17 Intercept 86,4373 1.0735 84,4413 884337 | 805214 6.31E-13
18 | A:Honing Pressure 5.125 2.5625 1.0735 0.5663 4.5587 2.3871 0.0441
19 B:Mo, of Strokes -0.873 -4,9375 1.0735 -6,9337 | -2.9413 | -4.5996 0.0018
20 C:Cycle Time 2125 1.0625 1.0735 -0.9337 3.0587 0.9595 0.3513
21 AR -2.125 -1.0625 1.0735 -3.0587 0.9337 -0.9598 0.3513
22 AC 4,875 2.4375 1.0735 0.4413 4.4337 2.2707 0.0528
23 BC -2.625 -1.3125 1.0735 -3.3087 0.6837 -1.2227 0.2563
24 ABC -0,375 -0,1875 1.0735 -2,1837 1.8087 -0,1747 0.8657 |-

4 | »

Design  Analysis |

In the Regression Information table, note that factor A (honing pressure) and factor B (number of strokes)
and the interaction between factors A and C (cycle time), along with their p values, are red, indicating that at
a significance level of 10%, these effects are significant.

e To validate the normality assumption graphically, we will use the Residual Probability plot. Plot the data
by selecting Plot from the Data menu or by clicking the Plot icon.

4 Note that these options can be specified separately for each response if more than one response is used in the design.
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4.2 Example 2: Two Level Full Factorial Design

Select Residual Probability from the Plot Type menu in the Control Panel. The Residual Probability

plot will be displayed, as shown next.

EFD

Folio1 (Plot)
) Mormal Probability Plot of Residual

M=l B

Plat Type Q|

|[Residusl Probabilty =l |
Response

| surface Finish |

¥ Auta Refresh
¥ Keep Aspect Ratio

i

ukomatic Scaling

¥ Round ¥-Scale
¥ Round #-Scale

Probility

Residuals

||Regular Residual

L

Residual
TriksorrDerling = 0 3015; redee = 0o5s
Design I Analysis  Plot I

The data points follow the line reasonably closely, indicating that the normality assumption is valid.

The Effects window will appear, as shown next.
]

Response: ISurFace Finish j O I
Lirnit by Order: IS-Way Inkeraction j Cancel |

Select Significant Effects | Help |

EEffects

Effect Mame

A :Honing Pressure:
B:Mo. of Strokes
CiCyele Time

A

aC

EC

ABC

Reset Defaulks

™| Triclude Elacks i Made!
| Triclude: Curvature in Mads]

DOE++

Select Select Effects from the Data menu or click the Select Effects icon in the Control Panel.

To determine the parameters of the model, we will need to analyze the data set including only the
significant effects. To do this, return to the Analysis tab by clicking its page index tab.

DOE++ Training Guide
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4 Step-by-Step Examples

e Click the Select Significant Effects button to select only the effects that were shown to be significant.
This will clear the checkboxes beside the AB, BC and ABC effects, leaving only effects A, B, C and AC

selected, as shown next.

[IjElTects [ %]
Response: ISurFace Finish j O I
Lirnit by Order: |2-Way Inkeraction j Cancel |

Select Significant Effects | Help |

I Effect Mame _

A:Honing Pressure Reset Defaults |
B:Mo. of Strokes

CiCyele Time

Oas

aC

Osc

Ozec

™| Triclude Elacks i Made!
| Triclude: Curvature in Mads]

DOE++

Note that selections in the Effects window must be hierarchical—if you select to include any second
order or greater effect, all related main effects must also be included. Thus, in this case, effect C is
included in order to include effect AC.

e Click OK to accept your selections and close the window. Note that the status indicator in the Response
area of the Control Panel is now red, indicating that you have made changes since the data set was last
analyzed, and the status in the information area of the Control Panel says “Edited.”

e In the Analysis Settings area of the Control Panel, click inside the Test Terms area to toggle the analysis
settings from Grouped to Individual. This performs the same function as changing from Grouped
Terms to Individual Terms on the Options page of the Control Panel.
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4.2 Example 2: Two Level Full Factorial Design

e C(Click the Calculate icon to re-analyze the data set using the selections you have just made. The changed

Analysis tab is shown next.

[IjFolio: Foliol {Analysis) M= E3

IMain | Optionsl Other I

AZS
A ‘ B ‘ c ‘ D E ‘ F ‘ G ‘ = Response 40
1 ANDVA Table ISurFace Finish j
Degrees  Sum of Mean i
2 %De.l::;ﬁuu: of Squares | Squares  FRatio P Value Tranjo::,atmn
Freedom [Partial] [Partial]
3 |Model 4 608,25 152.0625 5.636 0.0021 Risk Level {alpha)
4 A:Honing Pressure 1 105.0625 | 105.0625 | 59668 | 0.0327 0.1
5 B:Mo, of Strokes 1 3900625 390.0625 | 22,1526 0.0006
& | C:Cycle Time 1 18.0625 | 18.0625 @ 1.0258 | 0.3329 Analysis Settings
7 | ac 1 950625 | 050625 | 5.3988 | 0.0403 Partial 55| Individual
8 [Residual 11 193.6675 | 17.608 G alind
9 | Lack of Fit 3 46,1875 | 153958 0835 | 0.5114 Obsetvations = 15
10 Pure Error a 147.5 18,4375 Analysis Summary
11 |Total 15 B801.9375 P
12
13 5 = 4.1962
14 R-zq =75.83%
15 R-sgfadj) = 67.06%
16
17 Regression Information
18 Term Effect | Coefficient Stg:i?rd Low CI | HighCI T ¥alue P Yalue
19 Intercept 86,4373 1.049 84,5535 88,3215 | 823963  1.11E-16
20 AHoning Pressure 5.125 2.5625 1.049 0.6785 4.4465 2.4427 0.0327
21 B:Mo, of Strokes -0.873 -4,9375 1.049 -6.8215 | -3.0535 | -4.7067 0.0006
22 C:Cycle Time 2125 1.0625 1.049 -0.8215 294685 1.0128 0.3329
23 AC 4,875 2.4375 1.049 0.5535 4,3215 2.3235 0.0403 |+
4 | »

Design Analysis | Plak I
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4 Step-by-Step Examples

e C(Click the Show Analysis Summary (...) icon at the lower right side of the Control Panel to view the
analysis summary in the Results Panel. The Analysis Info page of the analysis summary is shown next.

ﬁnnalysis Summary !E[ E
e R EERE
A B [ C D E F -
1  |Surface Finish Results _
2
2 |Transform: ¥' =%
4
5 |Factor Properties
5]
7 Factor Name Units Type  Low Level High Level
=] A Honing Pressure psi Quantitative 200 400
9 B Mo, of Strokes Quantitative 3 5
10 C Cycle Tirme sec Quantitative } 5

13 |Significant Effects at Alpha = 0.1:

15 Name P value

16 AHoning Pressure 0.0327

17 B:Mo. of Strokes 0.0006

18 AC 0.0403

19

20

21 |Equation in terms of Coded values:

22

23 86.4375

24 +2.5625 | * A:Honing Pressure

25 -4.9375 * B:Mo. of Strokes

26 +1.0625 | * C:Cycle Time

27 +2,4375 | * AC

28

29 |Equation in terms of Actual values:

30

31 1235

32 -0.0719 * A:Honing Pressure

33 -4.9375 * B:Mo. of Strokes

34 -5.2500 * C:Cycle Time
+0,0244 | * AC

35
4| » MAnalysis Info A Alias Structure

War_Cov Matrix A 4] |

s

The parameters of the model are shown in the Equation in terms of Actual values section. This can be

rewritten as:

7 = 123.5000 - 0.0719x, — 4.9375x, — 6.2500x; + 0.0244x  x,

e Click the Close button in the Results Panel toolbar to close the window.

e Save the project by selecting Save from the File menu or by clicking the Save icon.

e Close the project by selecting Close from the File menu and proceed to the next example.

4.3 Example 3: Two Level Fractional Factorial Design

A researcher is interested in investigating different membrane operating conditions for an affinity membrane
chromatographic column. The experiment consists of feeding a protein solution of concentration C, through

the porous membrane column. As the solution runs through the column, targeted protein molecules are
immobilized. The concentration of the effluent C is measured, which increases with time as the column
approaches saturation. The response is the processing time, i.e. the time by which the effluent concentration
reaches a breakthrough, Cgp, where Cgp = C/C,,. In other words, if Cgr equals 0.1, the processing time is

the time by which the concentration of the effluent reaches 10% of the concentration of the initial solution.
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4.3 Example 3: Two Level Fractional Factorial Design

Given the large number of factors that the researcher is attempting to explore and due to time and resource
constraints, she decides to perform a fractional factorial design with 32 runs with the following factor

settings:

Factor Units Low Level High Level
Inlet mol/m3 SE-5 10E-5
concentration
Inlet flow-rate m3/s 1E-8 1E-7
Column length m 0.5 1
Column m 0.01 0.1
diameter
Bead porosity - 0.7 0.8
Bead radius m 4E-5 8E-5
CBT - 0.2 0.8
Results obtained from the experiment are shown next.
Inlet Inlet Column | Column Bead Bead .
concentration | flow-rate length diameter | porosity | y,4iys | CBT Tu.ne
(mol/m3) (m3/s) (m) (m) (m) (min)
5.00E-05 1.00E-08 0.5 0.01 0.7 0.0008 | 0.8 109
1.00E-04 1.00E-08 0.5 0.01 0.7 0.0004 | 0.2 100
5.00E-05 1.00E-07 0.5 0.01 0.7 0.0004 | 0.2 110
1.00E-04 1.00E-07 0.5 0.01 0.7 0.0008 | 0.8 105
5.00E-05 1.00E-08 1 0.01 0.7 0.0004 | 0.2 73
1.00E-04 1.00E-08 1 0.01 0.7 0.0008 | 0.8 111
5.00E-05 1.00E-07 1 0.01 0.7 0.0008 | 0.8 102
1.00E-04 1.00E-07 1 0.01 0.7 0.0004 | 0.2 73
5.00E-05 1.00E-08 0.5 0.1 0.7 0.0004 | 0.8 85
1.00E-04 1.00E-08 0.5 0.1 0.7 0.0008 | 0.2 98
5.00E-05 1.00E-07 0.5 0.1 0.7 0.0008 | 0.2 100
1.00E-04 1.00E-07 0.5 0.1 0.7 0.0004 | 0.8 83
5.00E-05 1.00E-08 1 0.1 0.7 0.0008 | 0.2 90
1.00E-04 1.00E-08 1 0.1 0.7 0.0004 | 0.8 93
5.00E-05 1.00E-07 1 0.1 0.7 0.0004 | 0.8 86
1.00E-04 1.00E-07 1 0.1 0.7 0.0008 | 0.2 84
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4 Step-by-Step Examples

Inlet Inlet Column | Column Bead Bead .
concentration | flow-rate length diameter | porosity | ya4iys | CBT Tn.ne
(mol/ m3 ) (m3/ s) (m) (m) (m) (min)
5.00E-05 1.00E-08 0.5 0.01 0.8 0.0008 0.2 47
1.00E-04 1.00E-08 0.5 0.01 0.8 0.0004 0.8 155
5.00E-05 1.00E-07 0.5 0.01 0.8 0.0004 0.8 165
1.00E-04 1.00E-07 0.5 0.01 0.8 0.0008 0.2 50
5.00E-05 1.00E-08 1 0.01 0.8 0.0004 0.8 153
1.00E-04 1.00E-08 1 0.01 0.8 0.0008 0.2 30
5.00E-05 1.00E-07 1 0.01 0.8 0.0008 0.2 33
1.00E-04 1.00E-07 1 0.01 0.8 0.0004 0.8 150
5.00E-05 1.00E-08 0.5 0.1 0.8 0.0004 0.2 44
1.00E-04 1.00E-08 0.5 0.1 0.8 0.0008 0.8 142
5.00E-05 1.00E-07 0.5 0.1 0.8 0.0008 0.8 139
1.00E-04 1.00E-07 0.5 0.1 0.8 0.0004 0.2 40
5.00E-05 1.00E-08 1 0.1 0.8 0.0008 0.8 148
1.00E-04 1.00E-08 1 0.1 0.8 0.0004 0.2 21
5.00E-05 1.00E-07 1 0.1 0.8 0.0004 0.2 23
1.00E-04 1.00E-07 1 0.1 0.8 0.0008 0.8 151
Do the following:

e Examine the fraction generators and the alias structure.

e Identify the significant effects using the Effect Probability plot and reduce the model accordingly.’

e If the researcher is to determine membrane operating conditions that will optimize the column capacity
(i.e. minimize the breakthrough time) what should the next step be?

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\DOE\Training Guide) and is named “TwoLevelFractionalFactorial.rdoe.” The
data set for this example is available in the Spreadsheet in the “TwoLevelFractionalFactorial-Data.rso7”
file located in the “Raw Data” folder within the “Training Guide” folder.

> Note that since there are no replicates in this design, Lenth's method is applied in the Effect Probability plot to
determine significant effects. Alternatively, the analyst might choose to assume the third order effects are negligible.
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4.3 Example 3: Two Level Fractional Factorial Design

Solution

e C(Create a new project by clicking Create a New Project in the initial window, by selecting New from the
File menu or by clicking the New icon.

d

e On the first page of the Design Wizard, select to create a Factorial Design and click Next to proceed to
the next step.

EDesign Wizard [ %]

Specify the type of Design of Experiments.

—Create a new project using. ..

[” One Factor Design
|- 29 Choose this ko compare mean values at each level of a single Factor, 7]

ti—| ¥ Factorial Design
r;f"f'f_,_ Choose this ko simulkaneously study the effects of several Factors (e.q. Fractional Factorial, 71
General Factorial, Plackett-Burman ...},

|® [” Response Surface Method Design
Choose this ko establish a relationship between factors and responses (e.g. Central Composite, (el

Box-Behnken Design ...

.| [T Taguchi Robust Design

Choose this to use Taguchi's methods {e.q. Robust Parameter Design ...}, 7]

" Reliability DDE
Choose this For life test designs, especially when you expect interval data or suspensions from 71
the experiments,

DOE++

Help Load Last Design. .. Cancel | = Back Eimish |

e In the second step of the Design Wizard, select 2 Level Fractional Factorial Design and click Next to
proceed to the next step.

| Design Wizard [ %]

T -\ Define the design type for your Factorial Design.

Step 2

—Factorial Design

A7 [" 2 Level Full Factorial Design

1 7 Choose this if the experiment. includes all combinations of the Factors, 7]
g ¥ 2 Level Fractional Factorial Design
Choose this if the experiment. includes only part of all combinations of the Factors, 71
ol " Plackett-Burman Design
b o Choose this to study the main effect of multiple Factors, Each Factor has only bwo levels, (7]
Vﬁ] [” General Full Factorial Design
Choose this if the experiment. includes all combinations of the Factor levels, Each factor can (7]

have any number of levels,

« [” Taguchi DA Factorial Design
;ﬁ Choose this to use Taguchi's Orthogonal Array, Each Factor can have multiple levels, 71

DOE++

Eimish

Help | Cancel < Back
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4 Step-by-Step Examples

e In the third step of the Design Wizard, select 7 from the Factors drop-down and 32 runs, 1/4 from the
Fractions drop-down and leave all other fields at their default settings, as shown next.

[IjDesign Wizard [ %]

"""": Define the design profile for your factorial desiagn.

Step 3

& Level Fractional Factorial Design

Factors I? VI Factor Properties |
Fractions |32 runs, 1/4 'l Fraction Generator |
Blocks |1 'l Elock Properties |

Center Points Per Block ID 'l
Replicates |1 vl ™| Block On Replicates :I
Responses |1 VI Response Properties |

Repeated Measurements INone 'l {Available with one response only)

Wiew Available Desions

Help | Cancel | < Back |

DOE++

Ensh |

e Click the Factor Properties button. In the Factor Properties window that appears, enter the names, units,
types and high and low level values for the factors, as shown next.

[IjFactor Properties !E[ E
MNarme Units | Type | Low Level | High Lewvel |=

| & |Inlet concentration mal/m~3 | Quantitative 5.00E-05 0.0001

| B | Inlet flow-rate m"3fs Quantitative 1.00E-02 1.00E-07

|C | Colurmn length m Quantitative 0.5 1

|0 | Caolumn diameter m Quantitative 0.01 0.1

|E | Bead parosity Quantitative 0.7 0.8

| F | Bead diameter m Quantitative 0.0004 0.0002

G CBT Quantitative 0.2 0.8

t Quantitative: The results can be generalized to other values,

{['] Qualitative: The results can only be applied to the levels you define.
o]
[=]

OF | Cancel | Help |

e Click OK to close the Factor Properties window and return to the Design Wizard.
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4.3 Example 3: Two Level Fractional Factorial Design

e C(Click the Response Properties button. In the Response Properties window that appears, define the
response name, as shown next.

[IjResponse Properties !E[ E
Name Units =
Time min |

+

+

- <

[-] OF | Cancel | Help |

e Click OK to close the Response Properties window and return to the Design Wizard.

e C(Click the Fraction Generator button to open the Fraction Generator window, which allows you to
specify the generators, or factorial interactions whose effects will be aliased with the main effects of
particular factors. Default generators are automatically supplied, as shown next.

[IjFraction Generator !E[ E
Factors Sign | Generators |~
F _[Bead diameter + apC0 |
LRSSl

5] CBT + ABCE

+

+

[[] =

o]

[ =] Reset | QK | Cancel | Help |

These generators create an alias structure for the design, which we will examine in an upcoming step.
e Accept the default generators and click OK to close the window and return to the Design Wizard.

e Click Next to proceed to the next step.
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4 Step-by-Step Examples

e The fourth step of the Design Wizard provides a review of the settings you have chosen for the design.

[IjDesign Wizard [ %]
——

Review the settings you have chosen for your design.

Step 4

View in & separate window. ..

—Design Review

2 Level Fractional Factorial Design

Factors: 7
Fraction: 1/4
Blocks: 1
Center Points Per Block: 0
Replicates: 1
Block On Replicates: N
Cbservations: 32
Responses: 1

Factor Properties

Factor Name Units Type  Low Level High Level
A Inlet concentration malfm™3 Quantitative 5.00E-05 0.0001
B Inlet flow-rate m"3fs  Quantitative 1.00E-08  1.00E-07 -
+
A 4| ¥ [\Initial Design /A Tritial &lias Structure 7 K |
(o}
o Help | Cancel | < Back | [ext = |

Note that there is an additional tab called “Initial Alias Structure” in the summary area. Click this tab to

view the alias structure of the design, as shown next.

[IjDesign Wizard [ %]

"""": Review the settings vou have chasen for your design,

Step 4

View in & separate window. ..

—Design Review

Initial Alias Structure:

Fraction Generators:
F = ABCD
G = ABCE

[1] =1+ DEFG + ABCDF + ABCEG
[A] = & + BCDF + BCEG + ADEFG
[B] =B + ACDF + ACEG + BOEFG
[C] =C + ABDF + AREG + CDEFG
[D] =D + EFG + ABCF + ABCDEG
[E] =E + DFG + ABCG + ABCDEF
[F] =F + DEG + ABCD + ABCEFG
[G] = G + DEF + ABCE + ABCDFG
[4B] = AB + CDF + CEG + ABDEFG
[AC] = AC + BDF + BEG + ACDEFG

* [ Initial Design_Anitial Alias Structure’ 4|

pis

DOE++

Cancel | < Back

Help |

I Ensh |

If any of the settings shown in these two tabs are not as intended, you can click the Back button to return

to the appropriate step and make any necessary changes.

e C(Click Finish to create the new project with the Standard Folio containing the two level fractional

factorial design.

By default, the Design tab Data Sheet is sorted by the Run Order column, which is the randomized order,
generated by DOE++, in which it is recommended to perform the runs to avoid biased results. For ease of
entry, the data in this example have been presented in the standard order as specified in the design type.

42

http://DOE.ReliaSoft.com



4.3 Example 3: Two Level Fractional Factorial Design

e To sort the Data Sheet by the Standard Order column, select Standard Order in the Sort By area in the
Control Panel. The Standard Folio will look like the one shown next, as shown next.

[ Reliasoft DOE++

File Edt Wisw Project Shest Data Took Window Help

=] E3

i FEF LR R hEEEEEE

AvEEal=l [#][aaswE- e
[5]] Projsctl [ Folio: Foliol (Design) M= B
= By Standard Falios
.5 Folot a1 wain | optians | other |
Additional Flots Aidniet | Binlet | CiColumn |DiColumn | o, FiBead )
& o o S| Rin | PO | o cocannaton| fowrats | g | et | 525 et |cicer | Time e
B Sreadshests (mol/m=3) | (m~3/s) (m) )] (m} ] =
B Attachments 1 1 16 1 1 SE-005 | 1E-008 05 0.01 07 00008 | 08 prie]vuee
2 2 1 1 00001 | 1E-008 05 0.01 07 | 0004 | 02 =T
a a 4 1 1 SE-005 | 1E-007 0s .01 07 | 00004 | 02 o
4 4 E 1 1 00001 | 1E-007 05 0.01 07 | 00008 | 08 e
5 5 19 1 1 SE-005 | 1E-008 1 .01 07 | 00004 | 02
5 & 1 1 1 00001 | 1E-008 1 0.01 07 | 00008 | 08 [~ Desgnsummary
7 7 21 1 SE-005 | 1E-007 1 .01 07 | 00008 | 08 [ Er——
E ) 5 1 1 00001 | 1E-007 1 0.01 07 | 0004 | 02 =]
E] E] a 1 1 SE-005 | 1E-008 0s 01 07 | 00004 | 08
10 10 7 1 1 00001 | 1E-008 05 01 07 | 00008 | 02
1 no o 1 1 SE-005 | 1E-007 0s 01 07 | 0008 | 02
2 L2 1 1 00001 | 1E-007 05 01 07 | 0004 | 08
13 13 2 1 1 SE-005 | 1E-008 1 01 07 | 0008 | 02
14 ¥ 10 1 1 00001 | 1E-008 1 01 07 | 0004 | 08
15 15 18 1 1 SE-005 | 1E-007 1 01 07 | 00004 | 08
16 14 1 1 00001 | 1E-007 1 01 07 | 00008 | 02
17 7 s 1 1 SE-005 | 1E-008 0s 001 08 | 00008 | 02
W weibull++ 18 1B 17 1 1 00001 | 1E-008 05 0.01 08 | 0004 | 08
pemm—s 19 a1 1 SE-005 | 1E-007 0s .01 08 | 00004 | 08
Al ALTA 20 20 26 1 1 0.0001 1E-007 05 0.01 0.3 00003 | 02

b S

Loaded folios: 1 | Active Folio "Folial” |Project: Project L.rso7 |

Physical Memory Avallable: 34,.23%

Note that not all rows are displayed in the image above. Your design will contain 32 rows.

Save the project as “TwoLevelFractionalFactorial.rso7.”

e Enter the response data in the order given in this example on page 37. The Folio will look like the one

shown next.

[EFolio: Folio1 (Design) M=]
L32 151 Main | Optiunsl Other |
) AInlet B:Inlet |C:Colurnn |D:Columin |E:Bead | F:Bead ) ;
Stg:;;rd ORrgzr ??;:‘: Block |concentration |flow-rate | length | diameter porosity diameter |G :CET grlnme) ~ CDd::S:::Etms
{molfm~3y | (m~2/) | (m) {3 @) {rm) v =

1 123 1 1 SE-005 | 1E00B | 05 001 | 07 00008 08 | 109 D (s

2 2 12 1 1 0.0001 1E-008 05 0.01 0.7 0.0004 | 0.2 100 Sart By

3 3 13 1 1 SE-005 1E-007 05 0.01 0.7 0.0004 | 0.2 110  Run Order

4 4 19 1 1 0.0001 1E-007 05 0.01 0.7 00008 | 08 105 & Standard Order

5 =1 22 1 1 SE-005 1E-005 1 0.01 0.7 0.0004 | 0.2 73

5] 5] 3 1 1 0.0001 1E-005 1 0.01 0.7 00008 | 08 111 Design SUmmary
7 7 32 1 1 SE-005 1E-007 1 0.01 0.7 0.0002 0.8 102 Pll=s .
8 g 30 1 1 0.0001 1E-007 1 0.01 0.7 0.0004 | 0.2 73

9 Q 7 1 1 SE-005 1E-008 05 0.1 0.7 0.0004 | 0.8 g5

10 10 5] 1 1 0.0001 1E-008 05 0.1 0.7 00008 | 0.2 95

11 11 15 1 1 SE-005 1E-007 05 0.1 0.7 00008 | 0.2 100

12 12 25 1 1 0.0001 1E-007 05 0.1 0.7 0.0004 | 0.8 a3

13 13 17 1 1 SE-005 1E-005 1 0.1 0.7 00008 | 0.2 90

14 14 11 1 1 0.0001 1E-005 1 0.1 0.7 0.0004 | 0.8 93

15 15 18 1 1 SE-005 1E-007 1 0.1 0.7 0.0004 0.8 86

16 16 1 1 1 0.0001 1E-007 1 0.1 0.7 0.000g | 0.2 84

17 17 2 1 1 SE-005 1E-008 05 0.01 0.8 00008 | 0.2 47

18 18 14 1 1 0.0001 1E-008 05 0.01 0.8 0.0004 | 0.8 155

19 19 29 1 1 SE-005 1E-007 05 0.01 0.8 0.0004 | 0.8 165

20 20 16 1 1 0.0001 1E-007 05 0.01 0.8 00008 | 0.2 S0

21 21 28 1 1 SE-005 1E-005 1 0.01 0.8 0.0004 | 0.8 153

22 22 3 1 1 0.0001 1E-005 1 0.01 0.8 00008 | 0.2 30

23 23 21 1 1 SE-005 1E-007 1 0.01 0.8 0.0008 0.2 33

24 24 10 1 1 0.0001 1E-007 1 0.01 0.8 0.0004 | 0.8 150

25 25 28 1 1 SE-005 1E-008 05 0.1 0.8 0.0004 | 0.2 44

26 26 =] 1 1 0.0001 1E-008 05 0.1 0.8 0.0008 | 08 142

27 27 El 1 1 SE-005 1E-007 05 0.1 0.8 0.0008 | 0.8 139

28 28 31 1 1 0.0001 1E-007 05 0.1 0.8 0.0004 | 0.2 40

29 29 24 1 1 SE-005 1E-005 1 0.1 0.8 00008 | 08 148

30 30 4 1 1 0.0001 1E-005 1 0.1 0.8 0.0004 | 0.2 21

31 31 20 1 1 SE-005 1E-007 1 0.1 0.8 0.0004 0.2 | 23

32 32 27 1 1 0.0001 1E-007 1 0.1 0.8 0.0008 | 0.8 151 A
Design
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4 Step-by-Step Examples

e To examine the alias structure for the design, click the Show Design Summary (...) icon at the lower
right side of the Control Panel. The design summary will be displayed in the Results Panel, as shown

next.

[IjDesign Summary !E[ E
e R EERE
A B c | D [ E [ F -

1 |2 Level Fractional Factorial Design _

2

3

4 [Initial Design Information

5

5] Factors: 7

7 Fraction: 1/4

g Blocks: 1

9 Center Points Per Block: 0

10 Replicates: 1

11 Block On Replicates: ND

12 CObservations: 32

13 Fesponses: 1

14

15

16 |Factor Properties

17

18 Factor Name Units Type  Low Level High Level

19 A Inlet concentration malfm™3 Quantitative  5.00E-05 0.0001

20 B Inlet flow-rate m"3fs Quantitative 1.00E-02 | 1.00E-07

21 C Colurnn length m Quantitative 0.5 1

22 u] Column diameter m Quantitative 0.01 0.1

23 E Bead porosity Quantitative 0.7 0.8

24 F Bead diameter m Quantitative 0.0004 0.0002

25 G CBT Quantitative 0.2 0.8

26

27

28 |Fraction Generators:

29 |F=ABCD

30 |G =aRCE

31

32

2B

34

25

36

37

38 -
<[+ [\Initial Design /A Tritial &lias Structure A Corent 4] | LlJ
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4.3 Example 3: Two Level Fractional Factorial Design

Click the Alias Structure page index tab of the design summary to view the initial alias structure, as
shown next.

ﬁDesign Summary !E[ E
e R EERE
A& | B [ ¢ [ D [ E [ F [ @ -

1 |Initial Alias Structure: _

2

3 Fraction Generators:

4 F = &BCD

5 5 = ABCE

4]

7 [1] =1+ DEFG + ABCDF + ABCEG

g [4] = & + BCDF + BCEG + ADEFG

9 [B] =B + ACDF + ACEG + BDEFG

10 [C] =C + ABDF + ABEG + CDEFG

11 [D] =D + EFG + ABCF + ABCDEG

12 [E] = E + DFG + ABCG + ABCDEF

13 [F] =F + DEG + ABCD + ABCEFG

14 [G] = G + DEF + ABCE + ABCDFG

15 [4B] = AR + CDF + CEG + ABDEFG

16 [4C] = AC + BOF + BEG + ACDEFG

17 [4D] = AD + BCF + AEFG + BCDEG

18 [4E] = AE + BCG + ADFG + BCDEF

19 [4F] = AF + BCD + ADEG + BCEFG

20 [45] = AG + BCE + ADEF + BCDFG

21 [BC] = BC + ADF + AEG + BCDEFG

22 [BD] = BD + ACF + BEFG + ACDEG

23 [BE] = BE + ACG + BDFG + ACDEF

24 [BF] = BF + ACD + BDEG + ACEFG

23 [BG] = BG + ACE + BDEF + ACDFG

26 [CD] = CD + ABF + CEFG + ABDEG

27 [CE] = CE + ABG + CDFG + ABDEF

28 [CF] = CF + ABD + CDEG + AREFG

29 [CGE] = CG + ABE + CDEF + ARDFG

30 [DE] = DE + FG + ABCDG + ARCEF

31 [DF] = DF + EG + ABC + ARCDEFG

32 [DG] = DG + EF + ABCDE + ARCFG

33 [4DE] = ADE + AFG + BCDG + BCEF

34 [4DG] = ADG + AEF + BCDE + BCFG

35 [BDE] = BDE + BFG + ACDG + ACEF

36 [BDG] = BDG + BEF + ACDE + ACFG

37 [CDE] = CDE + CFG + ABDG + ABEF

28 [CDG] = CDG + CEF + ABDE + ABFG -
«| [ Initidl Design_Mnitial Alias Structure Current 44| LlJ

This specifies every instance of aliasing (or confounding) in the design, where the effect of a certain
factor or factorial interaction cannot be separated from another effect.

e Click Close to close the Results Panel.

e On the Options page of the Control Panel, specify a Risk Level (Alpha) value of 0.1 for the Time
response and select to use Grouped Terms.

e Return to the Main page of the Control Panel and click the Plot icon.
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4 Step-by-Step Examples

The data set will be analyzed automatically and the Analysis and Plot tabs will be added to the Folio. The
Effect Probability plot, created by default, is shown next.
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B 50000
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1.000 10:08:00 AM
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The significant main effects are shown to be C (column length), D (column diameter), F (bead diameter) and
G (CBT). Significant interactions are CD, CF, CG, DF and DG.
e Go to the Analysis tab by clicking its page index tab.

o Select Select Effects from the Data menu or click the Select Effects icon in the Control Panel.

e In the Effects window, click the Select Significant Effects button to select only the effects shown to be
significant (C, D, F, G, CD, CF, CG, DF and DG), as shown next. Note that not all selections are
displayed in this image.

EEffects [ %]

Resporise: ITime j QK I
Lirnit by Order: |2-Way Inkeraction j Cancel |

Select Significant Effects | Help |

I Effect Mame

[} 2 Inlet concentration MI
Oe:1nlet Flove-rate

C:Column length

[ Column diameter

OE:Bead porosity

F:Bead diameter

GiCBT

O:ze

Oac

Oac

Oze

Oer x|
™| Triclude Elacks i Made!

| Triclude: Curvature in Mads]

DOE++

46 http://DOE.ReliaSoft.com



4.4 Example 4: General Full Factorial Design

e Click OK to accept your selections and close the window.

e In the Analysis Settings area of the Control Panel, click inside the Test Terms area to toggle the analysis
settings from Grouped to Individual.

e C(Click the Calculate icon to re-analyze the data set using the selections you have just made. The changed
Analysis tab is shown next.

ﬁFnliD: Foliol (Analysis) |_ (O] x|
A4l Main I Optlonsl Other I
& ‘ B ‘ C ‘ D ‘ E ‘ F ‘ G ‘ H I H Response @)
1 ANOVA Table [ime =l
Degrees  Sum of Tean Transformation
2 [Bource of Yariation of Squares  Squares FRatio P Yalue
Freedom [Partial]  [Partial]
3 [Model g 5.96E+04  6183.0868 496.1127 | 2.79E-23 Risk Level (alpha)
4 C:Column length 1 7125312 7125312 | 571714 | 1.49e-07 .
5 D:Colurmn diameter 1 603.7813 603.7813  48.4456 | 5.49e-07
& | F:Bead diameter 1 2257813 2257813 18116 | 0.0002 Analysis Settings
7 | cicer 1 2.80E+04  2,00E+04  2315.6442 B.EEE-24 Partiel 55| Individual
8 | 1 2050312 2050812 | 164511 | 0.0005 Obs;t:':;:i =
9 CF 1 148.7813 1487813 | 11.9378 0.0023
10 CG 1 935.2813 9353.2813 | 750442 | 1.54E-08 Analysis Summary
11 CF 1 2.36E+04 | 2.36E+04 1893.4969  7.75E-23 T -
12 D5 1 357.7812 3577812 | 287073 | 2.22E-05
13 |Residual 22 274.1875 12.4631
14 Lack of Fit g 46,6875 77813 0.5473 0.7651
15 Pure Error 16 227.5 14,2183
16  |Total 31 5.59E+04
17
15 5 = 3.5303
19 R-s0 = 99.51%
20 R-sg(ad]) =|99.31%
21
22 Regression Information
23 Term Effect | Coefficient Stg::i?rd Low CI | HighCI | T%alue P Value
24 Intercept 035312 05241 02,4396 | 946020 @ 140.8716 o

25 CiColurnn length -9.4375 -4.7188 06241 -5.7904 | -35471 ) -7.5612 | 14907
26 DiColurn diameter | -8.6873 -4.3438 06241 -0.41534 | -3.2721 0 -6.9603 | 549E-07

27 F:Bead diameter 53125 2.6563 06241 1.5848 37279 4.2563 0,000

28 GICBET 60,0625 30,0312 06241 289396 | 311029 | 48,1211 1]

=g ch 5.0625 2.5313 0.6241 1.4596 3.6029 4.056 0.0005

=0 CF 43125 2.1562 06241 1.08485 3.2279 3.4551 0.0022

21 CG 10,8125 5.4062 06241 4,33245 6.4779 2.6628 | 1.54E-03

=2 DOF 54,2125 27,1562 06241 26,0846 | 282270 | 4351432 0

23 DG -6.6875 -3.3438 06241 -4.4154 | 22721 | -5.3579 | 222605 f

*

1
Design  Analysis Plutl

If the researcher is to determine membrane operating conditions that will optimize the column capacity (i.e.
minimize the breakthrough time), she might chose to augment the design by adding center points. If the
curvature is found to be significant, then a response surface methodology analysis might be beneficial.
Otherwise, optimization with the current design can be performed. These steps are demonstrated in
“Example 7: Sequential Optimization” on page 70.

e Save and close the project then proceed to the next example.

4.4 Example 4: General Full Factorial Design

During warranty analysis, a cylinder assembly was found to be problematic, translating into more warranty
returns than expected. As part of the analysis, the engineers would like to know if different factors have a
significant effect on the high number of warranty claims observed. Factors that they would like to explore
include the region where the assembly was deployed (Region A, B or C), the engine type (gasoline, diesel,
ethanol or hybrid) and the supplier for key components (S1 or S2).

The analyzed response was measured in terms of the reliability at the end of the warranty period and was
obtained through warranty analysis of sold items and warranty claims. Note that the results were not
obtained through a controlled experiment, as the warranty claims were recorded as they arrived.
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4 Step-by-Step Examples

The data set is shown next.

Do the following:

Region Engine Type Supplier R:)z]i:?;;izyat
A Gasoline S1 0.973
A Gasoline S2 0.991
A Diesel S1 0.971
A Diesel S2 0.971
A Hybrid S1 0.978
A Hybrid S2 0.956
A Ethanol S1 0.988
A Ethanol S2 0.978
B Gasoline S1 0.988
B Gasoline S2 0.978
B Diesel S1 0.992
B Diesel S2 0.976
B Hybrid S1 0.999
B Hybrid S2 0.977
B Ethanol S1 0.995
B Ethanol S2 0.975
C Gasoline S1 0.977
C Gasoline S2 0.93
C Diesel S1 0.971
C Diesel S2 0.928
C Hybrid S1 0.96
C Hybrid S2 0.896
C Ethanol S1 0.916
C Ethanol S2 0.932

o Identify the significant effects, assuming that third order effects are negligible.

e Identify the critical population(s).
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4.4 Example 4: General Full Factorial Design

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\DOE\Training Guide) and is named “GeneralFullFactorial.rdoe.” The data set

for this example is available in the Spreadsheet in the “GeneralFullFactorial-Data.rso7” file located in the
“Raw Data” folder within the “Training Guide” folder.

Solution

e Create a new project. On the first page of the Design Wizard, select to create a Factorial Design and
click Next to proceed to the next step.

EDesign Wizard [ %]

L Specify the type of Design of Experiments.

Step 1

—Create a new project using. ..

[” One Factor Design
|- 29 Choose this ko compare mean values at each level of a single Factor, 7]

.—| ¥ Factorial Design
r;f"f'f_,_ Choose this ko simulkaneously study the effects of several Factors (e.q. Fractional Factorial, 71
General Factorial, Plackett-Burman ...},

|® [” Response Surface Method Design
Choose this ko establish a relationship between factors and responses (e.g. Central Composite, (el

Box-Behnken Design ...

Choose this to use Taguchi's methods {e.q. Robust Parameter Design ...}, 7]

.| [T Taguchi Robust Design

" Reliability DDE
Choose this For life test designs, especially when you expect interval data or suspensions from 71
the experiments,

DOE++

Eiish |

Help Load Last Design. .. Cancel | = Back

e In the second step of the Design Wizard, select General Full Factorial Design and click Next to
proceed to the next step.

EDesign Wizard [ %]

T -\ Define the design type for your Factorial Design.

Step 2

—Factorial Design

A7 [" 2 Level Full Factorial Design
r;{'f Choose this if the experiment. includes all combinations of the Factors, 7]

[” 2 Level Fractional Factorial Design

Choose this if the experiment. includes only part of all combinations of the Factors, 71

ol " Plackett-Burman Design

b o Choose this to study the main effect of multiple Factors, Each Factor has only bwo levels, (7]
r—vﬁ] ¥ General Full Factorial Design
Choose this if the experiment. includes all combinations of the Factor levels, Each factor can (7]
have any number of levels,
« [” Taguchi DA Factorial Design
;ﬁ Choose this to use Taguchi's Orthogonal Array, Each Factor can have multiple levels, 71

DOE++

Eimish

Help | Cancel < Back
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4 Step-by-Step Examples

o In the third step of the Design Wizard, select 3 from the Factors drop-down and leave all other fields at
their default settings, as shown next.

[IjDesign Wizard [ %]

"""": Define the design profile for your factorial desiagn.

Step 3

r—izeneral Full Factorial Design

Factors |3 - l Factor Properties |

Replicates |1 vl ™| Block On Replicates ---|
Responses |1 VI Response Properties |

Repeated Measurements |MNone * | {Available with one response only)

Wiew Available Desions

Help | Cancel | < Back |

DOE++

Ensh |

e Click the Factor Properties button. In the Factor Properties window that appears, enter the names and
units for the factors then specify the number of levels for each factor and enter the level values, as shown
next.

[IjFactor Properties !E[ E
-

Mumber
of Levalg | Levell | Level2 | level3 | level4 [

MName Units Type

Region Qualitative 3 A B C

&
| B [Engine Type Qualitative 4 Gasoline Diesel Hyhrid Ethanol
C | Supplier Qualitative 2 S1 S2

t Quantitative: The results can be generalized to other values,
{['] Qualitative: The results can only be applied to the levels you define.
o]
[=]

OF | Cancel | Help |

e Click OK to close the Factor Properties window and return to the Design Wizard.
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4.4 Example 4: General Full Factorial Design

e C(Click the Response Properties button. In the Response Properties window that appears, define the
response name, as shown next.

[IjResponse Properties !E[ E
Name Units =
Relishility at Warranty |

DOE++

OF | Cancel | Help |

e Click OK to close the Response Properties window and return to the Design Wizard.
e Click Next to proceed to the next step.

e The fourth step of the Design Wizard provides a review of the settings you have chosen for the design.

[IjDesign Wizard [ %]

™ Review the settings you have chosen for your design,

Step 4
View in & separate window. ..

—Design Review

General Full Factorial Design o
_
Factors: 3
Replicates: 1
Block On Replicates: N
Observations: 24
Responses: 1

Factor Properties

Factor Name Units Type Level Levell Level2 Leve
A Region Qualitative 3 A B C
B Engine Type Qualitative 4 Gasoline  Diesel Hyhir
[ Supplier Qualitative 2 S1 S2

-
4 | LlJ
Help | Canicel | < Back | fext = |

DOE++

If any of the settings are not as intended, you can click the Back button to return to the appropriate step
and make any necessary changes.

e C(Click Finish to create the new project with the Standard Folio containing the general full factorial
design.

e Save the project as “GeneralFullFactorial.rso7.”
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4 Step-by-Step Examples

e Sclect Standard Order in the Sort By area in the Control Panel to sort the Data Sheet by the Standard
Order column, then enter the response data in the order given in this example on page 48. The Folio will
look like the one shown next.

[IjFoIio: Foliol {Design} M= E3
Gz4  |D932 wain | options | other |
Stg:;!;rd Or\;gzr Block | A:Region | B:Engine Type |C:Supplier | Relisbility at Warran - -~ Cod:j:z:cmrs

1 1 17 1 A Gasoline 51 0.973 & i il

2 2 13 1 & Gasoline sz 0.991 Sort By

3 3 16 1 A Diesel 51 0.971 " Run Order

4 4 5 1 A Diesel 52 0.971 & Standard Order

5 5 19 1 A Hybrid 51 0.973

5] 5] 14 1 A Hybrid 52 0.956 Diesign Summary:

7 7 11 1 A Ethanol S1 0.988 T

=] g ] 1 A Ethanol 52 0.973

9 ] 24 1 B Gasoline 51 0.933

10 10 23 1 B Gasoline 52 0.973

11 11 20 1 B Diesel 51 0.992

12 12 12 1 B Diesel 52 0.976

13 13 21 1 B Hybrid 51 0.999

14 14 22 1 B Hybrid 52 0.977

15 15 7 1 B Ethanol 51 0.995

16 16 1 1 B Ethanol 52 0.975

17 17 4 1 © Gasoline 51 0.977

18 18 15 1 © Gasoline 52 0.93

19 19 2 1 © Diesel 51 0.971

20 20 18 1 © Diesel 52 0.923

21 21 g 1 © Hybrid 51 0.96

22 22 5] 1 © Hybrid 52 0.896

23 23 10 1 © Ethanol 51 | 0.916

24 24 3 1 © Ethanal 52 0.932 hd
Design |

e On the Options page of the Control Panel, specify a Risk Level (Alpha) value of 0.1 for the Reliability
at Warranty response and select to use Individual Terms.

e Return to the Main page of the Control Panel and select Select Effects from the Data menu or click the
Select Effects icon in the Control Panel.

e In the Effects window, select 2-Way Interaction from the Limit by Order drop-down, as shown next.

[IjElTects [ %]

Response: IReIiabiIity ak Warranty j O I
Lirnit by Order: |2-Way Inkeraction j Cancel |

Select Significant Effects | Help |

I Effect Mame _

eqgion Reset Defaults |
B:Engine Type
C:Supplier

A

aC

BC

Ozec

™| Triclude Elacks i Made!
| Triclude: Curvature in Mads]
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4.4 Example 4: General Full Factorial Design

e C(Click OK to accept your selections and close the window then click Calculate. The Analysis tab is
shown next.

A30
A ‘ B ‘ © ‘ [u] ‘ E ‘ F ‘ G H H
1 ANOYA Table
Source of | Degrees of Sum of Mean .
2 variation Freedom Squal_'es Squal_'es F Ratio P Value
[Partial] [Partial]
3 |Model 17 0.0151 0.0009 3.5478 0.0623
4 A Region 2 0.0096 0.0048 19,1362 | 0.0025
5 B:Engine Type 3 0.0005 0.0002 0.6341 0.6197
5] C:Supplier 1 0.002 0.002 8.0541 0.0296
7 AR 5] 0.0013 0.0002 0.8425 0.5798
=] AC 2 0.001 0.0005 1.9297 0.2254
9 BC 3 0.0008 0.0003 1.0366 0.4341
10 |Residual 5] 0.0015 0.0003
11 Lack of Fit 5] 0.0015 0.0003
12 |Total 23 0.0166
13
14 S = 0.0158
15 R-sq =90.95%
16 R-sqfad{) = 65.32%
17
18 Regression Information
19 Term Coefficient Stg:i?rd Low CI HighCI T Value P Yalue
20 Intercept 0.9665 0.0032 0.9602 09728 | 209.2264 | 9.40E-14
21 A[1] 0.0092 0.0046 0.0004 0.0181 2.023 0.0293
22 2] 0.0185 0.0046 0.0096 0.0274 4.05 0.0067
23 B[1] 0.0063 0.0056 -0.0045 0.0172 1.1321 0.3008
24 B[2] 0.0017 0.0056 -0.0092 0.0125 0.2979 0.7738
25 B[3] -0.0055 0.0056 -0.0164 0.0034 | -0.9831 0.3635
26 C:Supplier 0.0092 0.0032 0.0029 0.0154 2.838 0.0296
27 A[11B[1] -8.23E-05 0.0079 -0.0155 0.0152 | -0.0105 0.9919
28 Al1B[2] -0.0064 0.0079 -0.0218 0.009 -0.811 0.4483
29 A[1B[3] -0.0032 0.0079 -0.0186 0.0121 | -0.4108 0.6935
30 Al2B[1] -0.0083 0.0079 -0.0237 0.007 -1.0533 0.3328
31 AlzB[2] -0.0027 0.0079 -0.018 0.0127 -0.237 0.7476
32 AlZB[3] 0.0085 0.0079 -0.0069 0.0239 1.0743 0.324
2B AL]C -0.0074 0.0046 -0.0163 0.0015 | -1.6236 0.1556
34 Alz]C -0.0007 0.0046 -0.0095 0.0082 | -0.1459 0.8887
25 B[1]C -0.0027 0.0056 -0.0135 0.0082 | -0.4767 0.6305
36 B[2]C 0.0007 0.0056 -0.0102 0.0115 0.1192 0.209
37 B[3]C 0.0038 0.0056 -0.002 0.0197 1.5789 0.1654
1

s

IMain | Optionsl Other I

EFolio: Foliol {Analysis) M= E3

Response

9

||Re|iability ak Warranty

=

Transfarmation
¥ =Y

Risk Level (alpha)
0.1

Analysis Settings

Partial 55

| Individual

Calculated

Observations = 24

Analysis Summary
Fii}=...

Design  Analysis |

From the ANOVA table, the region and the supplier are identified as significant factors at the 10%
significance level (indicated by red text in the Source of Variation and P Value columns). The engine type is
not found to affect the reliability of the units.

o Click the Plot icon to add the Plot tab to the Folio.
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4 Step-by-Step Examples

e Sclect Main Effects from the Plot Type menu in the Control Panel. The Main Effects plot is shown next.
Note that the circle around one point in this plot is an annotation created in ReliaSoft Draw to emphasize

the relevant point.
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This plot shows the individual factors versus reliability at warranty. The critical population is the one with
the lowest reliability. You can see that the population deployed in region C had the lowest reliability. To
refine this conclusion, you can view the Interaction Matrix plot.
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4.5 Example 5: Taguchi Orthogonal Array Design

e Sclect Interaction Matrix from the Plot Type menu in the Control Panel. The Interaction Matrix plot is
shown next. Note that the circles around points in this plot are annotations created in ReliaSoft Draw to
emphasize the relevant points.
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The plot at the upper right shows the effect of the interaction between region and supplier on reliability. To
determine what population is represented by each point, hover the cursor over the point. You can see that the
circled point represents the population deployed in the third region (region C) using parts from the second
supplier (supplier S2). This population had particularly low reliability. By examining the plot at the middle
left, you can see that the population deployed in region C with hybrid and ethanol engines also had very low
reliability.

e Save and close the project then proceed to the next example.

4.5 Example 5: Taguchi Orthogonal Array Design

In plastic processing, an engineer would like to find the effect of different factors on the impact strength of
the material. Four process variables are to be studied: the holding pressure, the injection speed, the barrel
temperature and the mold temperature. The engineer would like to explore three settings for each factor, so a

general full factorial design would require 3% =381 runs to perform. Given time and resource constraints, it is
decided to carry out a Taguchi L9 design instead, where higher interaction terms will be assumed to be
negligible.
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4 Step-by-Step Examples

The following parameter settings are used:®

Parameter Units Level 1 Level 2 Level 3
Hold pressure bar 250 300 350
Injection speed mm/s 75 100 125
Barrel temperature °C 200 230 160
Mold temperature °C 30 40 50
The following impact strength data are collected:
Hold Injection Barrel Mold Impact
Pressure Speed Temperature | Temperature Strength
(bar) (mm/x) 0 (§(®) (kJ/m?)
250 75 200 30 87.48
250 100 230 40 86.54
250 125 160 50 85.72
300 75 230 50 87.93
300 100 160 30 86.48
300 125 200 40 85.31
350 75 160 40 87.89
350 100 200 50 86.11
350 125 230 30 85.75
Do the following:

o Identify the significant factors.

o Identify the factor settings that will maximize the impact strength.

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\DOFE\Training Guide) and is named “TaguchiOA.rdoe. The data set for this

example is available in the Spreadsheet in the “TaguchiOA-Data.rso7” file located in the “Raw Data

folder within the “Training Guide” folder.”

6. http://www.tekes.fi/julkaisut/propros/raportti57.pdf

2
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4.5 Example 5: Taguchi Orthogonal Array Design

Solution

e Create a new project. On the first page of the Design Wizard, select to create a Factorial Design and
click Next to proceed to the next step.

[IjDesign Wizard [ %]

DOE++

Specify the type of Design of Experiments.

Step 1

—Create a new project using. ..

[” One Factor Design

de9 Choose this to compare mean values at each level of a single Factor, 7]
’TE ¥ Factorial Design
r;‘f'r Choose this to simultaneously study the effects of several Factors {e.g. Fractional Factorial, 7]
General Factorial, Plackett-Burman ...},
|® [” Response Surface Method Design
Choose this ko establish a relationship between factors and responses (e.g. Central Composite, (el
Box-Behnken Design ...
.| [T Taguchi Robust Design
v Choose this to use Taguchi's methods {e.q. Robust Parameter Design ...}, 7]
" Reliability DDE
Choose this For life test designs, especially when you expect interval data or suspensions from 71
the experiments,
Help Load Last Design. .. Cancel | = Back | Eimish |

e In the second step of the Design Wizard, select Taguchi OA Factorial Design and click Next to proceed

to the next step.

[IjDesign Wizard [ %]

DOE++

Define the design type for your Factorial Design.

Step 2

—Factorial Design

i [" 2 Level Full Factorial Design

r;{'f Choose this if the experiment. includes all combinations of the Factors, 7]
[” 2 Level Fractional Factorial Design
Choose this if the experiment. includes only part of all combinations of the Factors, 71
ol " Plackett-Burman Design
b o Choose this to study the main effect of multiple Factors, Each Factor has only bwo levels, (7]
Vﬁ] [” General Full Factorial Design
Choose this if the experiment. includes all combinations of the Factor levels, Each factor can (7]
have any number of levels,
|7 Taguchi DA Factorial Design
Choose this to use Taguchi's Orthogonal Array, Each Factor can have multiple levels, 71
Help | Cancel < Back Eimish
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4 Step-by-Step Examples

e In the third step of the Design Wizard, select to create a Single Level Factor Design. Select 3 Level
Design and then select L9(34) from the drop-down and leave all other fields at their default settings, as

shown next.
"""": Define the design profie for your Taguchi O& factorial design.
Step .3

r—Taguchi ©& Factorial Design
{+ Single Level Factor Design

{~ Mixed Level Factor Design

(" 2 Level Design (2 to 31 Fackaors) |L4 (23} 'l
{* 3 Level Design (2 to 22 Fackaors) |L9 (374} 'l
{~ 4 Level Design (2 to 5 Factars) |L16 (45} 'l
{~ 5 Level Design (2 to & Factars) |L25 (576) 'l

Factors |4 'l Factor Properties |

Replicates Il vl ™| Block On Replicates ---|
Responses lﬁ Response Properties |

Repeated Measurements |MNone * | {Available with one response only)
Wiew Available Desions

Help | Cancel | < Back |

DOE++

Ensh |

e Click the Factor Properties button. In the Factor Properties window that appears, enter the names and
units for the factors then specify the number of levels for each factor and enter the level values, as shown

next.
[IjFactor Properties !E[ E
) Murnber | Columin =
MNarme Units Type of Levels | Inde Level 1 | Level 2 | Level 3 Il

A Hold Pressure bar | Qualitative 3 1 250 200 3250
| B | Injection Speed mmys | Qualitative 3 2 75 100 125
|C Parrel Temperature. C Qualitative 3 3 200 230 160
D | Mold Termperature C Qualitative 3 4 20 40 S0

t Quantitative: The results can be generalized to other values,

{['] Qualitative: The results can only be applied to the levels you define.

o]

=] oK | Cancel | Help |

e Click OK to close the Factor Properties window and return to the Design Wizard.
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4.5 Example 5: Taguchi Orthogonal Array Design

e C(Click the Response Properties button. In the Response Properties window that appears, define the

response name, as shown next.

[IjResponse Properties _|Of =

MName

Units

r

Irnpact Strength

klfm~2

DOE++

Cancel | Help

Click OK to close the Response Properties window and return to the Design Wizard.

L]
e Click Next to proceed to the next step.
e The fourth step of the Design Wizard provides a review of the settings you have chosen for the design.
"""": Review the settings you have chosen for your design.
Step 4
View in & separate window. ..
—Design Review
Taguchi DA Factorial Design o
_
Design Matrix: L9 (374)
Factors: 4
Replicates: 1
Block On Replicates: N
Observations: 9
Responses: 1
Factor Properties
Factor Name Units Type Level ColumnIndex Lewvell |
A Hold Pressure bar Qualitative 3 1 250
B Injection Speed mmfs  Qualitative 3 2 75
C Barrel Temperature C Qualitative 3 3 200
+ n] Mald Termperature C Qualitative 3 4 30 -
+ MY LlJ
g
o Help | Cancel | < Back | [ext =
If any of the settings are not as intended, you can click the Back button to return to the appropriate step
and make any necessary changes.
e Click Finish to create the new project with the Standard Folio containing the Taguchi OA design.
e Save the project as “TaguchiOA.rso7.”
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4 Step-by-Step Examples

e Sclect Standard Order in the Sort By area in the Control Panel to sort the Data Sheet by the Standard
Order column, then enter the response data in the order given in this example on page 56. The Folio will
look like the one shown next.

[IjFoIio: Foliol {Design} M= E3
Al 1 Main | Optionsl Other |
A:Hold |B:lnjection | C:Barrel C:Mold o Display Factors
Stgr;gj:rrd Or\;gzr Black |Pressure | Speed | Temperature Temperature Imp(icjt{rsnt/r;r;gﬂﬂ  Coded val
thary | (mrm/s) () () 4 B §°t i \‘:C"l“es
1 1 7 1 250 75 200 a0 57.48 ctual values
2 2 9 1 250 100 230 40 B6.54 Sort By
3 3 8 1 250 125 160 =0 B5.72 P
4 4 2 1 300 75 230 =0 57.93 5 St”a”n d;r;;r o
5 5 4 1 300 100 160 a0 B6.48
f & 3 1 300 125 200 40 B5.31 T ENTeT
7 7 5 1 350 75 160 40 57.89 .
] 8 & 1 350 100 200 =0 B6.11
] g 1 1 350 125 230 a0 B5.75
Design |

e On the Options page of the Control Panel, specify a Risk Level (Alpha) value of 0.1 for the Impact
Strength response and select to use Individual Terms.

e Return to the Main page of the Control Panel and select Select Effects from the Data menu or click the
Select Effects icon in the Control Panel.

e In the Effects window, select Main Effects from the Limit by Order drop-down, as shown next.

Response: IImpact Strength j oK I
Lirit by Order: IMain Effects j Cancel |
Select Significant Effects | Help |
I Effect Marne: I
:Hold Pressure Reset Defaults
B:Injection Speed
C:Barrel Temperature
[:Mold Temperature
O:ze
Oac
Oac
Oec
Oeo
Oco
+
+
1]
(o] ™| Include Blocks in Made]
o ™| Include Curyature in Made]
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4.5 Example 5: Taguchi Orthogonal Array Design

e Click OK to accept your selections and close the window then click Plot. The Effect Probability plot is
shown next.

ReliaSoft DOE++ - www.ReliaSoft.com
Normal Probability Plot of Effect
99.000 Effect Probability
Impact Strength
Y=Y
® Non-Significant Effects
B Significant Effects
— Distribution Line
m B1]
m C12]
z
] 50000
o
<}
a
m B[2]
10.000
m Cl]
5.000
User Name
Company
2/25/2008
1.000 5:28:12 PM
-6.000 -3.600 -1.200 1.200 3.600 6.000
Effect
Alpha = 0.1: Lenth's PSE = 0.0267

Factors B and C are found to affect the response at a significance level of 0.1. Note that no replicates exist,
so these factors are identified using Lenth's PSE of 0.0267.

e Sclect Main Effects from the Plot Type menu in the Control Panel. The Main Effects plot is shown next.

ReliaSoft DOE++ - www.ReliaSoft.com
Main Effect Plot
88.000 Main Effect
Bl Impact Strength
Y=Y
-®- A:Hold Pressure Mean Line
@- B:Injection Speed Mean Line
-@- C:Barrel Temperature Mean Line
@ D:Mold Temperature Mean Line
87.200
s e
o N o—— —o
86.400 —— ®
e
I3
i=4
©
o
=
B
£
ic
85.600 @
84.800
User Name
Company
2/21/2008
84.000 4:12:55 PM
0.000 0.800 1.600 2.400 3.200 4.000
Factor
Least Squares Means
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4 Step-by-Step Examples

From this plot, you can see that factor B should be set at level 1 (injection speed = 75 mm/s) and factor C
should be set at level 2 (barrel temperature = 230°C). Factors A and D, the hold pressure and the mold
temperature, should be set at the most economical/feasible conditions, as they do not affect the process.

e Save and close the project then proceed to the next example.

4.6 Example 6: Response Surface Methodology: Box-Behnken Design

In order to measure the amount of a contaminant in certain foods, a standard monitoring system exists. A
chemist would like to propose an alternate method of quality control in which the contaminant reacts with
reactants A and B in the presence of catalyst C. The product of this reaction gives a simpler, cheaper method
to quantify the presence of the contaminant. The experimenter would like to find the optimum amount of
reactants A and B and the catalyst, such that the detection error is minimized. The detection error is
measured in terms of percent deviation from the results obtained from the currently used procedure. In this
experiment, the experimental solution containing the contaminant will be kept at the maximum adequate
dose. The levels of the reactants and catalyst are shown next.

Factor Low Level High Level
Reactant A (M) 1.00E-05 1.00E-04
Reactant B (M) 1.00E-06 1.00E-05

Catalyst (M) 1.00E-03 5.00E-03

The experimenter chooses to run a Box-Behnken design after having determined during prior investigation
that there is a quadratic relation between the different factors and the response.

The data set is shown next.

Reactant A | Reactant B Catalyst P]gf-(e,l;t
™) (M) M) 0
1 -1 0 1596
! -1 0 1.36
1 1 0 1.702
! 1 0 1.066
1 0 -1 1.904
! 0 -1 1.526
-1 0 1 1498
! 0 1 0.102
0 -1 -1 1.25
0 1 -1 1516
0 -1 1 1278
0 1 1 0.886
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4.6 Example 6: Response Surface Methodology

: Box-Behnken Design

Reactant A | Reactant B Catalyst P]g;:f,:t
™M) M) (M) o
0 0 0 0.728
0 0 0 0.538
0 0 0 1.038

Note that for ease of viewing the factor values in this data set are expressed as coded values, where -1
represents the factor’s low value and 1 represents the factor’s high value.

Do the following:

e Find an appropriate model for the response.

e Find settings for the factors such that the percent error is minimized (0.3% is desired but up to 0.5% is
acceptable).

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ DOE\Training Guide) and is named “BoxBehnken.rdoe.” The data set for this
example is available in the Spreadsheet in the “BoxBehnken-Data.rso7” file located in the “Raw Data”
folder within the “Training Guide” folder.

Solution

e C(Create a new project. On the first page of the Design Wizard, select to create a Response Surface
Method Design and click Next to proceed to the next step.

EDesign Wizard [ %]
""’"': Specify the type of Design of Experiments.
Step 1

—Create a new project using. ..

+ | I one Factor Design
|- 29 Choose this ko compare mean values at each level of a single Factor, 7]

?"'_’TE [ Factorial Design

r;f"f'f_,_ Choose this ko simulkaneously study the effects of several Factors (e.q. Fractional Factorial, 71
General Factorial, Plackett-Burman ...},

|® ¥ Response Surface Method Design
Choose this ko establish a relationship between factors and responses (e.g. Central Composite, (el

Box-Behnken Design ...

o l/| " Taguchi Robust Design
v Choose this ko use Taguchi's methods {e.g. Robust Parameter Design ... ). 7]

[~ Reliability DOE
Choose this For life test designs, especially when you expect interval data or suspensions from 71
the experiments,

DOE++

Help Load Last Design. .. Cancel = Back Eimish
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4 Step-by-Step Examples

In the second step of the Design Wizard, select Box-Behnken Design and click Next to proceed to the
next step.

EDesign Wizard [ %]

"':"': Define the type of Response Surface Method Design.

Step 2

—R5M Design
% " central Composite Design
i Choose this to create a Central Composite Design, [

& ¥ Box-Behnken Design
rzﬂdf Choose this to create a Box-Behnken Design, I

|'\§..

|'\§..

DOE++

Eiish |

Help | Cancel | < Back

In the third step of the Design Wizard, select 3 from the Factors drop-down and leave all other fields at
their default settings, as shown next.

EDesign Wizard [ %]

"':"': Define the design profile for the Box-Behnken Design,

Step 3

—Box-Behnken Design

Factors |3 VI Factor Properties |
Blocks |1 'l Elock Properties |

Center Points Per Block |3 'l [~ Custom
Replicates |1 vl ™| Block On Replicates :I
Responses |1 VI Response Properties |

Repeated Measurements |MNone * | (Available with one response only)

Wiew Available Desions

Help | Cancel < Back

Einish

DOE++
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4.6 Example 6: Response Surface Methodology: Box-Behnken Design

e C(Click the Factor Properties button. In the Factor Properties window that appears, enter the names, units
and high and low level values for the factors, as shown next.

[IjFactor Properties _|Of =

DOE++

MNarme Units Type Low Level | High Lewvel =
A Reactant & I Quantitative 1.00E-05 0.0001
|B | ReactantB I Quantitative 1.00E-06 1.00E-05
C Catalyst I+ Quantitative 0.001 0.005
Quantitative: The results can be generalized to other values,
OF | Cancel Help

Note that all factors in Box-Behnken designs are quantitative.

e Click OK to close the Factor Properties window and return to the Design Wizard.

e C(Click the Response Properties button. In the Response Properties window that appears, define the
response name, as shown next.

e Click OK to close the Response Properties window and return to the Design Wizard.

[IjResponse Properties _|Of =
Name Units =
Percent Error % |
+
+
[[]
. -
[-] OF | Cancel | Help

e Click Next to proceed to the next step.
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4 Step-by-Step Examples

e The fourth step of the Design Wizard provides a review of the settings you have chosen for the design.

"""": Review the settings you have chosen for your design.
Step 4
Wiew in & separate window. ..
—Design Review
Box-Behnken Design o
_
Factors: 3
Blocks: 1
Center Points Per Block: 3
Replicates: 1
Block On Replicates: N
Cbservations: 15
Responses: 1
Factor Properties
Factor Name Units Type  Low Level High Level
A Reactant & I Quantitative  1.00E-03 0.0001
B Reactant B I Quantitative 1.00E-06  1.00E-03
+ C Catalyst I+ Quantitative 0.001 0.005 -
Y | | o
[[]
o]
o Help | Cancel | < Back | [ext = |

If any of the settings are not as intended, you can click the Back button to return to the appropriate step
and make any necessary changes.

e Click Finish to create the new project with the Standard Folio containing the Box-Behnken design.

e Save the project as “BoxBehnken.rso7.”

e Sclect Coded Values in the Display Factors area in the Control Panel to view the factor values in their

coded form.

e Sclect Standard Order in the Sort By area in the Control Panel to sort the Data Sheet by the Standard
Order column, then enter the response data in the order given in this example on page 62. The Folio will
look like the one shown next.

[IjFoIio: Foliol {Design}

IS[=] E3

H15 1.038 Main | Optionsl Other I
Standard| Run | Point Block &:Reactant 4 |B:Reactant B |C:Catalyst PE:E:t Display Factars
Order | Crder | Type 1) 1) 1) (9 7] & Coded Valuss
1 1 10 1 1 1 1 0 1,506  Actual Values
2 2 15 1 1 1 =il u] 1.36 Sort By
3 3 g 1 1 =il 1 u] 1.702
4 4 7 1 1 1 1 0 LO66 € Run Order
5 5 g 1 1 ») o 1 1004 % standard Order
6 & 3 1 1 1 ] =i 1.526 Desion Summary
7 7 13 1 1 =il u] 1 1.498 ——
8 8 4 1 1 1 0 1 0.102 Pl=...
9 9 4] 1 1 u] =il =il 1.25
10 10 1 1 1 u] 1 =il 1.516
11 11 2 1 1 u] =il 1 1.278
12 12 5 1 1 u] 1 1 0.886
13 13 12 u] 1 u] u] u] 0.728
14 14 11 u] 1 u] u] u] 0.538
15 15 14 u] 1 u] u] o] 1.038 -
Design |

e On the Options page of the Control Panel, specify a Risk Level (Alpha) value of 0.1 for the Percent
Error response and select to use Individual Terms.
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4.6 Example 6: Response Surface Methodology: Box-Behnken Design

is shown next.

e Return to the Main page of the Control Panel and click Calculate. The ANOVA table on the Analysis tab

[IjFoIio: Foliol {Analysis) M= E3
A1 [Main | Optionsl Other I
A B ‘ C ‘ (0] ‘ E ‘ F ‘ G ;I Response 0|
1 ANDVA Table ||Percent Error j|
Source of | Degrees of Sum of Mean . Transformation
2 variation Freedom Squal_'es Squal_'es F Ratio P Value T
[Partial] [Partial] =
3 |model g 28243 | 03139 | 37538 | 0.079% Risk Level (Alpha)
4 A Reactant & 1 0.8752 0.8752 10,4665 0.0231 01
5 B:Reactant B 1 0.0123 0.0123 0.1474 0.7168
4] C:Catalyst 1 0.7393 0.7393 58.842 0.031 Analysis Settings
7 AR 1 0.04 0.04 0.4734 0.52 Partial 55 | Individual
g | ac 1 0.2501 02591 | 3.0085 | 01357 Calculated
2 |ec 1 0.1022 | 01082 | 1.2045 | 03068 byl = 15
10 | as 1 04369 | 0.4360 | 5.2255 | 0.071 FrEleD Sty
11 BB 1 0.3757 0.3757 4.4936 0.0875 E=
12 CC 1 0.0782 0.0782 0.9345 0.378
13 |Residual 5 0.4181 0.0836
14 Lack of Fit 3 0.2907 0.0969 15211 0.4203
15 Fure Error 2 0.1274 0.0637
16 |[Total 14 3.243 -
4 | »

Design  Analysis |

From the ANOVA table, the significant effects are A, C, AA and BB.

o Select Select Effects from the Data menu or click the Select Effects icon in the Control Panel.

e In the Effects window, click the Select Significant Effects button to select only the effects shown to be
significant. Note that in order for BB to be selected, B must also be selected so that model is hierarchical,

as shown next.

[IjElTects [ %]

[ o |
j Cancel |
Select Significant Effects | Help |

I Effect Marne: I
Reset Defaulks |

eactant A
B:Reactant B
CiCatalyst
O:ze

Oac

Oec

A

EE

Occ

Response: IPercent Error

Limit by Order: ILinear + Quadratics

™| Triclude Elacks i Made!

DOE++
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4 Step-by-Step Examples

e Click OK to accept your selections and close the window then click the Calculate icon to re-analyze the
data set using the selections you have just made. The changed Analysis tab is shown next.

[IjFolio: Foliol {Analysis)

A35
A B ‘ © ‘ [u] ‘ E ‘ F ‘ G

1 ANOYA Table

Source of | Degrees of Sum of Mean .
2 variation Freedom Squal_'es Squal_'es F Ratio P Value

[Partial] [Partial]
3 |Model 5 2.3394 0.4679 4.6603 0.0224
4 A Reactant & 1 0.8752 0.8752 87171 0.0162
5 B:Reactant B 1 0.0123 0.0123 0.1228 0.7341
5] C:Catalyst 1 0.7393 0.7393 7.3641 0.0239
7 A8 1 0.4114 0.4114 4,0977 0.0736
=] BB 1 0.3519 0.3519 3.5052 0.094
9 |Residual ] 0.9036 0.1004
10 Lack of Fit 7 0.7762 0.1109 1.7407 0.4125
11 Fure Error 2 0.1274 0.0637
12 |Total 14 3.243
13
14 S =0.3169 FRESS = 2.6742
15 R-sg = 72.14% R-sgipred) = 17.54%
16 R-sqfad{) = 56.66%
17
18 Regression Information
19 Term Coefficient Stg:i?rd Low CI HighCI T Value P Yalue
20 Intercept 0.8575 0.1522 0.5785 1.1366 5.6339 0.0003
21 A Reactant & -0.2308 0.112 -0.5361 | -0.1254 | -2.9523 0.0162
22 B:Reactant B -0.0393 0.112 -0.2446 0.1661 | -0.3504 0.7341
23 C:Catalyst -0.204 0.112 -0.5094 | -0.0985 | -2.7137 0.0239
24 A8 0.3328 0.1644 0.0314 0.6342 2.0243 0.0736
25 [=I5) 00,3078 0.1644 0.0064 0.6092 1.8722 0,094
1

IS[=] E3
wain | options | other |
Response 0
||Percent Errar j

Transfarmation
¥ =Y

Risk Level (alpha)
0.1

Analysis Settings
Partial 55 [ Individual
Calculated
Observations = 15

Analysis Summary
Fii}=... .

Design  Analysis |

Select Optimization from the Data menu or click the Optimization icon in the Control Panel.

=l
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4.6 Example 6: Response Surface Methodology: Box-Behnken Design

e In the Optimization Settings window that appears, select Minimize from the drop-down in the Goal
column and enter 0.3 for the Target value and 0.5 for the Upper Limit value. The Optimization Settings
window will look like the one shown next.

[Ijl:lptimization Settings !E[ E
Response Settings | Factor Settings (Coded) | Algorithm Settings |
Lower LUpper ) =
Selected MNarme Goal Limit Target Lirmit Weight Importance ||
v Percent Error Minimize 0.3 0.5

DOE++

Reset | OF | Cancel | Help

e Click OK to accept your settings and create the Optimal Solution plot, as shown next.

[ B3

[IjFoliu: Foliol {Optimization)
ReliaSoft DOE++ - wana |

Optirnal Salution 1 Display Factors [*)

= Coded values
= Actual Values

Falial

Factor ws Response
" Continuaus Functio

1216

--- Factar Yalue

— Respanse Value -] |7 Keep Aspect Ratio

Solutions

1.067
Optimal Solution 1

0,918

Percent Error
(Minimize)
=04701

A

076

0613

0,470

: : : User Mame
H H Company
' ' ' arifenng
! ! ! HEEE AN
= = = = = = Z = = = = = =z = = = = =
g 8 8§ 8 8 & 2 8 8§ § 3 E 2 8§ 8 § 2 8
- 2 = 2 £ 5 4 2 2 = = 4 4 0= = = = =
AaReactant & E:Reactart B 1 Catahyst |E| ‘[ll gl &ll@
*=0.4969 *=0.0638 ¥ = 10000 |

Designl Analysis  Optimization
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4 Step-by-Step Examples

Note that the factor settings shown are coded values. To view the actual factor values, select Actual Values
in the Display Factors area in the Control Panel. The solution will be replotted, as shown next.

[ﬁFnlin: Foliol {Optimization)
ReliaSoft DOE++ - wvew ReliaSoRt .com
Optirnal Solution 1

Display Factars 0

" Coded values
' actual Values

Falial

Factor vs Responge
" Continuaus Functi

1216

--- Factor Yalue

— Response Value o-| |7 Keep Aspect Ratio

Solutions

L.0e7
Optimal Solution 1

0918

Percent Error
(Mimirniz &)
¥ =04701

0.768

0613

0.470
User Marme

10:01:07 AR

ctant B CiCabahyst l@ Iﬂll Ig—“ @l l@

JE6IE-E ¥ = 0,000

2.200E6
1000ES
0.001
0,002
0,003
0,002
0,004
0.005

-
u
=
3
"

1.000ES
2.800E:5
4E00ES
6. 400ES
S.200ES
L000E-4
LO00EE
2.800EE
4E00EE

AiReactant 5
¥ =7.73kIE-S

Design I Analysis  Optimization I

The optimum settings are found to be reactant A =7.7361E-5, reactant B =5.7869E-6 and catalyst
C =0.0050.

@
[

b
b

e Save and close the project then proceed to the next example.

4.7 Example 7: Sequential Optimization

This multi-part example guides you through the process of moving from the present operating conditions to
the vicinity of the operating conditions where the response is optimum, then analyzing these ranges using
response surface methodology and optimizing the factor settings for the desired response.

The yield from a chemical process is found to be affected by two factors: reaction temperature and reaction

time. The current reaction temperature is 230°F and the reaction time is 65 minutes. The experimenter wants
to determine the settings of the two factors such that maximum yield can be obtained from the process.

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\DOFE\Training Guide) and is named “SequentialOptimization.rdoe.” The data
sets for this example are available on separate sheets in the Spreadsheet in the “SequentialOptimization-
Data.rso7” file located in the “Raw Data” folder within the “Training Guide” folder.

4.7.1 Part 1: Current Operating Conditions

To explore the region around the current operating conditions, the experimenter decides to use a single

replicate of the 22 design. Ranges for the factors for this design are chosen to be (225, 235)°F for the
reaction temperature and (55, 75) minutes for the reaction time. Five replicates at the center point are also
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4.7 Example 7: Sequential Optimization

added to the design to estimate error sum of squares and check for model adequacy. The response values
obtained for this design are shown below:

Center Point Tem;;;r;ature ReTaif‘rtll(:m ‘({‘l;()l)d
(min)

No 225 55 33.95
No 235 55 36.35
No 225 75 35
No 235 75 37.25
Yes 230 65 35.45
Yes 230 65 35.75
Yes 230 65 36.05
Yes 230 65 35.3
Yes 230 65 35.9

Do the following:

e Find an appropriate model for this response.

In the “Sequential Optimization.rdoe” sample file, the Folio for this part of the example is named “Foliol.”
Solution

e C(Create a new project. On the first page of the Design Wizard, select to create a Factorial Design and
click Next to proceed to the next step.

[IjDesign Wizard [ %]

S Specfy the type of Design of Experiments.

Step 1

—Create a new project using. ..

+ | I one Factor Design
|- 29 Choose this ko compare mean values at each level of a single Factor, 7]

?"'_’TE [V Factorial Design
r;f"f'f_,,_ Choose this ko simulkaneously study the effects of several Factors (e.q. Fractional Factorial, 71
General Factorial, Plackett-Burman ...},

|® [” Response Surface Method Design
Choose this ko establish a relationship between factors and responses (e.g. Central Composite, (el

Box-Behnken Design ...

o l/| " Taguchi Robust Design
v Choose this ko use Taguchi's methods {e.g. Robust Parameter Design ... ). 7]

[~ Reliability DOE
Choose this For life test designs, especially when you expect interval data or suspensions from 71
the experiments,

DOE++

Eimish

Help Load Last Design. .. Cancel = Back
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4 Step-by-Step Examples

e In the second step of the Design Wizard, select 2 Level Full Factorial Design and click Next to proceed

to the next step.

[IjDesign Wizard [ %]

DOE++

-\ Define the design type for your Factorial Design.

Step 2

—Factorial Design
i V¥ 2 Level Full Factorial Design
&7

Choose this if the experiment. includes all combinations of the Factors,

[” 2 Level Fractional Factorial Design

Choose this if the experiment. includes only part of all combinations of the Factors,

SRR " Plackett-Burman Design

e Choose this to study the main effect of multiple Factors, Each Factor has only bwo levels,

Vﬁ]l [” General Full Factorial Design

have any number of levels,

« [” Taguchi DA Factorial Design
}g& Choose this to use Taguchi's Orthogonal Array, Each Factor can have multiple levels,

Choose this if the experiment. includes all combinations of the Factor levels, Each factor can

Help | Cancel | < Back

Eiish |

e In the third step of the Design Wizard, select 2 from the Factors drop-down and 5 from the Center
Points Per Block drop-down and leave all other fields at their default settings, as shown next.

[IjDesign Wizard [ %]

DOE++

-\ Define the design profile for your factorial design.

Step 3

& Level Full Factorial Design

Factors |2 VI Factor Properties |
Blocks |1 'l Elock Properties |

Center Points Per Block IS 'l
Replicates |1 vl ™| Block On Replicates :I
Responses |1 VI Response Properties |

Repeated Measurements |MNone * | {Available with one response only)

Wiew Available Desions

Help | Cancel < Back

Einish
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4.7 Example 7: Sequential Optimization

e C(Click the Factor Properties button. In the Factor Properties window that appears, enter the names, units
and high and low level values for the factors, as shown next.

[IjFactor Properties !E[ E
MNarme Units | Type | Low Level | High Lewvel |2
A | Temperature F Quantitative 225 235
B | Reaction Time min Quantitative 55 75
t Quantitative: The results can be generalized to other values,
g Qualitative: The results can only be applied to the levels you define.
[-] OF | Cancel | Help |

e Click OK to close the Factor Properties window and return to the Design Wizard.

e C(Click the Response Properties button. In the Response Properties window that appears, define the
response name, as shown next.

e Click OK to close the Response Properties window and return to the Design Wizard.

[IjResponse Properties !E[ E
Name Units =

Yield %o —I

-

OF | Cancel | Help |

DOE++

e Click Next to proceed to the next step.
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e The fourth step of the Design Wizard provides a review of the settings you have chosen for the design.

[IjDesign Wizard [ %]
"""": Review the settings vou have chasen for your design,

Step 4

—Design Review

View in & separate window. ..

2 Level Full Factorial Design

_
Factors: 2
Blocks: 1
Center Points Per Block: 5
Replicates: 1
Block On Replicates: N
Cbservations: 9
Responses: 1
Factor Properties
Factor Name Units Type  Low Level High Level
A Temperature F Quantitative 225 235
B Reaction Time min Quantitative 55 73
H o]
l-‘-I 4 | »
o]
o Help | Cancel | < Back | [ext = |

If any of the settings are not as intended, you can click the Back button to return to the appropriate step
and make any necessary changes.

e C(Click Finish to create the new project with the Standard Folio containing the two level full factorial

design.

e Save the project as “SequentialOptimization.rso7.”

e Sclect Standard Order in the Sort By area in the Control Panel to sort the Data Sheet by the Standard
Order column, then enter the response data in the order given in this example on page 70. The Folio will
look like the one shown next.

[IjFoIio: Foliol {Design}

IS[=] E3

G9 359 Main | Optionsl Other |
Standard Run Paint A:Termperature |B:Reaction Time | Yield Display Factors
Crder Crder Type Bl (3] {rmin (%)
I~ " Coded Yalues
1 1 6 1 1 225 55 33.95 @ Actusl Values
2 2 3 1 1 233 55 36.33 Sort By
3 3 7 1 1 223 75 35
4 4 g 1 1 233 75 37.25 " Run Order
5 5 2 i 1 230 65 35.45 @ standard Order
5] 5] 4 u] 1 230 65 35.73 Diesign Summary
7 7 5 u] 1 230 65 36.03 ——
=] g ] u] 1 230 65 35.3 Pl=...
9 9 1 o] 1 230 65 35.9
Dresign |

e On the Options page of the Control Panel, specify a Risk Level (Alpha) value of 0.1 for the Yield

response and select to

use Grouped Terms.

74

http://DOE.ReliaSoft.com



4.7 Example 7: Sequential Optimization

e Return to the Main page of the Control Panel and click Calculate. The Analysis tab is shown next.

ﬁFolio: Foliol {Analysis) M= E3

A0 [Main | Optionsl Other I
A ‘ B ‘ C ‘ (0] ‘ E ‘ F ‘ G ‘ H ;I Response 0
1 ANOVA Table Jrieid =l
Source of Degrees Sum of Mean TransFarmation
2 Variation of Squares | Squares  FRatio P Value .
Freedom [Partial] [Partial] =Y
3 |model 4 6,368 1592 | 164543 | 0.0095 Risk Level (Alpha)
4 Iain Effects 2 5.3562 31781 32.8488 0.0033 01
5 2-\Way Interaction 1 0.0056 0.0056 0.0581 0.8213 .
4] Curvature 1 0.0061 0.0061 0.0633 0.8137 Analysis Settings
7 [Residual 4 0.397 0.0967 Partisl 55 [ Grouped
& | PureError 4 0.357 0.0967 Calculated
a  |Total 2 £.755 Observations = 9
10 Analysis Summary
11 5=0311 ——
Pli)=... ann
12 R-sq = 04.27% L B
13 R-sq(ad]) = 55.54%
14
15 Regression Information
16 Term Effect | Coefficient Stg:i?rd Low CI | HighCI T ¥alue P Yalue
17 Intercept 35.6373 0.1555 35,3059 | 359691  220,1457  2.18E-09
18 A Temperature 2,325 1.1625 0.1555 0.8309 1.4941 7.4748 0.0017
19 B:Reaction Time 0.975 0.4875 0.1555 0.1559 0.8191 31346 0.035
20 AR -0.075 -0.0375 0.1555 -0.3691 0.2941 -0.2411 0.8213
21 Curvature 0.0525 0.2087 -0,3923 0.4973 0.2516 0.8137 |-
4 | »

Design  Analysis |

The analysis shows that the first-order regression model is adequate for this experiment since curvature is
not significant. The interaction term is also not significant. Thus, dropping the interaction term, the model in
terms of the coded variables is:

$ = 356375+ 1.1625x, + 0.4875x,

4.7.2 Part 2: Method of Steepest Ascent

Do the following:

e Use the method of steepest ascent to arrive at the operating conditions that are close to the region of

maximum yield.7 Use a step size of 10 minutes for factor B.
e How would you check for the presence of curvature at this region?

Solution

The step size of 10 minutes in factor B (variable x,) corresponds to a step size of 1 unit in coded values, as

shown next:

Logyactual 10

half range  (75-355
2

o, coded =

7 For more information on the method of steepest ascent, please refer to ReliaSoft’s Experiment Design and Analysis
Reference.
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In terms of coded values, that step size of 1 unit in X, corresponds to a step size of 2.39 units in x; (i.e. factor
A):
Ax, coded = '?1 -Ax, coded

2

:1'1622-1=2.39

In terms of actual values, that step size of 2.39 coded units in x; corresponds to a step size of 11.95°F:

(235-225)

Ax, actual = Ax, coded - half range =2.39 - =11.95

Experiments should be conducted by increasing the temperature and the reaction time in steps of 12°F and
10 minutes until no further increase is observed in the yield.

Following this protocol, the following information is observed at each step of the path of steepest ascent:

Factor Levels
Steps Coded Actual Yield
A B A B
Current Operation 0 0 230 65
Delta 24 1 12 10
1 24 1 242 75 36.50
2 4.8 2 254 85 39.35
3 7.2 3 266 95 45.65
4 9.6 4 278 105 49.55
5 12.0 5 290 115 55.70
6 14.4 6 302 125 64.25
7 16.8 7 314 135 72.50
8 19.2 8 326 145 80.60
9 21.6 9 338 155 91.40
10 24.0 10 350 165 95.45
11 26.4 11 362 175 89.30
12 28.8 12 374 185 87.65

Settings in the region centered around x; = 350°F and x, = 165 minutes (step 10) seem optimal, as the
response is largest at these settings.

Using the method of steepest ascent, the region where yield is maximized was determined; however, the
presence or absence of curvature in the region of interest cannot be determined. By using an experiment that
is augmented with center points, as shown in the next section, we can further investigate for curvature.
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4.7.3 Part 3: Checking for Curvature

In order to investigate the region that was determined in Part 2 to contain the maximum yield, a 2% design
augmented by 5 center points was conducted. The following data set was obtained:

Center Point Temp(;r)ature R?l“ai:rtlleon \((:)/eol)d
(min)
No 345 155 89.75
No 355 155 90.20
No 345 175 92.00
No 355 175 94.25
Yes 350 165 94.85
Yes 350 165 95.45
Yes 350 165 95.00
Yes 350 165 94.55
Yes 350 165 94.70

Do the following:

e Determine whether curvature is present.

e If curvature is present, what would be the simplest way to proceed in order to determine the optimum
settings for temperature and reaction time?

In the “Sequential Optimization.rdoe” sample file, the Folio for this part of the example is named “Folio2.”
Solution

e Add anew Standard Folio to the project by selecting Add Folio from the Project menu. On the first page
of the Design Wizard, click the Load Last Design... link. DOE++ will use all of the settings specified for
the most recently created design, including factor and response properties, and go immediately to the
design configuration step (in this case, the third step) of the Design Wizard.
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e In the third step of the Design Wizard, click the Factor Properties button. In the Factor Properties
window that appears, enter the new high and low level values for the factors, as shown next.

e Click OK to close the Factor Properties window and return to the Design Wizard.

MNarme Units | Type | Low Level | High Lewvel
A | Temperature F Quantitative 345 355
B | Reaction Time min Quantitative 155 175

[IjFactor Properties _|Of =
-

t Quantitative: The results can be generalized to other values,
L JQualitative: The results can only be applied to the levels you define.

OF | Cancel | Help

e Click Next to proceed to the next step.
e The fourth step of the Design Wizard provides a review of the settings you have chosen for the design.

[IjDesign Wizard [ %]

Review the settings you have chosen for your design.

:E_i\

Step 4

View in & separate window. ..

—Design Review

2 Level Full Factorial Design
_
Factors: 2
Blocks: 1
Center Points Per Block: 5
Replicates: 1
Block On Replicates: N
Cbservations: 9
Responses: 1
Factor Properties
Factor Name Units Type  Low Level High Level
A Temperature F Quantitative 345 355
B Reaction Time min Quantitative 155 175
H o]
l-‘-I 4 | »
o]
o Help | Cancel | < Back | [ext = |

If any of the settings are not as intended, you can click the Back button to return to the appropriate step

and make any necessary changes.

e Click Finish to create the new Standard Folio containing the two level full factorial design.
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e Sclect Standard Order in the Sort By area in the Control Panel to sort the Data Sheet by the Standard
Order column, then enter the response data in the order given in this example on page 77. The Folio will
look like the one shown next.

ﬁFolio: FolioZ {Design} M= E3
G9 94.7 Main | Optionsl Other |
Standard Run Paint A:Termperature |B:Reaction Time | Yield Display Factors
Block -
Order Order Type ) {min} (%) ] ¢ Coded Yaluss
1 1 1 1 1 345 155 89.75 @ Actusl Values
2 2 5] 1 1 355 155 0.2 Sort By
3 3 g 1 1 245 175 o2
4 4 5 1 1 355 175 94,25 ((: Run Order
5 5 7 i 1 350 165 54,85 O e @rdlay
5] 5] ] u] 1 350 165 95.45 Diesign Summary
7 7 2 ] 1 350 165 o5 ———
=] g 4 u] 1 350 165 94.55 @=..
9 9 3 o] 1 350 165 o4.7
Design |

e On the Options page of the Control Panel, specify a Risk Level (Alpha) value of 0.1 for the Yield
response and select to use Grouped Terms.

e Return to the Main page of the Control Panel and click Calculate. The Analysis tab is shown next.

A30
A ‘ B ‘ © ‘ [u] E ‘ F ‘ G ‘ H
1 ANOYA Table
Source of Degrees  Sum of Mean .
2 Variation of Squal_'es Squal_'es F Ratio P Value
Freedom [Partial] [Partial]
3 |Model 4 37.643 9.4107 78,9161 | 0.0005
4 IMain Effects 2 11,745 5.8725 49,2453 | 0.0015
5 2-\Way Inferaction 1 0.81 0.81 56,7925 0.0597
5] Curvature 1 25.088 25.088 | 210.3816  0.0001
7 |Residual 4 0.477 0.1193
=] Fure Error 4 0.477 0.1193
9 |Total 5] 28.12
10
11 S =0.3453
12 R-sq =|98.73%
13 R-sq(ad{) = 97.50%
14
15 Regression Information
16 Term Effect | Coefficient Stg:i?rd Low CI | HighCI T ¥alue P Yalue
17 Intercept 91.55 0.1727 91.1819 | 91,9181 | 530.2237 | 7.59E-11
18 A Temperature 1.35 0.673 0.1727 0.3069 1.0431 3.9094 0.0174
19 B:Reaction Time 3135 1.575 0.1727 1.2069 1.9431 9.1218 0.0008
20 AR 0.9 0.45 0.1727 0.0819 0.8181 2.6062 0.0597
21 Curvature 32.36 0.2317 2.8662 38538 | 14,5045  0.0001
1 »

ﬁFolio: FolioZ (Analysis) M= E3

IMain | Optionsl Other I

Response 0
Jvield |
Transfarmation
¥ =Y

Risk Level (alpha)
0.1

Analysis Settings
Partial 55 | Grouped
Calculated
Observations = 9

Analysis Summary
Fii}=... .

Design  Analysis |

In the ANOVA table, the curvature and its p value of the curvature are displayed in red, indicating that there
is curvature that merits further investigation. The presence of curvature indicates that a linear model is
insufficient for modeling the response of this experiment. Therefore, further investigation using an
experiment that allows the use of second order models is required. The simplest way to perform this
investigation and to determine the optimum settings for temperature and reaction time is to augment the
current experiment with axial runs to complete a central composite design and fit a second order model to

the response.
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4.7.4 Part 4: RSM Analysis/Optimization

The following additional data points are obtained when performing the axial runs required for a response
surface methodology (RSM) central composite design with o = 1.4142 to get a rotatable design.

Do the following:

Center Point Temp(;r)ature R?l?ifltl?n ‘({(l;ol)d
(min)

No 342.9289322 165 90.5

No 357.0710678 165 92.75

No 350 150.8578644 88.4

No 350 179.1421356 92.6

e Obtain the second order model using the significant terms.

e Find factor settings such that the yield is maximized.

In the “Sequential Optimization.rdoe” sample file, the Folio for this part of the example is named “Folio3.”

Solution:

e Return to the Design tab of the second Standard Folio.

o Sclect Modify Design from the Data menu or click the Modify Design icon on the Control Panel.

i

e In the Modify Design window that appears, select Add Axial Block in the Options area. Select New
Folio in the Apply Changes To area and select Rotatable Design for Alpha, as shown next, then click

OK.

[IjModify Design [ %]
Options Alpha
" Replicate Design *' Rotatable Design
© add Center Poirks
" Sphetical Design
" Fold Design
' pdd Axial Block " Fare Centered Design
7 Cuskom
Apply Changes To |1
 Currert Folin
t & MNew Folio
1"}
g Cancel | Help |

A new Standard Folio containing a copy of the design plus the settings for the axial points will be added to

the project.
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e Enter the axial point response data given in this example on page 80, as shown next.

EFolio: Modified Folio2 {Design)

G13 92.6 Main | Optionsl Other I
Standard Run Paint A:Termperature |B:Reaction Time | Yield 2] Display Factors
Block - _
Crder Crder Type (3] {rmin (%) ] ¢ Coded Yaluss
1 1 1 1 1 345 155 89.75 ' Actual Values
2 2 & 1 1 355 155 o0.2 =
3 3 g 1 1 345 175 oz
4 4 5 1 1 355 175 04,25 " Run Order
5 5 7 0 1 350 165 54.85 @ standard Order
& & 9 o 1 350 165 05.45 Desion Summary
7 7 2 o 1 350 165 o5 ——
g g 4 o 1 350 165 04,55 =
9 9 3 o 1 350 165 04.7
10 10 10 -1 2 3429289322 165 o0.5
11 11 11 -1 2 357.0710678 165 092.75
12 12 12 -1 2 350 1508578644 56.4
13 13 13 -1 2 350 179.1421356 92,6

Design |

o Select Select Effects from the Data menu or click the Select Effects icon in the Control Panel.

e In the Effects window, clear the Include Blocks in Model option, as shown next.

EEffects [ %]
Response: I\"ield j O I
Lirnit by Order: IFuII Quadratics j Cancel |

Select Significant Effects | Help |

I Effect Mame _

:Temperature Reset Defaults |
B:Reaction Time

AB

A

BB

[™ Tnclude Blacks in Model

DOE++

e Click OK to accept your selections and close the window.

e On the Options page of the Control Panel, specify a Risk Level (Alpha) value of 0.1 for the Yield
response and select to use Grouped Terms.
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e Return to the Main page of the Control Panel and click Calculate. The Analysis tab is shown next.

[IjFolio: Modified FolioZ (Analysis)

A2q [Main | Optionsl Other I
A ‘ B ‘ C (0] ‘ E ‘ F ‘ G H H Response 0
1 ANOVA Table Jieid =
Sum of Mean -
. T f i
2 izl::-:ﬁu?]f D:_%r:;;_?f Squares  Squares F Ratio P Value rans Iorma on
[Partial] | [Partial] Y=
3 |Model 5 £5.0867 13.0173 | 913426  3.22E-06 Risk Level (Alpha)
4 | Linear Effects 2 23.051 11,5255 | 80.8743  1.45E-05 g
5 | Interaction Effects 1 0.81 0.81 56838 | 0.0486 .
6 | Quadratic Effects 2 41,2257 | 206128 | 144.6402 2.03E-06 Analysis Settings
7 |residual 7 0.9978 0.1425 Partidl 55| Grouped
8 | LackofFit 3 0.5206 01735 | 14551 03527 allmutiad
o | Pure Error 4 0.477 01193 Observations = 13
10 [Total 12 £6,0842 Arellgas S
i [ ro=..
12 S =0.3775 PRESS = 4.4472
13 R-5 = 98.49% R-sgipred) = 93.27%
14 R-sqiadj) = 97.41%
15
16 Regression Information
17 Term Coefficient Stg:i?rd Low CI HighCI T W¥alue P Yalue
18 Intercept 04,91 0.1688 04,5001 | 95,2209 | 562.1764 0
19 4:Temperature 0.7352 0.1335 0.4824 00881 55088 0.0003
20 | B:Reaction Time 1.53 0.1335 1.2771 17828 | 11.4631  8.64E-06
21 4B 0.45 0.1888 0.0924 08076 | 23841 | 0.0486
2z A -1.5206 0.1431 -1.7018 | -1.2405 | -10.6241  1.43E-05
23 BE -2,0831 0,1431 -2,3543 -1.812  -14,5542  1.73E-06 =
A »

Design  Analysis |

All effects are significant at a significance level of 0.1. The final model in term of coded values is:
$ = 949+ 0.735x, + 1.53x, + 0.45x,x, — 1.52x — 2.08x

e Select Optimization from the Data menu or click the Optimization icon in the Control Panel.

=l
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In the Optimization Settings window that appears, select Maximize from the drop-down in the Goal

column and enter 80 for the Lower Limit value and 100 for the Target value. The Optimization Settings
window will look like the one shown next.

[Ijl:lptimization Settings

=] B3
Response Settings | Factor Settings (Actual) | Algorithm Settings |
Lower LUpper ) =
Selected MNarme Goal Limit Target Lirmit Weight Importance ||
2 ield Maximize 50 100

+
+
[[] =
o]
[ =] Reset | QK | Cancel | Help

e Click OK to accept your settings and create the Optimal Solution plot, as shown next.

[IjFoIio: Modified Folio2 (Optimization)

Optimal Solution 1

Display Factors 0

" Coded values
& Ackual values

| [T Keep Aspect Ratio

Solutions
i optimal Solution 1

“field
[ Maxirnize])
= 95,3264

A:Temnperature E:Reaction Tirne @l ﬂl @l @l @l
¥ =351.5045 ¥ = 168.9973 S|
Design I Analysis  Optimization |

The optimum settings are found to be at a temperature of x; = 352°F and with a reaction time of x, = 169
minutes.

e Save and close the project then proceed to the next example.
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4.8 Example 8: Taguchi Robust Design

Consider the case of a chemical process where the experimenter wants the product to be neither acidic nor
basic (i.e. the pH of the product needs to be as close to 7 as possible). It is thought that the pH of the product
depends on the concentration of the three reactants A, B and C used to create the product. It has also been
found that the pH of the product depends on the ambient temperature.

The experimenter chooses Taguchi's robust parameter design approach to investigate the settings of the
control factors (i.e. the concentrations of A, B and C) to make the product as insensitive as possible to the

noise factor (i.e. changes in ambient temperature). It is decided to carry out a 23 experiment to study the
effect of the three control factors on the pH of the product. It is also decided to carry out the experiment at
four levels of the ambient temperature by using a chamber where the surrounding temperature of the
chemical process can be controlled.

The resulting data set is shown next.

Control Factor Settings Noise Noise Noise Noise
A B C Condition 1 | Condition 2 | Condition3 | Condition 4
-1 -1 -1 5.05 6.5 7 7.15
1 -1 -1 5.05 5.05 5.35 6.15
-1 1 -1 5.95 6.85 7.65 7.95
1 1 -1 4.65 4.95 5.35 5
-1 -1 1 6.35 7 7.25 7
1 -1 1 4.05 6.55 6.15 6.45
-1 1 1 6.85 7.05 7 8
1 1 1 4.65 5.55 6 6.15

Note that the factor values in this data set are expressed as coded values, where -1 represents the factor’s low
value and 1 represents the factor’s high value. When creating a design, with the exception of standard one
factor designs, it is not necessary to enter actual factor values. In some situations, it may be more convenient
to use coded values. DOE++ performs analysis in the same way, regardless of whether actual or coded
values are used.

Do the following:
e Obtain the location and dispersion models using a nominal-the-best model for the Signal/Noise Ratio

model.

e Using the normal probability plots of the location and signal-to-noise ratio responses, identify the
significant effects at a 10% significance level.

e Build location and signal-to-noise ratio models.

e Find the optimum settings so that the pH value stays on target while maximizing the signal-to-noise
ratio.

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\DOE\Training Guide) and is named “TaguchiRobust.rdoe.” The data set for
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this example is available in the Spreadsheet in the “TaguchiRobust-Data.rso7” file located in the “Raw

Data” folder within the “Training Guide” folder.

Solution

e Create a new project. On the first page of the Design Wizard, select to create a Taguchi Robust Design

and click Next to proceed to the next step.

EDesign Wizard [ %]

Specify the type of Design of Experiments.

Step 1

—Create a new project using. ..

o

?"'_’TE [ Factorial Design
U,

©

/|

o b

[” One Factor Design
Choose this to compare mean values at each level of a single Factor

General Factorial, Plackett-Burman ...},

[” Response Surface Method Design

Box-Behnken Design ...
¥ Taguchi Robust Design

[~ Reliability DOE

the experiments,

Choose this to simultaneously study the effects of several Factors {e.g. Fractional Factorial,

Choose this to establish a relationship between Factors and responses {e.g. Central Composite,

Choose this to use Taguchi's methods {e.q. Robust Parameter Design ...},

Choose this For life test designs, especially when you expect interval data or suspensions from

Load Last Design. .. = Back

DOE++

Help Cancel |

Eiish |

e In the second step of the Design Wizard, select 2 Level Factorial Design for the inner (control) array

type and click Next to proceed to the next step.

EDesign Wizard [ %]
Define the Inner Array type for Taguchi Robust Design.
Step 2
—Select Inner Array For Control Fackors
.. [” Taguchi DA Factorial Design
;ﬁ Choose this design if you have multiple level control Factors, 7]
& ’T ¥ 2 Level Factorial Design
r;/'f'r Choose this design if all control Factors are bwo level, 7]
- ,F‘.':—: [” General Full Factorial Design
%I Choose this if the experiment. includes all combinations of the Factor levels, Each factor can 71
have any number of levels,
+
+
g
o Help | Cancel | < Back Eimish |

In the third step of the Design Wizard, select to create a 2 Level Full Factorial Design for the inner

array and select 3 from the Factors drop-down and leave all other fields at their default settings. Because
the control factor names in this example are A, B and C and only coded values are used, you do not need

DOE++ Training Guide
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to change the factor names or enter low and high values for the factors. There is no need, therefore, to
access the Factor Properties window. Click Next to proceed to the next step.

EDesign Wizard [ %]

"':"': Define the data format that you want for Taguchi 2 Level,

Step 3

—Taguchi 2 Level Inner Array Design
{+ 2 Level Full Factorial Design
(" 2 Level Fractional Factorial Design

(" Plackett-Burman Design

Factors |3 - l Factor Properties |

Wiew Available Desions

Help | Cancel | < Back

e In the fourth step of the Design Wizard, select to create a General Full Factorial Design for the outer
(noise) array and leave all other fields at their default settings, as shown next.

EDesign Wizard [ %]

Define the Outer Array for Moise Factors in Taguchi Robust Design.

Eiish |

DOE++

v\

Step 4

—Ouker Array Design For Moise Fackors
(" 2 Level Full Factorial Design
(" 2 Level Fractional Factorial Design
(" Plackett-Burman Design

{+ General Full Factorial Design

Factors I 1 - l Factor Properties |

Replicates I 1 - l

Wiew Available Desions

Help | Cancel < Back

Einish

DOE++
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e To define the noise factor properties, click the Factor Properties button. In the Factor Properties
window that appears, select 4 from the drop-down in the Number of Levels column, as shown next.

[IjFactor Properties !E[ E
MNarme Units Type Pyl Level 1 Level 2 Level 3 Level 4 =
b of Levels _|
A A Qualitative 4 - 1 2 3 4

t Quantitative: The results can be generalized to other values,
{['] Qualitative: The results can only be applied to the levels you define.
o]
[=]

OF | Cancel | Help |

e Click OK to close the Factor Properties window and return to the Design Wizard.
e Click Next to proceed to the next step.

e The fifth step of the Design Wizard provides a review of the settings you have chosen for the design.

[IjDesign Wizard [ %]
o Review the settings you have chosen for your design.
Step 5

View in & separate window. ..
—Design Review

Taguchi DA Robust Design o
_

Inner Array Design

Design Type: 2 Level Full Factorial Design

Factors: 3

Runs: =]

Sarple Size per Run: 4

Observations: 32

Control Factor Properties

Factor Name Units Type Low L
A A Quantitative -1
B B Quantitative -1
C C Quantitative -ls
o | o

DOE++

Help | Cancel | < Back | [ext =

The information here is extensive. You may wish to take a moment to scroll through it. If any of the
settings are not as intended, you can click the Back button to return to the appropriate step and make any
necessary changes.

e Click Finish to create the new project with the Standard Folio containing the Taguchi robust design.

e Save the project as “TaguchiRobust.rso7.”
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e Sclect Standard Order in the Sort By area in the Control Panel to sort the Data Sheet by the Standard
Order column, then enter the response data for each noise condition in the order given in this example on
page 84. The Folio will look like the one shown next.

[I__T]_Folio: Foliol {Design) [_ O]
18 6.15 Main | options | other |
Standsrd | Run | . . Hoise Moise Hoise Moise ) ) ) = b Signs|/hnise Ratio
Order | Order A || B | €S Condition 1 |Condition 2 |Condition 3 (Condition 4 v Meanp i ™ Sige e Ratllg_l Norminal
1 1 B | -1| -1 -1| 505 6.5 7 7.15 —
2 2 3 1 -1 -1 505 5.05 535 6.15 Ly
3 3 1111 5.95 6.85 7.65 7.05 " Coded Values
4 4 7 11 4.65 4,05 5.35 5 ¥ ctual Values
5 5 4 | 1|11 6.35 7 7.25 7 =
3 [3 2 |11 1 4.05 6.55 6.15 6.45 e
7 7 6 | -1 11 6.85 7.05 7 B =i i i @itz
8 8 s 1 1 1 4 5.55 s e || et Bt
I Design Summaty:
I Pli)=...
Design I

Because you did not change the factor values from the original coded values in the Factor Properties
window, the Folio will look the same regardless of whether Coded Values or Actual Values is selected in
the Display Factors area of the Control Panel. Note that the last three columns, Y Mean, Y Std and Signal
Noise Ratio, are currently empty. These columns will be populated by DOE++ when the data set is analyzed,
using calculations based on your input in the noise condition columns, and will then be used as the responses
for the analysis.

e On the Main page of the Control Panel, select Nominal in the Signal/Noise Ratio menu.

e On the Options page of the Control Panel, specify a Risk Level (Alpha) value of 0.1 and select to use
Grouped Terms for the Y Mean response, which is currently selected in the Response drop-down.

e Sclect the Y Std response from the Response drop-down and specify a Risk Level (Alpha) value of 0.1
and select to use Grouped Terms for it.

e Do the same for the Signal Noise Ratio response.
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4.8 Example 8: Taguchi Robust Design

e Return to the Main page of the Control Panel and click Plot. The Y Mean, Y Std and Signal Noise Ratio
columns will be calculated and used as the responses in the Analysis and Plot tabs that are added to the
Folio. The Effect Probability plot for the Y Mean (location) response, created by default, is shown next.

ReliaSoft DOE++ - www.ReliaSoft.com
Normal Probability Plot of Effect
99.000 Effect Probability
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Y=Y
® Non-Significant Effects
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10.000
mAA
5.000
User Name
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2/25/2008
1.000 1:27:33 PM
-6.000 -3.600 -1.200 1.200 3.600 6.000
Effect
Alpha = 0.1; Lenth's PSE = 0.1781

The normal probability plot of the effects for the location response indicates that A is the only significant
effect for this model.

Select Signal Noise Ratio from the Response drop-down in the Control Panel. The Effect Probability
plot for the Signal Noise Ratio response is shown next.

ReliaSoft DOE++ - www.ReliaSoft.com
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Alpha = 0.1; Lenth's PSE = 1.6494
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4 Step-by-Step Examples

The normal probability plot of the effects for the Signal Noise Ratio response indicates that AC is the only
significant effect for this model.

e Go to the Analysis tab by clicking its page index tab.

e Sclect the Y Mean response from the Response drop-down in the Control Panel if it is not already
selected.

o Select Select Effects from the Data menu or click the Select Effects icon in the Control Panel.

e In the Effects window, click the Select Significant Effects button to select only the effect (A) shown to
be significant for the Y Mean response, as shown next.

[IjElTects [ %]

Response: I\" Mean j o] I
Lirit by Order: IMain Effects j Cancel |

Select Significant Effects | Help |

I Effect Marne: I

Reset Defauls
Oe:e

Occ

O:ze

Oac

Oec

Ozec

™| Triclude Elacks i Made!
| Triclude: Curvature in Mads]

DOE++

e Click OK to accept your selections and close the window.

e In the Analysis Settings area of the Control Panel, click inside the Test Terms area to toggle the analysis
settings from Grouped to Individual.

e Click the Calculate icon to re-analyze the data set using the selections you have just made. The changed
Analysis tab is shown next.

[ljFuliu: Foliol {Analysis) H=l
/2T [ain I Optlunsl Other I
A ‘ B | € | D | E | F | ® ‘ H 1 | 1 Resporse 4
1 ANOVA Table J¥ r2an &l
Degrees | Sum of Mean Transformation
2 33:::30?: of Squares | Squares FRatio P Value
Freedom [Partial] | [Partial] -
3 [Model 1 4.2145 4,2145 35.5449 0.001 Risk Lewvel (Alpha)
4 A 1 4.2145 4,2145 35.5449 0.001 0.1
5 |Residual ] 0.7283 0,1214 _ _
6 | PureError 6 0.7283 0.1214 e e e
7 |Total 7 5.0427 Partial 35 | Individual
g Calculated
3 S = 03454 s Observations = 32
10 F-5g = 85.56% I Analysis Surmmary
i R-sqac) = £3.15% [ A e
13 Regression Information
14 Term Effect | Coefficient Stg:_?;rd Low CI | HighCI T V¥Yalue P Value
15 Intercept 6.1781 0.1232 5.9388 64175 | 50.1566 4.21E-09
156 A -1.4687 -0, 7344 0.1232 -0.9737 -0.495 -5.962 0.001 -
1 »
Design  Analysis | Plot I
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4.8 Example 8: Taguchi Robust Design

From the information in the Regression Information table, the location model can be determined to be:
y = 6.1781-0.7344x,
o Select the Signal Noise Ratio response from the Response drop-down in the Control Panel.

o Select Select Effects from the Data menu or click the Select Effects icon in the Control Panel.

e In the Effects window, click the Select Significant Effects button to select only the effects shown to be
significant for the Signal Noise Ratio response. Note that in order to select AC, A and C must also be
selected so that the model is hierarchical, as shown next.

[IjElTects [ %]

Response: ISignaI Moise Ratio j
Lirnit by Order: |2-Way Inkeraction j Cancel
Select Significant Effects | Help |

Effect Mame
A Reset Defaults |
Oes

[olls

Oxe

A

Oec

Ozec

™| Triclude Elacks i Made!
| Triclude: Curvature in Mads]

DOE++

e Click OK to accept your selections and close the window.

e In the Analysis Settings area of the Control Panel, click inside the Test Terms area to toggle the analysis
settings from Grouped to Individual.

e Click the Calculate icon to re-analyze the data set using the selections you have just made. The changed
Analysis tab is shown next.

[ Folio: Foliol (Analysis) M=l
A35 Main I Optiunsl Other I
A ‘ B | € | D | E | F | ® ‘ H 1 | 1 = Response 4
1 ANOVA Table ISigna\ Noise Ratio j
Degrees Sum of Mean Transformation
2 32:;:;;: of Squares | Sgquares FRatio P Value
Freedom [Partial]l | [Partial]l =

3 [Model 3 89.6186 29,8729 3.0164 0.0766 Risk Level {Alpha)
4 s 1 3.1674 3.1674 05319 0.5062 0.1
5 cic 1 0.0212 0.0212 0.0036 0.9353
6 | AC 1 86.43 86,43 | 145138 | 00120 (s ST
> |Residual 4 53.82 5.055 Partial 55 [ Individual
8 | PucEror 4 23.82 5,055 (ealeticted
9 Total 7 113,935 Observations = 32
10 I Analysis Surmmary
11 S = 24402 [ Pm
12 R-5g = 72.00% _I
13 |R-sgiad)) = 63.25%
14
15 Regression Information
16 Term Effect | Coefficient Sté'l:z?rd Low CI | HighCI T VYalue P Value
17 Intercept 19,963 0.8628 18,1237 | 21.8023 23,1382 Z2.07E-0S
18 Aid -1.2584 -0.6292 0.8628 -2.4685 1.2101 | -0.7293 0.5062
19 i 0.103 0.0515 0.8628 -1.7878 1.8902 0.,0597 0,9553
20 AL -6.5738 -3,2869 0,8628 -5.1262 | -1.4476  -3.8097 00,0189 -

4 | LlJ

Design  Analysis | Plot I

From the information in the Regression Information table, the dispersion model can be determined to be:
SNy = 19.963 — 0.6292x, +0.0515x; — 3.2869x x,
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4 Step-by-Step Examples

Select Optimization from the Data menu or click the Optimization icon in the Control Panel.

<

e In the Optimization Settings window that appears, select the checkboxes for the Y Mean and Signal
Noise Ratio responses and clear the checkbox for the Y Std response. For the Y Mean response, select
Target from the drop-down in the Goal column and enter 6.5 for the Lower Limit value, 7 for the Target
value and 7.5 for the Upper Limit value. For the Signal Noise Ratio response, select Maximize in the
Goal column and enter 0 for the Lower Limit value and 30 for the Target value. The Optimization
Settings window will look like the one shown next.

[Ijl:lptimization Settings !E[ E
Response Settings | Factor Settings (Actual) | Algorithm Settings |
Lower LUpper ) =
Selected MNarme Goal Limit Target Lirmit Weight Irmportance ||
v ¥ Maan Target ~ 6.5 7 7.5 1 1
r ¥ Std
IV ignal Noise Ratf  Maximize o] 20 1 1
+
+
[[] -
o]
[ =] Reset | QK Cancel Help
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4.9 Example 9: One Factor Reliability Design

e Click OK to accept your settings and create the Optimal Solution plot, as shown next.

[I__T]_ Folio: Foliol {Optimization)

ReliaSoft DOE++ - www ReliaSoft.cam

Cptirmal Solution 1 Display Factors 43|
i " Coded values
Folioz
6312 - L & Actual Values
Factor vs Response @
—  Continuaus Functior
73] . Factor value DE ¥ Keep Aspect Ratio

— Response Walue

Solutions
& optimal Solution 1

B.225

£.9125

031

¥ Mean
0.8250 (Target)

b

5738

D=

£.444

23.931

22,364

20,798

23,9306

13.221

Vo=

Signal Noise Ratio
0.7977 (Maximize)

17 BRE

User Mame
Campany
8/12/2008
123872 pi

s}

16098

L.000
0600
0,200
0.200
0,600
1.000
1.000
0600
0,200
0.200
0,600
1.000

Ad i

% =-1,0000 %=1,0000 @ \ﬂl 1@ I@ll@l

Slobal Desirability = 06112 -
Design I Analysisl Plot  Optimization |

Based on the Optimal Solution plot, factor A should be set at its low value and factor C should be set at its
high value in order to keep the pH as close as possible to 7 while making the product as insensitive as
possible to changes in ambient temperature. Since factor B does not affect either the location model or the
dispersion model, it can be set at the level that is most economical.

e Save and close the project then proceed to the next example.

4.9 Example 9: One Factor Reliability Design

A unit has traditionally worked in an application where it is required to cyclically bend to 40 degrees. The
designers have been requested to inform management how it will affect the life of the parts to be working in
an environment where the units will be required to bend as much as 50 to 60 degrees. Thirty units are to be
randomly tested to failure by bending them to 40, 50 and 60 degrees and the cycles to failure will be
recorded.

The following failure data are collected:

(dlz;gelees) Cycles Failed
40 75
50 33
60 35
40 53
50 35
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4 Step-by-Step Examples

(dt;lfelzs) Cycles Failed
60 45
40 44
>0 32
60 30
40 43
>0 47
60 36
40 51
>0 35
60 28
40 58
>0 45
60 32
40 67
>0 50
60 39
40 69
>0 43
60 37
40 76
>0 48
60 42
40 41
>0 31
60 38

Do the following:

e Assuming a Weibull distribution and a significance level of 10%, determine whether the angle
significantly affects the life of these units.

e Graphically validate the Weibull distribution assumption.

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\DOE\Training Guide) and is named “OneFactorReliability.rdoe.” The data set
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4.9 Example 9: One Factor Reliability Design

for this example is available in the Spreadsheet in the “OneFactorReliability-Data.rso7” file located in the
“Raw Data” folder within the “Training Guide” folder.

Solution

e Create a new project. On the first page of the Design Wizard, select to create a Reliability DOE and
click Next to proceed to the next step.

[IjDesign Wizard [ %]

Specify the type of Design of Experiments.

Step 1

—Create a new project using. ..

+ | I one Factor Design
S99 Choose this ko compare mean values at each level of a single Factor, 7]
?"'_’TE [ Factorial Design
r;f"f'f_,,_ Choose this ko simulkaneously study the effects of several Factors (e.q. Fractional Factorial, 71

General Factorial, Plackett-Burman ...},

| [” Response Surface Method Design
Choose this ko establish a relationship between factors and responses (e.g. Central Composite, (el

Box-Behnken Design ...

o l/| " Taguchi Robust Design
v Choose this ko use Taguchi's methods {e.g. Robust Parameter Design ... ). 7]

¥ Reliability DOE
Choose this For life test designs, especially when you expect interval data or suspensions from 71
the experiments,

Eiish |

DOE++

Help Load Last Design. .. Cancel | = Back

e In the second step of the Design Wizard, select One Factor Reliability Design and click Next to
proceed to the next step.

[IjDesign Wizard [ %]

Define the factorial type for Reliability Design.

Step 2

r—Reliability Design
E ¥ One Factor Reliability Design

Choose this to compare the life at each level of a single Factor, 7]

[” 2 Level Full Factorial Reliability Design

Choose this if the experiment. includes all combinations of the Factors, 71
[” 2 Level Fractional Factorial Reliability Design
Choose this if the experiment. includes only part of all combinations of the Factors, (7]
W " Plackett-Burman Reliability Design
h: Choose this to study the main effect of multiple Factors, Each Factor has only bwo levels, (7]

DOE++

Eimish

Help | Cancel < Back
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4 Step-by-Step Examples

e In the third step of the Design Wizard, enter 10 in the Replicates field, as each angle is tested 10 times.
Leave all other fields at their default settings, indicating that there is no censoring in the data, as shown

next.
[IjDesign Wizard [ %]
)

Define the data format that you want for One Factor Reliability.

Step 3

—one Factor Reliability

Factors |1 VI Factor Properties | Replicates IID

View Available Designs. ..

r— Times-to-Failure Data Options

[ My data set contains suspensions (right censored data)
—+ Choose this if your data set contains units that did not Fail. 71

[ My data set contains interval and/or left censored data

»—a Choose this if your data set contains uncertainty as ko exactly when a unit Failed, This will allow you ko (7]
specify intervals for times-to-failure,

—Based on yvour selections, the data sheet will include these responses

Time
t | Failed |
g
=] Help | Cancel | < Back | Mexk = I Finish |

e Click the Factor Properties button. In the Factor Properties window that appears, enter the name and
units for the factor then specify the number of levels and enter the level values, as shown next.

[IjFactor Properties !E[ E
) Murnbar =
MNarme Units of Levals Level 1 Level 2 Level 3 -
A Angle Degrees 3 40 50 60

- -

+

1"}

o]

[ =] QK | Cancel | Help

Note that the factor in a one factor reliability design is always qualitative.
e Click OK to close the Factor Properties window and return to the Design Wizard.

e Click Next to proceed to the next step.
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4.9 Example 9: One Factor Reliability Design

e The fourth step of the Design Wizard provides a review of the settings you have chosen for the design.

EDesign Wizard [ %]

"':"': Review the settings vou have chasen for your design,

Step 4
View in & separate window. ..

—Design Review
One Factor Reliability Design

_
Factors: 1
Replicates: 10
Cbservations: 30

Factor Properties

Factor Name Units Type Level Levell Level2 Level3
A Angle Degrees Qualitative 3 40 50 &0

|
Help | Cancel | < Back | [ext =

DOE++

If any of the settings are not as intended, you can click the Back button to return to the appropriate step
and make any necessary changes.

e Click Finish to create the new project with the Standard Folio containing the one factor reliability

design.
e Save the project as “OneFactorReliability.rso7.”

e To change the title of the results column (i.e. “Time Failed”), double-click the column header and, in the
window that appears, type Cycles Failed, as shown next, then click OK.

ﬁthange Heading
Cycles o

Failed =
Cancel |

DOE++
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4 Step-by-Step Examples

e On the Main page of the Control Panel, select the Weibull distribution.

Select Standard Order in the Sort By area in the Control Panel to sort the Data Sheet by the Standard
Order column, then enter the response data in the order given in this example on page 93. The Folio will
look like the one shown next.

[IjFoIio: Foliol {Design}

IS[=] E3

C30 38 Main | Optionsl Other |
Standard Run Cycles | Arangle Distribution
Crder Crder Failed |(Degrees)

1 1 g 75 40

E o 17 ee] =0 Display Factors
3 3 29 35 60 " Coded values

4 4 ] 53 40 & Ackual values

5 5 19 35 S0

& & 27 45 &0 sort By

7 7 5 44 40  Run Order

=] g 10 2 =0 & standard Order

£ 2 28 =0 €0 Design Surmmaryy
10 10 16 43 40 —
11 11 22 47 50 RIS
12 12 3 36 60

13 13 13 51 40

14 14 20 35 S0

15 15 7 28 60

16 16 5 58 40

17 17 5] 45 S0

18 18 2 32 60

19 19 4 67 40

20 20 15 S0 S0

21 21 14 a9 60

22 22 26 =] 40

23 23 12 43 S0

24 24 23 37 60

25 25 20 76 40

26 26 24 48 S0

27 27 11 42 60

28 28 21 41 40

29 29 1 31 S0

30 20 18 I 28 I 60
Design |

e On the Options page of the Control Panel, specify a Risk Level (Alpha) value of 0.1.
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4.9 Example 9: One Factor Reliability Design

e Return to the Main page of the Control Panel and click Calculate. The Analysis tab is shown next.

ﬁFolio: Foliol {Analysis) M= E3

AS0 [Main | Optionsl Other I
A ‘ B C ‘ D ‘ E ‘ F ‘ G ‘ H Distribution [}
1 |Distribution: Weibull
2
3 Likelihood Ratio Test Table FEK EE (i)
o i o1

4 Model Degrees of  Ln{Likelihood leellh_uud P value

Freedom Yalue) Ratio Al Getngs
S | Reduced 2 -119.8191 307518 | 2.10E-07 o BeiE
& Full 4 -104,4432 Callated
7 Observations = 30
=] MLE Information Factor Level = 3
9 Term Effect Coefficient Stg:i?rd Low CI | HighCI 2 ¥alue P Yalue Analysis Summary
10 Beta 56,3715 0.9307 5.0104 8.1024 Pli)=...
11 Intercept 3.8503 0.0303 3.8005 39001 | 127.1497 u]
12 Al1] 0.6169 0.3084 0.0406 0.2416 0.3733 75896 | 3.20E-14
13 Al2] -0,1868 -0.0934 0.0405 -0.1601 @ -0.0267 | -2.3048 0.0212
14
15 Life Characteristic Summary
16 Factor | Number in Eta Star_]de_lrd LowCI | HighCl

Level Level Deviation

17 40 F=10/5=0 53,9809 3.2807 58.8139  69.6215
18 50 F=10/5=0 42,8148 2.1632 39,3997 | 46,5258
19 50 F=10/5=0 37.9114 1,9006 34.9101 | 41,1708
20
21 Life Comparisons

Ln(Eta) Pooled .
22 |Contrast Difference  Standard Error Low CI HighCI 2 Value P Yalue
23 40 - 50 0.4018 0.0703 0.2862 0.5175 5.7184 | 1.07E-02
24 40 - &0 0.5235 0.0704 0.4076 0.6393 74328 | 1.06E-13
23 50 - 60 0.1216 0.0702 0.0061 0.2372 1.7319 0.0533 -

4 | »
Design  Analysis |

The p values in the Life Comparisons table indicate that, at a significance level of 10%, bending the units at
50 and 60 degrees has a significant effect on the life of the units such that the units are expected to fail faster
than they would being bent at 40 degrees.

e To confirm this graphically, click the Plot icon to add the Plot tab to the Folio.
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4 Step-by-Step Examples

e Sclect Life Characteristic from the Plot Type menu in the Control Panel. The Life Characteristic plot is

shown next.
ReliaSoft DOE++ - www.ReliaSoft.com
Life Characteristic
70.000 Life Characteristic
Time
® Life Characteristic
—— Bounds @ 90%
60.000
50.000
i}
w
40.000
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2/25/2008
20.000 2:14:30 PM
40 50 60
Level

e To validate the Weibull distribution assumption, select Residual Probability from the Plot Type menu
in the Control Panel. The Residual Probability plot is shown next.

ReliaSoft DOE++ - www.ReliaSoft.com
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Time
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— Residual Line
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4.10 Example 10: Two Level Fractional Factorial Reliability Design

The data points follow the line reasonably closely, indicating that the Weibull distribution assumption is
valid.

e Save and close the project then proceed to the next example.

410 Example 10: Two Level Fractional Factorial Reliability Design

A reliability engineer wishes to predict the reliability of an electromechanical component in the field. In
order to build a life-stress relationship for reliability prediction, important stresses need to be identified.

Given the large number of possible factors, the engineer chooses a 284 fractional factorial design (i.e. 16
runs) with the following factors:

A: Temperature
B: Humidity

C: Load

D: Speed

E: Voltage

F: Coolant Type
G: Vibration

H: Current

Since the ultimate goal is to build a reliability model, a reliability design is chosen. Units are inspected every
20 hours and the test is suspended after 200 hours of testing. The data set is shown next.

Temperature | Humidity | Load | Speed | Voltage C,(l);:f:t Vibration | Current lnsl;)isctte d (FSt:rteS) rl;:r:::g
-1 -1 -1 -1 -1 -1 -1 -1 180 F 200
1 -1 -1 -1 1 -1 1 1 60 F 80
-1 1 -1 -1 1 1 -1 1 140 F 160
1 1 -1 -1 -1 1 1 -1 180 F 200
-1 -1 1 -1 1 1 1 -1 160 F 180
1 -1 1 -1 -1 1 -1 1 80 F 100
-1 1 1 -1 -1 -1 1 1 180 S 200
1 1 1 -1 1 -1 -1 -1 80 F 100
-1 -1 -1 1 -1 1 1 1 180 S 200
1 -1 -1 1 1 1 -1 -1 180 S 200
-1 1 -1 1 1 -1 1 -1 120 S 140
1 1 -1 1 -1 -1 -1 1 120 F 140
-1 -1 1 1 1 -1 -1 1 180 S 200
1 -1 1 1 -1 -1 1 -1 120 F 140
-1 1 1 1 -1 1 -1 -1 140 F 160
1 1 1 1 1 1 1 1 120 F 140
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4 Step-by-Step Examples

Note that the factor values in this data set are expressed as coded values, where -1 represents the factor’s low
value and 1 represents the factor’s high value.

Do the following:

e Identify the significant factor(s).

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\DOE\Training Guide) and is named “TwoLevelFractionalReliability.rdoe.” The
data set for this example is available in the Spreadsheet in the “TwoLevelFractionalReliability-Data.rso7”
file located in the “Raw Data” folder within the “Training Guide” folder.

Solution

e Create a new project. On the first page of the Design Wizard, select to create a Reliability DOE and
click Next to proceed to the next step.

DOE++

[IjDesign Wizard [ %]

Specify the type of Design of Experiments.

—Create a new project using. ..

+ | I one Factor Design
|- a9 Choose this to compare mean values at each level of a single Factor,

| [ Factorial Design
r_,_'uf"f'f_,,_ Choose this ko simulkaneously study the effects of several Factors (e.q. Fractional Factorial,
General Factorial, Plackett-Burman ...},

| [” Response Surface Method Design
Choose this to establish a relationship between Factors and responses {e.g. Central Composite,
Box-Behnken Design ...

.| [T Taguchi Robust Design
v Choose this to use Taguchi's methods {e.q. Robust Parameter Design ...},

¥ Reliability DOE
Choose this For life test designs, especially when you expect interval data or suspensions from
the experiments,

Help | Load Last Design. .. Cancel = Back

Eimish
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4.10 Example 10: Two Level Fractional Factorial Reliability Design

In the second step of the Design Wizard, select 2 Level Fractional Factorial Reliability Design and

click Next to proceed to the next step.

[IjDesign Wizard [ %]

"""": Define the factorial type for Reliability Design,

Step 2

r—Reliability Design
" Dne Factor Reliability Design
Choose this to compare the life at each level of a single Factor, 7]
[” 2 Level Full Factorial Reliability Design
Choose this if the experiment. includes all combinations of the Factors, 71
¥ 2 Level Fractional Factorial Reliability Design
Choose this if the experiment. includes only part of all combinations of the Factors, (7]
W " Plackett-Burman Reliability Design
h: Choose this to study the main effect of multiple Factors, Each Factor has only bwo levels, (7]
+
+
g
o Help | Cancel | < Back Eimish |

In the third step of the Design Wizard, select 8 from the Factors drop-down and 16 runs, 1/16 from the
Fractions drop-down. In the Times-to-Failure Data Options area, select both My data set contains
suspensions (right censored data) and My data set contains interval and/or left censored data, as

shown next.

[IjDesign Wizard [ %]

"""": Define the data format that you want for Fractional Reliability.

Step 3

r—Fractional Reliability

Factors |8 VI Factor Properties |
Fractions |16 runs, 1/16 'l Fraction Generator |

View Available Designs. ..

Replicates I 1 - l

r— Times-to-Failure Data Options

[V My data set contains suspensions (right censored data)
—+ Choose this if your data set contains units that did not Fail.

[V My data set contains interval and/or left censored data

specify intervals for times-to-failure,

»—a Choose this if your data set contains uncertainty as ko exactly when a unit Failed, This will allow you ko (7]

—Based on yvour selections, the data sheet will include these responses

Last State
Inspected For5S

Time to
Fors

DOE++

Help | Cancel | < Back

Einish
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4 Step-by-Step Examples

e Click the Factor Properties button. In the Factor Properties window that appears, enter the names for
the factors, as shown next.

MNarme Units | Type | Low Level | High Lewvel =
A | Temperature Quantitative -1 1
| B | Huridity Quantitative -1 1
|C | Load Quantitative -1 1
1D | Speed Quantitative -1 1
| E | Yoltage Quantitative -1 1
| F | Coolant Type Quantitative -1 1
|G | Yibration Quantitative -1 1
H Current Quantitative -1 1

t Quantitative: The results can be generalized to other values,
g Qualitative: The results can only be applied to the levels you define.

[-] OF | Cancel | Help |

Because only coded values are used in this example, you do not need to enter low and high values for the
factors.

e Click OK to close the Factor Properties window and return to the Design Wizard.

e For this example, we will use the default fraction generators, so there is no need to access the Fraction
Generator window. Click Next to proceed to the next step.

e The fourth step of the Design Wizard provides a review of the settings you have chosen for the design.

[IjDesign Wizard [ %]
"""": Review the settings vou have chasen for your design,

Step 4
View in & separate window. ..

—Design Review

2 Level Fractional Factorial Reliability Design o
_
Factors: g
Fraction: 1/16
Replicates: 1
Cbservations: 16

Data set containg interval data.
Data set contains suspensions.

Factor Properties

Factor Name Units Type  Low Level High Level
A Temperature Quantitative -1 1
B Hurridity Quantitative -1 1
C Load Quantitative -1 1 -
4| » [\Initial Design /4 Tritial Alias Structure / Nl | ;l_‘

DOE++

Help | Cancel | < Back | [ext =

104 http://DOE.ReliaSoft.com



4.10 Example 10: Two Level Fractional Factorial Reliability Design

Note that there is an additional tab called “Initial Alias Structure” in the summary area. Click this tab to
view the alias structure of the design, as shown next.

[IjDesign Wizard [ %]
"""": Review the settings vou have chasen for your design,

Step 4
View in & separate window. ..

—Design Review
Initial Alias Structure: o

Fraction Generators:
E = ABC
F =BCD
G =ACD
H = 4BD

[1]1 =1+ ABCE + ABDH + ABFG + ACDG + ACFH + ADEF + AEGH + BCDF + BCGH + BDE

[4] = & 4+ BCE + BDH + BFG + CDG + CFH + DEF + EGH

[B] =B + ACE + ADH + AFG + CDF + CGH + DEG + EFH

[C] =0C+ ABE + ADG + AFH + BDF + BGH + DEH + EFG

[0] =D+ ABH + ACG + AEF + BCF + BEG + CEH + FGH

[E] =E + ABC + ADF + AGH + BDG + BFH + CDH + CFG

[F] =F + ABG + ACH + ADE + BCD + BEH + CEG + DiGH

[G] =G+ ABF + ACD + AEH + BCH + BDE + CEF + DFH -
% Initial Design_Anitial Alias Structure’ EXm Ll_‘

Help | Cancel | < Back | [ext = | Einish |

3

DOE++

If any of the settings are not as intended, you can click the Back button to return to the appropriate step
and make any necessary changes.

e C(Click Finish to create the new project with the Standard Folio containing the two level fractional
factorial reliability design.

e Save the project as “TwoLevelFractionalReliability.rso7.”

e Sclect Standard Order in the Sort By area in the Control Panel to sort the Data Sheet by the Standard
Order column, then enter the response data in the order given in this example on page 101. The Folio
will look like the one shown next.

[IjFuliu: Folio1 {Design} [_ O] <]
El6 140 Main I Opnnnsl Other |
Stgpéj::d ORrLclin nstZSctted FSE?ES. T':m;? ;D i Ternperature B :Humidity|C:Load D: Speed E voltage |F: Coolant Type & VibrationH:Current DETENET
1 1 14 180 F 200 -1 -1 -1 -1 -1 -1 -1 -1
2 2 4 &0 F &0 1 -1 -1 -1 1 -1 1 1 (I (FES
3 3 7 140 F 160 -1 1 -1 -1 1 1 -1 1 " Coded Yalues
4 4 15 180 F 200 1 1 -1 -1 -1 1 1 -1 & Actual values
5 5 11 160 F 180 -1 -1 1 -1 1 1 1 -1 ]
& & 8 &0 F  1m 1 = 1 = = 1 = 1 , HEED
7 7 10 180 5 200 -1 1 1 -1 -1 -1 1 1 =211 RunOrder
E 8 5 &0 F 100 1 1 1 -1 1 -1 -1 -1 || Standard Order
9 ] 1 180 S 200 -1 -1 -1 1 -1 1 1 1
I Design Summary
10 10 13 180 E 200 1 -1 -1 1 1 1 -1 -1
11 1 12| 10 5 140 -1 1 -1 1 1 -1 1 -1 I RIS e
12 12 3 120 F 140 1 1 -1 1 -1 -1 -1 1
13 13 2 180 S 200 -1 -1 1 1 1 -1 -1 1
14 14 16 120 F 140 1 -1 1 1 -1 -1 1 -1
15 15 6 140 F 160 -1 1 1 1 -1 1 -1 -1
16 16 9 120 F [0l 1 1 1 1 1 1 1 1 -

Design I

Because you did not change the factor values from the original coded values in the Factor Properties
window, the Folio will look the same regardless of whether Coded Values or Actual Values is selected in
the Display Factors area of the Control Panel.

e On the Main page of the Control Panel, select the Weibull distribution.

e On the Options page of the Control Panel, specify a Risk Level (Alpha) value of 0.1 and select to use
Grouped Terms.
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4 Step-by-Step Examples

e Return to the Main page of the Control Panel and click Calculate. The Analysis tab is shown next.

[Ij o: Foliol {Analysis) H=
430 main | options | other |

& | B | c ‘ D | E | F | G ‘ H | 1 | ] H Distribution [e]
1 |Distribution: weibull IO
2
) Likelihood Ratio Test Table
4 vodel Effect Degrees of Ln(Likelihood | Likelhood | [, . 0.1

Freedom Value) Ratio analysis Seltings
5 Reduced Main Effects 8 20,9252 146200 | 00668 R
6 2-Way Interaction 4 -24.7013 4.1821 0.3619 Parial R | Grouped
7 Full 14 -22.6102 Calculated
8 Observations = 16
9 |Unable to converge to a solution for the following terms: IW
10 |AF, AG, AH
11 Fii)=... =
12 MLE Information
13 Term Effect Coefficient Standard Error.  Low CI HighCI | ZValue P Value
14 Beta 6.3617 17477 4,044 9.9969
15 Intercept 5.13932 0.0632 5.0344 5.2442 | 806072 [u]
16 |A:Temperature -0.4644 -0.2322 0.1179 -0.4261 -0.0383 | -1.9701 0.0488
17 B :Humidity -0.0233 -0.0142 0.1137 -0.2012 01729 | -0.1247 0.2003
18 C:Load -0.1715 -0.0838 0.1169 -0.2781 0.1085 | -0.7337 0.4631
19 [:Speed 0.2689 0.1344 0.1178 -0.0594 0.3283 1.1411 0.2538
20 E:violtage -0.0933 -0.0493 0.1137 -0.2364 01378 | -0.4332 0.6649
21 |F:Coolant Type 0.1056 0.05z28 0.1132 -0.1345 0.24 0.4538 0.6428
22 G:Vibration 0.1075 0.0538 0.1169 -0.1386 0.2462 0.4597 0.6457
23 H:Current -0.0961 -0.0431 0.1138 -0.2332 01391 | -0.4224 0.6728
24 5B 0.0445 0.0=223 0.0652 -0.085 0.1295 0.2416 0.7327
23 AT -0.2654 -0.1327 0.0582 -0.2285 -0.0359 | -2.2785 0.0227
26 aD 0.0205 0.0103 0.0819 -0.1244 0.1449 0.1254 0.9002
27 AE 0.0827 0.0413 0.0618 -0.0604 0.1431 06686 0.5037 f
4 [

Design  Analysis |

The p values in the MLE Information table indicate that temperature and the interaction between
temperature and load (AC) are significant factors at the 10% significance level.
e To confirm this graphically, click the Plot icon to add the Plot tab to the Folio.

e Select Pareto Chart from the Plot Type menu in the Control Panel. The Pareto chart is shown next.

ReliaSoft DOE++ - www.ReliaSoft.com

Pareto Chart

Pareto Chart
AC
== (ritical Value
B Non-Significant
®  Significant
A:Temperature

D:Speed

C:Load
AE
F:Coolant Type
G:Vibration
E:Voltage

Term

H:Current
AB
AD
User Name
o Company
B:Humidity 11/17/2008
12:31:03 PM
0.000 0.600 1.200 1.645 1.800 2.400 3.000

Standardized Effect (Z Value)

Beta= 6.3617; Alpha = 0.1; Threshold = 1.6449
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4.11 Example 11: Multiple Linear Regression Tool

Temperature and the interaction between temperature and load are confirmed as the significant factors at the
10% significance level. The engineer can now proceed to building the life-stress relationship with the
important factors.

e Save and close the project then proceed to the next example.

4.11 Example 11: Multiple Linear Regression Tool

In doing some research, an investor decides to explore the relationship between the stock price of Apple Inc.
(AAPL) and its iPod sales.

The data set is shown next.’

Date AAPL Stock iPods Sold
Price () ™)
Jan-02 11.3 125
Mar-02 12.12 57
Jun-02 9.78 54
Sep-02 7.26 140
Jan-03 7.24 219
Mar-03 73 78
Jun-03 9.09 304
Sep-03 11.08 336
Jan-04 11.4 733
Mar-04 13.1 807
Jun-04 15.67 860
Sep-04 18.34 2016
Jan-05 34.61 4580
Mar-05 42 5311
Jun-05 37.59 6155
Sep-05 51.01 6451
Jan-06 77.81 14043
Mar-06 64.04 8526
Jun-06 58.71 8111
Sep-06 73.86 8729
Jan-07 88.88 21066
Mar-07 90.6 10549
Jun-07 121.7 9815
Sep-07 142.08 10200
Jan-08 161.63 22121

8 In this data set, cach stock price is the average of the monthly adjusted close price for the preceding three months,
taken from http:/finance.yahoo.com/q/hp?s=AAPL&a=09&b=1&c=2001&d=11&e=31&{=2007&g=m&z=66&y=066.
Quarterly sales reports are taken from the U.S. Securities and Exchange Commission Web site at http://www.sec.gov/
cgi-bin/browse-edgar?type=10-q&dateb=&owner=include&count=40&action=getcompany & CIK=AAPL.
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4 Step-by-Step Examples

Do the following:

e Determine if a relationship exists between stock price and sales, then build a model.
e Determine if a transformation might be appropriate and build a new model if desirable.

The sample file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ DOE\Training Guide) and is named “MLRTrdoe.” The data set for this
example is available in the Spreadsheet in the “MLRT-Data.rso7” file located in the “Raw Data” folder
within the “Training Guide” folder.

Solution

e C(Create a new project. On the first page of the Design Wizard, clear all checkboxes and click Finish to
create an empty project.

e Save the project as “MLRT.rso7.”

e Sclect Add Other Tools then Add Multiple Linear Regression from the Project menu. A blank
Multiple Linear Regression tool will be added to the project, as shown next.

[IE ReliaSoft DOE ++ =]

Eile Edit Wew Project Sheet Data Tools MWindow Help ‘
D@0 a2 /& a@aloln s E][EAl2008 5|5
A EE=qar|aElra 24 lEE]

o] MRt [BdFolio: MLRT1 (Design) A&
-l Standard Folios ;
{3 Additional Flots Al I main | other |
- Cther Tools A [ B [ [ [ D [ E [ F [ @ [ H [ 1 = m
[ | I
{8 Spreadsheets

L@l Attachments

=
o

-
=

-
X}

E weibull+ -+

= sl PR PR FICN ) RO ) PR R PR P
3 (L e = e
=1
=]

-
A aLTA »
Loaded folios: 0 | Active MLRT "MLRTL" |Project: C\DOE++ Training GuidelMLRT 1507 | Physical Memory Available: 48,43%

The Multiple Linear Regression Tool (MLRT) allows you to enter your own experimental data without using
one of the design types provided in the software. You can then analyze the data in much the same way that
designed experimental data sets are analyzed in the Standard Folio.
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4.11 Example 11: Multiple Linear Regression Tool

e Double-click the column header of column A and, in the window that appears, type Date, as shown next,
then click OK.

Ethange Heading
Crake oK |
Cancel |

DOE++

e Using the same process, change column B’s title to AAPL Stock Price ($) and column C’s title to iPods
Sold (M).

e Right-click the column header of the Date column and select Format Selection then Custom Number
from the shortcut menu.

e In the Format Cells window that appears, select Date in the Category area and then mmm-yy in the Type
area, as shown next.

Format Cells [ %]
Cateqgary: Tvpe:
Al ;I TOMmIm=yy
Currency
Fixed Td"lww =
Percent d-mmm-yy
Fraction -mm -
Scientific i
mfdfyyyy himm
Time midfyy
[~ [~
Sample
lrjan 0z ‘
[8]4 I Cancel

e Click OK to accept your selections and close the window.
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4 Step-by-Step Examples

e Enter the data given on page 107. For each date in the Date column, enter the date as the first of the
month (e.g. for Jan-02, type 1/1/02). The MLRT will look like the one shown next.

Folio: MLRT1 (Design) [_ ol ]
cos  [z2z1z1 main | other |
Date  |A&PL Stock Price (B)[PodsSoidgey) D [ E | F [ & [ H S
1 | JanOz 113 125 1%
2 | mar-o2 12.12 57
3 | un02 9.78 54
4 | Sep02 7.26 140
5 | Jan-03 7.24 219
6 | Mar-03 7.3 78
7 | un03 9.09 304
8 | Sep03 11.08 336
9 | Jan-04 11.4 733
10 | Mar-04 13.1 807
11 | Jun-04 15.67 860
12 | Sep-04 18.34 2016
13 | Jan-05 34.61 4580
14 | Mar-05 42 5311
15 | Jun-05 37.59 6155
16 | Sep-05 51.01 6451
17 | Jan-06 77.81 14043
18 | Mar-06 64,04 8526
19 | Jun-06 58.71 8111
20 | Sep06 73.86 8729
21 | Jan07 86.85 21066
22 | Mar-07 90.6 10549
23 | uno7 121.7 9815
24 | Sep07 142,08 10200
25 | Jan-08 161.63 C == =
| LIJ
Design |

e C(Click Calculate to analyze the data set. The Select Responses and Predictors window will open, as

shown next.
[IjSelect Responses and Predictors [ %]
Available Columns: Responses:
Column Iame Calumn | Mame

2 AAPL Stock Price {4 |
3 iPods Sold (M) *

Predictors:

Calumn | Mame

«| | >
—Settings

¥ Include intercept in the model

OF I Cancel | Help |

DOE++

The Select Responses and Predictors window allows you to specify for each column of data you have
entered in the Design tab of the MLRT whether it represents factor settings or response data.

e Select column 2, AAPL Stock Price ($), in the Available Columns area then click the arrow beside the
Responses area to move the selected column to the Responses area, indicating that the data contained in
that column are response data.
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4.11 Example 11: Multiple Linear Regression Tool

e Seclect column 3, iPods Sold (M), in the Available Columns areca then click the arrow beside the
Predictors area to move the selected column to the Predictors area, indicating that the data contained in

that column are factor settings. The window will look like the one shown next.

[IjSelect Responses and Predictors [ %]

Available Columns: Responses:

Column ~ IName Column

1 Date z

L2

Mame
ABPL Stock Price ($)

Predictors:

Calumn | Mame

—Settings
¥ Include intercept in the model

o 1|

DOE++

Cancel | Help |

Click OK to close the Select Responses and Predictors window and continue with the analysis. The
Analysis tab will be added to the MLRT, as shown next.

Folio: MLRT1 {Analysis) [_[a[=]
A2 [Main | Optionsl Other I
A [ 8 [ ¢ [ o [ e [T F [ & [ H Resporse 40
1 ANOVA Table -
Degrees Sum of Mean IMPL Stack Prics (§) j
Source of .
2 Variation of Squal_'es Squal_'es F Ratio P Value Fre——
Freedom [Partial] [Partial] Pt
3 |Model 1 3.83E+04 3.83E+04 80,0565 | 5.97E-09
4 iPods Sold (M) 1 3.83E+04 3.83E+04 80,0565 | 5.97E-09 Risk Level {alpha)
5 |Residual 23 1. 10E+04 4758.9193 0.1
4] Lack of Fit 23 1. 10E+04 4758.9193 . .
= ITotal 24 4.04E+04 Analy5|s. Settings
Partial 55
g Calculated
9 5 =21.8842 FRESS = 1.50E+04 -
Observations = 25
10 R-sq = 77.68% R-sg{pred) = 69.65%
11 R-sqiadjy = 76.71% Analysis Summary
12 Plii=...
13 Regression Information
14 Term Effect | Coefficient Stg:i?rd Low CI | HighCI T ¥alue P Yalue
15 Intercept 11,9692 5.882 1.8883 220502 2.0349 0.0535
16 iPods Sold (M) | 0.0124 0.0062 0.0007 0.005 0.0074 5.9474 | 5.97E-09 |-
4 | »
Design  Analysis |

The p values in the ANOVA and Regression Information tables indicate that the number of iPods sold is a
significant factor in the change of the stock price.

e To determine if the model is acceptable or if a transformation would be appropriate, click the Plot icon to
add the Plot tab to the MLRT.
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4 Step-by-Step Examples

e Sclect Residual Probability from the Plot Type menu in the Control Panel. The Residual Probability
plot is shown next.

ReliaSoft DOE++ - www.ReliaSoft.com
Normal Probability Plot of Residual
99.000 Residual Probability
AAPL Stock Price ($)
L] Y=Y
® Data Points
— Residual Line
Z
8 50,000
o
S
a
10.000
5.000
L]
User Name
Company
8/13/2008
1,000 1:30:42 PM
-70.000 -42.000 -14.000 14.000 42.000 70.000
Residual

Anderson-Darling = 2.9402; p-value = 1.2638E-7

You will recall that if the model accurately accounts for the effect of the factor, the residuals (i.e. the
differences between the observed response values at each factor level and the response values predicted by
the model) should be approximately normally and independently distributed. The noticeable pattern in the
way the data points deviate from the residual line here suggest that Y is not normally distributed and that a
transformation may be appropriate. The Box-Cox Transformation plot can help in determining the
transformation that should be used.
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4.11 Example 11: Multiple Linear Regression Tool

e Sclect Box-Cox Transformation from the Plot Type menu in the Control Panel. The Box-Cox

Transformation plot is shown next.

ReliaSoft DOE++ - www.ReliaSoft.com

Box-Cox Power Transform Plot

21.000 Box-Cox Transformation
AAPL Stock Price ($)
oy
—— Lambda Line
— Lower CI
— Upper CI
— CISSe
18.200 — Best Lambda

o

S 15400

=3

a

s

S)

=

=1

a

©

=1

pd

3

o 12.600

=4

3

9.800
User Name
Compan
8/13/2008
7.000 1:31:03 PM
-5.000 -3.000 -1.000 1.000 3.000 5.000

Lambda

Alpha = 0.1; Best Lambda = 0.1515; Lower CI = -0.1536; Upper CI = 0.4924
Recommended Transformation = Natural Log

Based on the best (lowest) value of lambda, the recommended transformation is the natural log
transformation, as displayed in the lower title of the plot.

e Return to the Analysis tab by clicking its page index tab.

e Click the Transformation icon.

DOE++ Training Guide

113



4 Step-by-Step Examples

e The Transformation window will open, as shown next.’

ETransfﬂrmation [ %]

Biox-Cox Transformation I

Response

|apL Stock Price () =l
¥ Min = 7,24 ¥ Max = 161,63

Transfarmation

Parameters

OF | Cancel | Help

e C(Click the Box-Cox Transformation tab at the top of the window to go to the Box-Cox Transformation
page. This page can help to select a transformation by giving you the same results as the Box-Cox
Transformation plot. Click Calculate to calculate the best lambda value along with its confidence
interval. The recommended transformation, based on the best lambda value, is displayed at the bottom of

the window, as shown next.

DOE++

ETransfﬂrmation [ %]

General  Box-Cox Transformation |

Biox-Cox Transformation Resulks
Best Lambda
[0.1515 |
Lower CI (90%:)
[-0.1536 |
Upper CI {90%:)
[0.4924 |

Recommended Transformation

[ Matural Log ]

OF | Cancel | Help

You can see that the recommended transformation is the same as the one recommended on the Box-Cox

Transformation plot.

% You will notice that the Response drop-down is unavailable. This is because the window was accessed from the
Analysis tab Control Panel, so the choice you make will be applied only to the response currently selected in the Control
Panel. When you access the Transformation window from the Standard Folio Design tab Control Panel, the Response

drop-down is enabled.
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4.11 Example 11: Multiple Linear Regression Tool

e Return to the General page of the Transformation window and select Natural Log from the
Transformation menu. The equation for the transformation is now displayed at the bottom of the
window. Any recommended parameters are displayed in the Parameters area, as shown next.

ETransfﬂrn1atinn B=

General | Box-Cox Transformatinnl

Respanse

AL Stock Price (5) =
¥ Min = 7,24 ¥ Max = 161,63

TransFormation

IMatural Log

Parameters

i

F'=In(Y +a)

’TI Cancel | Help |

DOE++

e Click OK to apply the transformation to the response and close the window. You will see that the status
indicator in the Response area of the Control Panel has turned red, indicating that changes have been

made and the results in the Analysis tab are no longer valid.

Click the Plot icon to recalculate the data set with the new transformation applied and display the results

in a plot.

e Sclect Residual Probability from the Plot Type menu in the Control Panel. The new Residual
Probability plot is shown next.

ReliaSoft DOE++ - www.ReliaSoft.com

Normal Probability Plot of Residual

99.000 Residual Probability
AAPL Stock Price ($)
Y' = Natural Log

@® Data Points

— Residual Line

50.000

Probability

10.000

5.000

User Name
Company
8/13/2008
1:33:27 PM

1.000
1.200 2.000

-2.000 -1.200 -0.400 0.400
Residual

Anderson-Darling = 0.2468; p-value = 0.7279

The data points now follow the residual line reasonably closely, indicating that the transformation was, in

fact, appropriate.

e Save and close the project.
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Practice Questions

This section contains some additional practice questions and the next section presents solutions to these
questions. The file for these examples is located in the “Training Guide” folder in your application directory
(e.g. C:\Program Files\ReliaSoft\DOE\Training Guide) and is named “Practice Questions.rdoe.”

5.1 Practice Question 1

In comparing post-surgery rehabilitation programs after knee reconstruction, a researcher divides patients
into 4 different groups (A through D). After 6 months of recovery, the costs incurred by each group are
compared. Costs include expenses such as professional physical therapy, medications, post-surgery doctor
visits, etc. Note that the recovery results target was attained for all patients.

Group A Costs | Group B Costs | Group C Costs | Group D Costs
® ®) ® ®
360 770 570 330
460 930 730 440
540 1070 870 550
590 1160 960 620
480 960 760 470
500 990 790 500
340 850 850 290
470 940 740 460
570 1110 910 580
480 970 770 480

Create a new project and Standard Folio containing a one factor design. Name the Folio “Question].”
Enter the data.

Validate the normality assumption using the Residual Probability plot.

Determine whether the four programs are significantly different in terms of cost.

Using the Box plot, determine which program is the least expensive.

A O

Save the project as “Practice Questions.rso7.” Close the Folio but leave the project open.

5.2 Practice Question 2

A metal deposition process consists of depositing a thin film of metal over steel sheets. The deposition
thickness needs to meet a target of 2mm. Minimum variability is desired in the thickness across the metal
sheet. Several factors are thought to affect this process, namely the speed at which the sheet moves through
the deposition chamber, the pressure in the chamber, the temperature to which the metals that will cover the
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5 Practice Questions

sheet are heated and the order in which these metals are laid. Due to the high number of out-of-spec sheets,
the experimenter decides to use a Taguchi robust design to find the appropriate control factor settings to
make the process more robust.

The following are the settings for the control factors:

Control Factor Level 1 Level 2 Level 3
Speed Low Medium High
Temperature Low Medium High
Pressure Low Medium High
Order Arrangement 1 | Arrangement2 | Arrangement 3

The following deposition thickness data, in mm, are collected at 5 different predetermined locations across
the metal sheet:

Control Factor Settings
Location | Location | Location | Location | Location
Speed | Temperature | Pressure Ol\l;[(i:;lgf ! 2 3 4 S
Low Low Low Arrangement 1 2.007 2.038 2.04 2.051 2.025
Low Medium Medium | Arrangement 2 1.983 1.972 2.057 2.033 2.043
Low High High | Arrangement 3 1.979 2 2.002 2.055 2.033
Medium Low Medium | Arrangement 3 1.995 1.996 2.01 2.025 2.101
Medium | Medium High | Arrangement I 1.984 1.996 1.996 2.028 2.031
Medium High Low Arrangement 2 1.995 1.987 1.99 2.01 2.015
High Low High Arrangement 2 1.97 1.99 1.994 2.009 2.013
High Medium Low Arrangement 3 1.976 1.965 1.983 1.988 2.033
High High Medium | Arrangement 1 1.907 1.938 1.974 1.99 2.005

1. Create a new Standard Folio for a Taguchi robust design. For the inner array, use a Taguchi L9(3"4)
orthogonal array. For the outer array, use a general full factorial design with 1 factor and 5 levels. Name
the Folio “Question2.”

2. Analyze the data using a Nominal signal-to-noise ratio.
Determine the optimum settings for the control factors based on the Main Effect plots.

4. Save your file and close the Folio.

5.3 Practice Question 3

A design engineer would like to optimize the design of a capacitor such that the life will be maximized. The
three factors that will be included in the study are the height and length of the capacitor and the type of
solder used. He chooses to use a full factorial reliability design and use two replicates. Factors are set at the
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5.4 Practice Question 4

limits of the allowed range for this application. Due to the test conditions and resources, units can only be
inspected every 24 hours. The data set is shown next.

Solder Height Length Last State Time to
Type (microns) | (microns) | Inspected (ForS) ForS
S1 50 200 168 F 192
S2 50 200 168 F 192
S1 100 200 264 F 288
S2 100 200 216 F 240
S1 50 600 216 S 240
S2 50 600 168 F 192
S1 100 600 216 F 240
S2 100 600 192 F 216
S1 50 200 192 F 216
S2 50 200 216 S 240
S1 100 200 288 F 312
S2 100 200 312 F 336
S1 50 600 216 F 240
S2 50 600 216 F 240
S1 100 600 264 F 288
S2 100 600 312 F 336

Note that two units were taken out of the experiment for further study after 240 hours due to anomalies
observed in the units.

1.

NS n kLD

Create a new Standard Folio for a two level full factorial reliability design with right and interval cen-
sored data. Name the Folio “Question3.”

Analyze the data using the Weibull distribution.

Validate the model assumptions using the Residual Probability plot.
Identify the important effects.

Reduce the model accordingly and recalculate.

What would be the optimal factor settings for this design?

Save your file and close the Folio.

5.4 Practice Question 4

The design of an automobile fuel cone is thought to be affected by six factors in the manufacturing process:

Factor A: cavity temperature
Factor B: core temperature
Factor C: melt temperature
Factor D: hold pressure

Factor E: injection speed
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e Factor F: cool time

The manufacturer of the fuel cone is unable to run the 2° = 64 runs required to complete one replicate for a
two level full factorial experiment with six factors. Instead, they decide to run a fractional factorial design.
Considering that three-factor and higher-order interactions are likely to be inactive, the manufacturer selects

a 262 (resolution IV) design that will require only 16 runs. The data set is shown next.

Cavity Core Melt Hold Injection Cool Time | Response
Temperature | Temperature | Temperature | Pressure Speed

-1 -1 -1 -1 -1 -1 7

1 -1 -1 -1 1 -1 7
-1 1 -1 -1 1 1 6.5
1 1 -1 -1 -1 1 7
-1 -1 1 -1 1 1 5

1 -1 1 -1 -1 1 5
-1 1 1 -1 -1 -1 3.5
1 1 1 -1 1 -1 4.5
-1 -1 -1 1 -1 1 7

1 -1 -1 1 1 1 7.5
-1 1 -1 1 1 -1 7

1 1 -1 1 -1 -1 4.5
-1 -1 1 1 1 -1 14
1 -1 1 1 -1 -1 11
-1 1 1 1 -1 1 13
1 1 1 1 1 1 13.5

1. Create a new Standard Folio for a two level fractional factorial design using coded values. Name the
Folio “Question4.”

2. Examine the fraction generators and the alias structure. State the assumptions of this design and what
can be done to mitigate problems.

Identify the significant effects using the Effect Probability plot and reduce the model accordingly.

4. Save your file and close the Folio.

5.5 Practice Question 5

In “Example 7: Sequential Optimization” on page 70 of Chapter 4, we assumed that the experimenter was
concerned only about the yield of the chemical reaction and selected optimal settings of temperature and
reaction time based on that requirement. Often, this is not the case; instead, it might be necessary to optimize
a number of responses simultaneously. Assume that the cost of making the product and the pH of the product
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5.5 Practice Question 5

are responses that have to be accounted for when selecting optimum settings. While the cost is to be
minimized, the pH should be within a close range to 7. The following data are collected:

Center Temperature | Reaction Time Yield Cost

Point (F) (min) %) ®) pH
1 345 155 89.75 420.5 7.98
1 355 155 90.2 419.6 7.56
1 345 175 92 416 7.14
1 355 175 94.25 411.5 6.08
1 342.9289322 165 90.5 419 7.46
1 357.0710678 165 92.75 414.5 6.5
1 350 150.8578644 88.4 423.2 6.92
1 350 179.1421356 92.6 414.8 6.24
0 350 165 94.85 4103 7.16
0 350 165 95.45 409.1 6.6
0 350 165 95 410 7.02
0 350 165 94.55 410.9 6.78
0 350 165 94.7 410.6 7.2

1. Create a new Standard Folio for a central composite design with three responses: yield (%), cost ($) and
pH. Use five center points and o = 1.4142. Use the factor ranges from the central composite design in

the original example (i.e. 345-355°F for temperature and 155-175 minutes for reaction time). Name the
Folio “Question5.”

2. Reduce the model for each response accordingly.

Identify optimal factor settings such that the yield is maximized, the cost is minimized and the pH stays
on target at 7. Assume that the experimenter wants to have a target yield value of 95 although any value
of yield greater than 94 is acceptable. For the cost, assume that the experimenter wants to lower the cost
to 400 although any cost value below 415 is acceptable. For the pH, a target of 7 is desired but values
between 6.9 and 7.1 are also acceptable. Assume equal weights and importance for all responses.
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Answers to Practice
Questions

This section provides answers to the Practice Questions in Chapter 5.

6.1 Practice Question 1

3. There is no apparent deviation from the normal probability line.

ReliaSoft DOE++ - www.ReliaSoft.com
Normal Probability Plot of Residual
99.000

Residual Probability
Response
Y=Y

Group A
Group B
Group C
Group D
Residual Line

50.000

Probability

10.000

5.000

User Name
Company
2/15/2008
2:10:32 PM

1.000
-300.000 -180.000 -60.000 60.000 180.000 300.000

Residual

4. From the Mean Comparisons table, there is significant difference between all programs except between
programs A and D.

DOE++ Training Guide 123



6 Answers to Practice Questions

5. From the Box plot, programs A and D are least expensive.

ReliaSoft DOE++ - www.ReliaSoft.com
Box Plot

1200.000 Box Plot

Response
Y=Y
® Data Points

-@- Mean Values
— Box Plot

980.000

760.000

Response

540.000

320.000

User Name
Company
2/15/2008
2:10:55 PM

100.000
Group A Group B Group C Group D

Level

6.2 Practice Question 2

4. By examining the Main Effect plots for Y Mean and Signal Noise Ratio, you can see that the medium
setting for the speed is the best choice for maximizing the signal-to-noise ratio while still remaining on
target. The Main Effect plot for Y Std indicates that the medium setting also has the smallest standard
deviation value.

For the temperature, the low and high levels are slightly better than the medium level for maximizing the
signal-to-noise ratio and minimizing standard deviation; however, the medium setting results in values
that are closest to the 2mm thickness target. The medium level is chosen.

The pressure setting does not seem to considerably affect the deposition thickness. The largest signal-to-
noise ratio and the smallest Y Std are found at the low setting; therefore, it is preferable.

The order of the metals does not seem to considerably affect the deposition thickness. The largest signal-
to-noise ratio and the smallest standard deviation values are observed at the second arrangement setting,
which is therefore preferable.

Thus, based on the experimental results, the best settings to maximize the signal-to-noise ratio while
remaining on the desired 2mm target are:

o Speed: medium setting

o Temperature: medium setting
o Pressure: low setting

o Order of metals: arrangement 2

Since the goal is both to maximize the signal-to-noise ratio and to keep the deposition thickness on
target, trade-offs need to be made in the selection of factor settings.
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6.3 Practice Question 3

3. Although the points do not track the line exactly, no significant deviations are found.

ReliaSoft DOE++ - www.ReliaSoft.com
Standardized Residual
99.000 Residual Probability
Time
@® Residuals
»  Susp Residuals
— Residual Line
50.000
z
o
©
o
[
a
10.000
5.000
User Name
Company
8/5/2008
1.000 > =S 2:34:42 PM
-6.000 -3.600 -1.200 1.200 3.600 6.000
Residual
Beta = 8.4876

4. Height is the key factor, based on the information in the Analysis tab and/or the pareto chart. In addition,
the interaction between solder type, height and length is significant.

6. Within the factor constraints (i.e. height between 50-100 microns, length between 200-600 microns), the
optimal settings are found to be solder type = S2, height = 100, length = 600.

ReliaSoft DOE++ - www.ReliaSoft.com
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6.4 Practice Question 4

2. The alias structure is shown next.

Initial Alias Structure:

Fraction Generators:
E = ABC
F =BCD

[1] =1 + 4BCE + ADEF + BCOF
[4] = & + BCE + OEF + ABCDF
[E] =B + ACE + COF + APDEF
[C] = C + ABE + BDF + ACDEF
[D] = D + 4EF + BCF + ABCDE
[E] = E + ABC + ADF + BCDEF
[F] = F + ADE + BCD + ABCEF
[£B] = 4B + CE + ACDF + BOEF
[AC] = AC + BE + ABDF + CDEF
[AD] = AD + EF + ABCF + BCDE
[AE] = AE + BC + DF + ARCDEF
[£F] = &4F + DE + 4BCD + BCEF
[EC] = BD + CF + ABEF + ACDE
[EF] = BF + CD + ABDE + ACEF
[4BD] = ABD + ACF + BEF + CDE
[4BF] = ABF + ACD + PDE + CEF

All main effects are free from aliasing with main effects and second order interaction effects. However,
the two-factor interactions may be aliased with each other.

If important two-factor interactions are found to be present, additional experimental trials should be
conducted to separate the confounded effects.

ReliaSoft DOE++ - www.ReliaSoft.com

Normal Probability Plot of Effect

99.000 Effect Probability

Response 1
Y=Y

[} ® Non-Significant Effects

B Significant Effects
— Distribution Line

mm D:Hold Pressure

m C:Melt Temperature

50.000

Probability

10.000 L4

5.000

User Name
Company
2/25/2008
4:26:41 PM

1.000
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Effect

Alpha = 0.1; Lenth's PSE = 0.6562

A normal probability plot of the unreplicated design shows the main effects of factors C and D and the
interaction effect BF to be significant. From the alias structure it can be seen that the interaction effect
BF is confounded with CD. Thus the actual source of this effect cannot be known on the basis of the
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present experiment. However since neither factor B nor F was found to be significant there is an

indication that the observed effect is likely due to interaction CD. To confirm this, a follow-up 22
experiment can be run involving only factors B and F. If those factors are found (or assumed) to be
inactive, the fitted regression model for the fuel cone design is:

y=176875+C+2-D+2.1875-CD

6.5 Practice Question 5

Y

412.921

D

409.882

2. Yield:
A 2 2
P = 94.9+0.735x, + 1.53x, + 0.45x x, — 1.52x] — 2.08x;
Cost:
" 2 2
v, = 410.18 — 1.471x, — 3.06x, — 0.9x,x, + 3.04x] +4.17x
pH:
¥, = 6.97-0355x, —0.041x,
3.
ReliaSoft DOE++ - www.ReliaSoft.com
Optimal Solution 1
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D

6.436

342.929
345.757
348.586
351.414
354.243
357.071
150.858
156.515
162.172
167.828
173.485
179.142

A:Temperature B:Reaction Time
X = 349.3790 X = 165.3988

Global Desirability = 0.6436

Optimum settings are found to be at a temperature of x; = 349°F and with a reaction time of x, = 165
minutes with an overall desirability of 0.6436. Note that the optimization solution shown above was
found using a random seed of 1 (set on the Algorithm Settings page of the Optimization Settings
window). If you use a different seed or no seed, your results may vary slightly.
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